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ΠΕΡΙΛΗΨΗ 

Τα Γεωγραφικά Συστήματα Πληροφοριών (ΓΣΠ ή G.I.S.) είναι λογισμικά που αξιοποιούν 

τις δυνατότητες των υπολογιστών για αποθήκευση, ανάλυση, διαχείριση και παρουσίαση 

δεδομένων που συνδέονται άμεσα ή έμμεσα με τη γεωγραφική πληροφορία. Στην παρούσα 

εργασία έγινε αξιοποίηση των τεχνολογικών εξελίξεων που συνδέονται με την χρήση των 

ΓΣΠ καθώς η αύξηση της διαθεσιμότητας και της ποιότητας των Ψηφιακών Μοντέλων 

Εδάφους έχουν επεκτείνει σημαντικά τις δυνατότητες χρησιμοποίησής τους σε πολλές 

εφαρμογές με σημαντικότερη την εξαγωγή χαρακτηριστικών του εδάφους όπως είναι η 

ταξινόμηση αναγλύφου, οι κλίσεις, ο προσανατολισμός του εδάφους, η σκίαση αναγλύφου 

και ο εντοπισμός του υδρογραφικού δικτύου. Αξιοποιήθηκε επίσης, μια άλλη σημαντική 

ιδιότητα των ΓΣΠ, η σύνδεση-συσχέτιση γεωγραφικών ή χωρικών (spatial) δεδομένων με 

περιγραφικά δεδομένα-ιδιότητες (attributes) όπως είναι τα δεδομένα απογραφής πληθυσμού 

της ΕΛΣΤΑΤ για τη δημιουργία χαρτών γεωγραφικής κατανομής των δομικών 

δημογραφικών δεικτών της Περιφέρειας Στερεάς Ελλάδας.    

Λέξεις κλειδιά: Γεωγραφικά Συστήματα Πληροφοριών, Ψηφιακά Μοντέλα Εδάφους, 

ανάλυση αναγλύφου, αιολικό δυναμικό, χρήσεις γης, δομικοί δημογραφικοί δείκτες. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

10 
 

ABSTRACT 

Geographic Information Systems (G.I.S.) are software that exploit the capabilities of 

computers for storing, analyzing, managing and presenting data directly or indirectly linked 

to geographic information. The present work exploited the technological developments 

associated with the use of GIS, as the increase in availability and quality of Digital Terrain 

Models has greatly expanded the possibilities for their use in many applications, with more 

important extraction of soil characteristics such as gradient classification, gradients, soil 

orientation, embossment shadowing and hydrographic network location. Another important 

feature of GIS was the use of the linking of geographic or spatial data with descriptive 

attributes such as the ELSTAT population inventory data to create maps of the geographic 

distribution of the structural demographic indicators of the Region Central Greece.  

 

Key words: Geographic Information Systems, Digital Terrain Models, relief analysis, wind 

potential, land uses, structural demographic indicators. 
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ΕΙΣΑΓΩΓΗ 

Η παρούσα διπλωματική εργασία εκπονείται στο πλαίσιο του Μεταπτυχιακού 

Προγράμματος Σπουδών «Πληροφορικής και Υπολογιστικής Βιοϊατρικής» με κατεύθυνση 

τις ΤΠΕ στην εκπαίδευση και έχει την εξής δομή: 

Στην πρώτη ενότητα ορίζουμε τι είναι Γεωγραφική Ανάλυση, τι είναι Γεωγραφικά 

Συστήματα Πληροφοριών και μελετούμε τα χαρακτηριστικά, τα εργαλεία και τις εφαρμογές 

τους.  

Στην δεύτερη ενότητα περιγράφονται αναλυτικά οι βασικές έννοιες των Ψηφιακών 

Μοντέλων Εδάφους (ΨΜΕ), οι πηγές δεδομένων, οι μορφές τους, τα σφάλματα που έχουν, 

η χρήση τους και γίνεται υλοποίηση στην Περιφέρεια Στερεάς Ελλάδας με την δημιουργία 

των τριών μορφών ΨΜΕ. 

Στην τρίτη ενότητα με κατάλληλη επεξεργασία του διαθέσιμου Ψηφιακού Μοντέλου 

Εδάφους (ΨΜΕ) που δημιουργήσαμε καθώς και άλλων δεδομένων θα εξάγουμε 

χαρακτηριστικά του εδάφους της Περιφέρειας Στερεάς Ελλάδας όπως: Την κατανομή 

Υψομέτρων (κατά Dikau, 1989), την κατανομή Κλίσεων (κατά Demek, 1972), την έκθεση ή 

προσανατολισμό του εδάφους, την σκίαση αναγλύφου και με τη βοήθεια μοντέλου που 

δημιουργήσαμε θα εντοπίσουμε το Υδρογραφικό Δίκτυο και τις λεκάνες απορροής.   

Στην τέταρτη ενότητα περιγράφονται αναλυτικά οι διαδικασίες δημιουργίας του χάρτη 

Αιολικού Δυναμικού της Περιφέρειας Στερεάς Ελλάδας με βάση τις μετρήσεις του ΚΑΠΕ 

(Κέντρο Ανανεώσιμων Πηγών και Εξοικονόμησης Ενέργειας). 

Στην πέμπτη ενότητα, αξιοποιώντας τα δεδομένα Corine Land Cover για τα έτη 2006 & 

2012 που προέκυψαν μετά την ολοκλήρωση του προγράμματος «GMS/Copernicus Initial 

Operations (GIO) Land Monitoring 2011-2013» ή GIO LAND, θα υπολογίσουμε  την 

επιφάνεια και το αντίστοιχο ποσοστό που καταλαμβάνουν οι 37 τύποι κάλυψης γης που 

συναντάμε στην Περιφέρεια Στερεάς Ελλάδας με την δημιουργία των αντίστοιχων χαρτών.  

Στην έκτη ενότητα αξιοποιώντας τα δεδομένα της ΕΛΣΤΑΤ παρουσιάζουμε την ανάλυση, 

σε επίπεδο Δήμων Καλλικράτη της Περιφέρειας Στερεάς Ελλάδας, της αριθμητικής 

πυκνότητας πληθυσμού, των δομικών δημογραφικών δεικτών καθώς και την γεωγραφική 

τους κατανομή.  

Στην έβδομη ενότητα συνοψίζουμε τα συμπεράσματά μας και παραθέτουμε θέματα για 

επιπλέον διερεύνηση που μπορούν να πραγματοποιηθούν με τα Γεωγραφικά Συστήματα 

Πληροφοριών. 
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1   Γεωγραφική Ανάλυση και Γεωγραφικά Συστήματα Πληροφοριών 

1.1   Γεωγραφική Ανάλυση 

Η Γεωγραφική Ανάλυση αποτελεί ένα σημαντικό πεδίο της επιστήμης της Γεωγραφίας το 

οποίο έχει την αφετηρία του στην Ποσοτική Επανάσταση της δεκαετίας του 1960. 

Εντάσσεται γενικότερα στην ανάλυση δεδομένων και με την έννοια αυτή έχει ευρύτερη 

χρησιμότητα. Αφορά όλους τους επιμέρους κλάδους της Γεωγραφίας αφού περιλαμβάνει 

μια σειρά μεθόδων και τεχνικών για την περιγραφή, την ερμηνεία και τη γενίκευση των 

γεωγραφικών φαινομένων. Η Γεωγραφική Ανάλυση ασχολείται με τις διαφοροποιήσεις στη 

θέση και τη γεωγραφική κατανομή των φαινομένων και εξετάζει τους παράγοντες οι οποίοι 

επηρεάζουν την κατανομή, τα χωρικά πρότυπα που δημιουργούνται και τις διαδικασίες από 

τις οποίες έχουν προκύψει, αλλά και τους τρόπους με τους οποίους μπορούμε να 

τροποποιήσουμε την κατανομή ώστε να είναι πιο αποτελεσματική (Ηλιοπούλου Π., 2015).   

Πεδία εφαρμογής της Γεωγραφικής Ανάλυσης είναι οι χωρικές κατανομές τόσο του 

ανθρωπογενούς όσο και του φυσικού περιβάλλοντος με την προϋπόθεση ότι αυτά 

χαρακτηρίζονται από τη γεωγραφική διάσταση. Ενδεικτικά αναφέρονται οι τομείς της 

περιφερειακής ανάπτυξης, των περιβαλλοντικών μελετών, των μεταφορών, της 

δημογραφίας, της χωρικής επιδημιολογίας, της χωρικής αρχαιολογίας και της αστικής 

γεωγραφίας. Επιπλέον έχει πρακτικές εφαρμογές για την επίλυση χωρικών προβλημάτων, 

όπως τα παντός είδους προβλήματα χωροθετήσεων, τα οποία αφορούν την εύρεση 

κατάλληλης θέσης για εγκαταστάσεις υπηρεσιών, ΧΥΤΑ, αιολικών πάρκων κλπ. 

Από τα πρώτα εργαλεία της Γεωγραφικής Ανάλυσης υπήρξαν οι χάρτες οι οποίοι ήταν σε 

θέση να αποκαλύψουν σχέσεις μεταξύ των φαινομένων που δεν θα μπορούσαν να 

παρατηρηθούν με τα αρχικά δεδομένα, τα οποία συνήθως είχαν μορφή πινάκων. Κλασικό 

παράδειγμα αποτελεί η εργασία του Snow (1855, Εικ. 1.1), ο οποίος χαρτογραφώντας τα 

κρούσματα της επιδημίας χολέρας στο Λονδίνο το 1854, εντόπισε την πηγή της μόλυνσης 

σε μία αντλία πόσιμου νερού. Δεν περιορίζεται όμως στην απλή παρατήρηση κάποιων 

χαρτών, αλλά χρησιμοποιεί στατιστικές μεθόδους για να μετρήσει τις σχέσεις και να 

εξακριβώσει την αξιοπιστία των αποτελεσμάτων (Ηλιοπούλου Π., 2015). 

Ασχολείται επίσης με τον έλεγχο υποθέσεων, τη δόμηση μοντέλων και την ανάπτυξη 

θεωρίας με αυξανόμενη χρήση μαθηματικών και στατιστικών στοιχείων (Κουτσόπουλος Κ., 

2009).  
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Εικόνα 1.1: Χάρτης Snow (1854), με μαύρες κουκίδες απεικονίζονται τα κρούσματα χολέρας και με Χ  
                     τα σημεία υδροληψίας.  Πηγή: https://nl.wikipedia.org/wiki/Epidemiologie 

Τα δεδομένα στη Γεωγραφική Ανάλυση αφορούν σημεία του χώρου, πολύγωνα  ή γραμμές. 

Εφόσον υπάρχει χωρική αναφορά, με την έννοια του γεωμετρικού προσδιορισμού σε ένα 

σύστημα συντεταγμένων, τα δεδομένα είναι χωρικά και μπορεί να γίνει ανάλυση σε 

περιβάλλον ΓΣΠ. Πολλά όμως δεδομένα τα οποία αφορούν πολύγωνα ή σημεία δεν έχουν 

γνωστή την ακριβή θέση στον γεωγραφικό χώρο και η ανάλυση γίνεται με βάση την 

οργάνωσή τους σε πίνακες. Οι πίνακες αυτοί μπορεί να αναλυθούν αυτόνομα ή να 

συνδεθούν με ένα ΓΣΠ ως περιγραφικά χαρακτηριστικά. (Ηλιοπούλου Π., 2015)  

Στην Ελλάδα ένας πρόσφατος όρος για την περιγραφή όλων των δεδομένων χωρικών και μη 

είναι τα γεωχωρικά (geospatial) δεδομένα, τα οποία ορίζονται ως «τα δεδομένα τα οποία με 

κάποιο άμεσο ή έμμεσο τρόπο σχετίζονται με τον χώρο» (Δημόσια Ανοικτά Δεδομένα  

http://geodata.gov.gr ). 

 

http://geodata.gov.gr/
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1.2   Γεωγραφικά Συστήματα Πληροφοριών (ΓΣΠ) 

Η πρώτη προσπάθεια για συστηματική χρησιμοποίηση των χαρτογραφικών δεδομένων έγινε 

κατά τη διάρκεια των δεκαετιών του '60 και του '70. Ιδιαίτερα οι σχεδιαστές και οι 

αρχιτέκτονες στις Η.Π.Α. συνειδητοποίησαν ότι τα δεδομένα που προέρχονται από 

διαφορετικές πρωτογενείς έρευνες, μπορούν να συνδυαστούν και να ενοποιηθούν 

επικαλύπτοντας διαφανή αντίγραφα χαρτών σε μία φωτεινή τράπεζα. Ο πιο γνωστός 

υποστηρικτής της απλής αυτής τεχνικής ήταν ο αμερικανός αρχιτέκτονας Ian McHarg 

(McHarg I. L., 1969).  

Στη διάρκεια των τελευταίων δεκαετιών διαπιστώθηκε σε πολλές χώρες ότι οι ανάγκες για 

αξιόπιστες και ενημερωμένες πληροφορίες γύρω από τη γη, την κοινωνία και το 

περιβάλλον δεν μπορούσαν να ικανοποιηθούν με τους παραδοσιακούς τρόπους συλλογής, 

καταγραφής, ενημέρωσης και επεξεργασίας  πληροφοριών. Έτσι, ειδικά από τις αρχές της 

δεκαετίας του ΄80, γνώρισαν εξαιρετικά μεγάλη ανάπτυξη τα Γεωγραφικά Συστήματα 

Πληροφοριών  (ακρωνύμιο GIS των λέξεων Geographic Information Systems). 

Υπάρχουν πάρα πολλοί ορισμοί, για το τι είναι ένα ΓΣΠ: 

 «Τα ΓΣΠ αντιπροσωπεύουν ένα ισχυρό σύνολο εργαλείων για τη συλλογή, αποθήκευση, 

ανάληψη ανά πάσα στιγμή, μετασχηματισμό και απεικόνιση χωρικών στοιχείων του 

πραγματικού κόσμου» (Burrough P., 1986).  

«ΓΣΠ είναι ένα σύστημα το οποίο αποτελείται από υλικό (hardware), λογισμικό (software), 

δεδομένα (data), ανθρώπους (people), οργανισμούς (organizations) και θεσμικές ρυθμίσεις 

(institutional arrangements) για τη συλλογή (collecting), αποθήκευση (storing), ανάλυση 

(analyzing), και διάδοση (disseminating) πληροφοριών σχετικά με περιοχές της γης» (Dueker 

& Kjerne, 1989). 

«ΓΣΠ είναι ένα πληροφοριακό σύστημα βασισμένο σε υπολογιστές το οποίο καθιστά ικανή τη 

σύλληψη (capture), μοντελοποίηση (modelling), χειρισμό (manipulation), ανάκτηση 

(retrieval), ανάλυση (analysis) και παρουσίαση (presentation) των γεωγραφικών 

αναφερόμενων δεδομένων» (Worboys, 1995).  

«Γεωγραφικό Σύστημα Πληροφοριών είναι μια οργανωμένη συλλογή μηχανικών 

υπολογιστικών μηχανημάτων (hardware), λογισμικών συστημάτων (software), χωρικών 

δεδομένων και ανθρώπινου δυναμικού, με σκοπό τη συλλογή, καταχώρηση, ενημέρωση, 

διαχείριση, ανάλυση και απόδοση, κάθε μορφής πληροφορίας που αφορά στο 

γεωγραφικό περιβάλλον» (Κουτσόπουλος Κ., 2002) 

Από τους παραπάνω ορισμούς διαπιστώνουμε ότι ένα ΓΣΠ, έχει τη δυνατότητα να φέρει σε 

πέρας τις εξής τρεις ιδιότητες : 
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 Μπορεί  να  αποθηκεύσει,  να  διαχειριστεί και  να  ενσωματώσει  ένα  μεγάλο  όγκο 

χωρικών στοιχείων. 

 Αποτελεί το πιο κατάλληλο εργαλείο χωρικής ανάλυσης, εστιαζόμενο ειδικά στη 

χωρική διάσταση των στοιχείων.  

 Αποτελεί ένα πολύ αποτελεσματικό μηχανισμό για την επίλυση χωρικών 

προβλημάτων μέσα από την οργάνωση, διαχείριση και μετασχηματισμό μεγάλου 

όγκου στοιχείων με τέτοιο τρόπο που η πληροφορία είναι προσιτή σε όλους.  

1.2.1   Τα μέρη ενός ΓΣΠ 

 Τα  ΓΣΠ έχουν τρία βασικά συστατικά τα οποία βρίσκονται σε συνεχή ισορροπία και 

αλληλεξάρτηση. Τα τρία αυτά μέρη είναι τα μηχανήματα (hardware), το λογισμικό 

(Software) και τα διαθέσιμα (resources).    

Εικόνα 1.2.1: Πηγή   (Κουτσόπουλος Κ., 2002) 

Το λογισμικό που επιτελεί συγκεκριμένες διεργασίες εξυπηρετώντας το γεωγραφικό 

πληροφοριακό σύστημα μπορεί να εκτελείται σε ένα ευρύ φάσμα τύπων υλικού, από 

κεντρικούς εξυπηρετητές υπολογιστών σε επιτραπέζιους υπολογιστές που χρησιμοποιούνται 

αυτόνομα ή ως μέρος δικτύου. Το λογισμικό του ΓΣΠ παρέχει λειτουργίες και τα εργαλεία 

που απαιτούνται για την εισαγωγή και αποθήκευση γεωγραφικών πληροφοριών. Παρέχει, 

επίσης, εργαλεία ερωτημάτων, αναλύει, και εμφανίζει γεωγραφικές πληροφορίες με τη 

μορφή χαρτών. Όλα τα πακέτα λογισμικού ΓΣΠ βασίζονται σε ένα σύστημα διαχείρισης 

βάσεων δεδομένων (DBMS) για την αποθήκευση και διαχείριση της γεωγραφικής 
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πληροφορίας και παρέχουν τα δεδομένα. Το ΓΣΠ επικοινωνεί με το DBMS για την 

εκτέλεση ερωτημάτων που καθορίζονται από το χρήστη. Επίσης το λογισμικό θα πρέπει να 

παρέχει ένα γραφικό περιβάλλον για τους χρήστες του (Graphical User Interface (GUI))  

(Κουτσόπουλος Κ., 2002). 

Η αγορά ενός υπολογιστικού συστήματος με το αναγκαίο λογισμικό δεν εξασφαλίζει καμιά 

επιτυχία σε οποιαδήποτε προσπάθεια αν δεν υπάρχουν τα κατάλληλα στοιχεία, οι 

εξειδικευμένοι  χειριστές  και  αναλυτές  χώρου  και   βέβαια  ένας  οργανισμός που να 

υποστηρίζει το  σύνολο των διαδικασιών που απαιτεί η χρήση ενός ΓΣΠ. 

1.2.2   Δομές δεδομένων 

Στη χαρτογράφηση των δεδομένων συνήθως χρησιμοποιούμε το ψηφιδωτό (raster) 

μοντέλο ή το διανυσματικό (vector) μοντέλο (Εικ. 1.2.2).  

Διανυσματικό (Vector) μοντέλο. Όλα τα χωρικά δεδομένα μπορούν να αναπαρασταθούν 

με τρεις βασικούς τύπου γεωμετριών: σημεία, γραμμές, πολύγωνα. Έτσι για την απόδοση 

της θέσης μια πόλης σε ένα χάρτη μπορεί να χρησιμοποιηθεί ένα σημείο, για την 

αποτύπωση ενός ποταμού μια γραμμή αποτελούμενη από πολλές κορυφές και για την 

αποτύπωση μιας δασικής έκτασης ένα πολύγωνο. Στην ουσία τα πάντα αναπαρίστανται από 

γραμμές. Το σημείο είναι μια γραμμή μηδενικού μήκους, ενώ το πολύγωνο είναι μια 

ακολουθία γραμμών με αρχή και τέλος την ίδια κορυφή. Η γεωμετρία που θα υιοθετηθεί για 

το συμβολισμό ενός αντικειμένου εξαρτάται από την κλίμακα απεικόνισης και το σκοπό της 

εφαρμογής που αναπτύσσεται. Έτσι π.χ. σε μια πολύ μεγάλη κλίμακα (1:1000) τα κτίσματα 

αποτυπώνονται ως πολύγωνα, ενώ σε μικρότερες κλίμακες (1:10.000) είναι ορθότερο να 

χρησιμοποιηθεί η γεωμετρία του σημείου. Τέλος κάθε γεωμετρία συνδέεται με μια σχέση 1-

1 με μια εγγραφή σε ένα πίνακα περιγραφικών χαρακτηριστικών. 

 

Εικόνα 1.2.2: Πηγή https://e-class.teilar.gr/modules/document/  

https://e-class.teilar.gr/modules/document/
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Ψηφιδωτό (Raster) μοντέλο. Η ψηφιδωτή δομή δεδομένων χρησιμοποιείται σε 

περιπτώσεις που το χωρικό φαινόμενο που αποτυπώνεται χαρακτηρίζεται ως συνεχής 

μεταβλητή (π.χ. το υψόμετρο του εδάφους, η κατανομή του θορύβου) ή σε περιπτώσεις που 

στο ΣΓΠ θέλουμε να ενσωματώσουμε μια δορυφορική εικόνα ή μια σαρωμένη 

αεροφωτογραφία. Οι ψηφιδωτές δομές δεδομένων έχουν περιορισμένες δυνατότητες 

σύνδεσης με περιγραφικά χαρακτηριστικά.  

1.2.3   Οι Διαδικασίες των ΓΣΠ 

Οι διαδικασίες που πρέπει να καλύπτονται από ένα ΓΣΠ αφορούν όλες τις διαδικασίες 

διαχείρισης και σχεδιασμού του χώρου. Πιο συγκεκριμένα το λογισμικό πρέπει να παρέχει 

τις πέντε παρακάτω βασικές λειτουργίες για χωρικά δεδομένα: 

 Εισαγωγή: Τα δεδομένα που χρησιμοποιούνται σε ένα Γεωγραφικό Σύστημα 

Πληροφοριών προέρχονται κυρίως από ψηφιοποίηση ή από τη σάρωση 

αεροφωτογραφιών και χαρτών ή από ήδη υπάρχοντα στοιχεία σε γεωγραφικές 

βάσεις δεδομένων. 

 Επεξεργασία: Τα δεδομένα πρέπει να υποστούν εκείνη την επεξεργασία που τα 

καθιστά κατάλληλα για παραπέρα ανάλυση και χρήση. Αυτό μπορεί να αφορά την 

ορθή απόδοση του συστήματος συντεταγμένων, την δημιουργία σχέσεων μεταξύ 

των δεδομένων, τη διόρθωση σφαλμάτων, την μετάβαση από μια δομή σε μια άλλη. 

 Ανάλυση: Ο χρήστης - αναλυτής θέτει ερωτήσεις σύμφωνα με την δυνατότητα των 

ίδιων των δεδομένων. Οι ερωτήσεις μπορεί να είναι του τύπου : 

Τι βρίσκεται στο ............; ( Χωρική ερώτηση  ή ερώτηση εντοπισμού : Τι υπάρχει 

σε μια συγκεκριμένη θέση ) 

Που βρίσκεται το ..........; ( Ερώτηση ιδιότητας-κατάστασης : Ποιες περιοχές 

ικανοποιούν συγκεκριμένες συνθήκες ) 

Πόσο έχει αλλάξει ........;  ( Ερώτηση τάσης : Προσδιορίζει γεωγραφικά συμβάντα ή 

τάσεις οι οποίες έχουν αλλάξει ή βρίσκονται σε διαδικασία αλλαγής) 

Ποια δεδομένα σχετίζονται ........ ; ( Ερώτηση σχέσεων : Αναλύει τις χωρικές 

σχέσεις μεταξύ γεωγραφικών οντοτήτων ) 

Τι θα γίνει αν ..........; ( Ερώτηση μοντελοποίησης : Υπολογισμός και εμφάνιση 

βέλτιστης διαδρομής, κατάλληλης θέσης κ.λ.π με βάση κάποιο μοντέλο ) 

 Απόδοση: Η απόδοση των αποτελεσμάτων της ανάλυσης γίνεται σε αναλογικά μέσα 

με την οργάνωση της εκτύπωσης χαρτογραφικών προϊόντων ή με την απόδοση σε 

ψηφιακές πλατφόρμες είτε με τη χρήση του Διαδικτύου, μέσω διαδραστικών χαρτών 
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(Web-based GIS), είτε σε μέσω εσωτερικών δικτύων οργανισμών μέσω εφαρμογών 

που υποστηρίζουν πολλαπλούς χρήστες με διακριτούς ρόλους (Enterprise GIS). 

 Έλεγχος: Κάθε σύστημα οφείλει να έχει μηχανισμούς ανάδρασης (feedback) ώστε 

να εξασφαλίζεται η ορθότητα και ακρίβεια των πληροφοριών. Αυτό μπορεί να 

γίνεται μέσω λογισμικού με διαδικασίες κανόνων επικύρωσης, με διαδικασίες 

ελέγχου ακρίβειας συντεταγμένων και γενικότερα με διαδικασίες ποιοτικών και 

ποσοτικών ελέγχων ανάλογα με τη φύση των δεδομένων.  

(https://el.wikipedia.org/wiki , 2018) 

1.2.4   Εφαρμογές των ΓΣΠ 

Τα ΓΣΠ μπορούν να εφαρμοστούν όπου υπάρχει ανάγκη για διαχείριση χωρικών δεδομένων 

ή όπου υπάρχει ανάγκη για ανάλυση της χωρικής διάστασης των δεδομένων. Οι 

σημαντικότερες εφαρμογές των ΓΣΠ είναι οι εξής: 

 Καταγραφή και διαχείριση της δημόσιας και ιδιωτικής ακίνητης περιουσίας 

(κτηματολόγιο). 

 Πολεοδομικός και χωροταξικός σχεδιασμός. 

 Διαχείριση οδικών δικτύων. 

 Εθνική άμυνα και κατανομή στρατιωτικών εγκαταστάσεων. 

 Αντιμετώπιση φυσικών καταστροφών και προστασία του περιβάλλοντος με τη 

δυνατότητα δημιουργίας σεναρίων καταστάσεων έκτακτης ανάγκης και άσκηση των 

υπηρεσιών στην αντιμετώπισή τους. 

 Διαχείριση των φυσικών πόρων και των καλλιεργειών. 

 Διαχείριση των δικτύων των οργανισμών κοινής ωφέλειας (ηλεκτρικό, τηλέφωνο, 

νερό, αποχέτευση, φυσικό αέριο, καλωδιακή τηλεόραση). 

 Παρακολούθηση των οικονομικών, εμπορικών, βιομηχανικών και βιοτεχνικών 

δραστηριοτήτων για τον καλύτερο σχεδιασμό της ανάπτυξης της εθνικής 

οικονομίας. 

 Παρακολούθηση της υγείας του πληθυσμού, εντοπισμό επιδημιών στη γένεσή τους, 

σχεδιασμό νοσηλευτικών κέντρων σε σχέση με την κατανομή του πληθυσμού. 

 Καταγραφή, τεκμηρίωση και προβολή των αρχαιολογικών ευρημάτων και μνημείων 

της χώρας. 

 Παρακολούθηση της εκπαίδευσης του πληθυσμού, συσχέτιση πληθυσμιακών 

δεδομένων και σχεδιασμού νέων εγκαταστάσεων εκπαίδευσης. 

 Διαχείριση δημογραφικών στοιχείων για την μακροπρόθεσμη πολιτική ανάπτυξης. 

 Εθνική ασφάλεια και καταπολέμηση του εγκλήματος. 

https://el.wikipedia.org/wiki
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1.3   Δεδομένα και λογισμικό που χρησιμοποιήθηκαν 

Τα πρωτογενή δεδομένα που χρησιμοποιήσαμε ήταν : 

 Όρια Δήμων, Περιφερειακών Ενοτήτων και Περιφερειών από τα Δημόσια Ανοιχτά 

Δεδομένα. 

 Το ASTER Global Digital Elevation Model από το Υπουργείο Οικονομίας, 

Εμπορίου και Βιομηχανίας της Ιαπωνίας (ΜΕΤΙ) και της Εθνικής Υπηρεσίας 

Αεροναυτικής και Διαστήματος των Ηνωμένων Πολιτειών (NASA). 

 Μετρήσεις της μέσης ετήσιας ταχύτητας του ανέμου από τα Δημόσια Ανοιχτά 

Δεδομένα. 

 Δεδομένα του προγράμματος Corine Land Cover για τα έτη 2006 & 2012 από την 

ΕΚΧΑ ΑΕ. 

 Αποτελέσματα απογραφής του μόνιμου πληθυσμού για το έτος 2011 από την 

ΕΛΣΤΑΤ. 

Για την υλοποίηση των διαδικασιών των ΓΣΠ χρησιμοποιήθηκε  η Δωρεάν Δοκιμαστική 

Έκδοση του ArcGISPro 2.1 (Εικ. 1.3.1). Επειδή η έκδοση δεν υποστηρίζει τις Προσωπικές 

Γεωβάσεις όλα τα δεδομένα αποθηκεύτηκαν στο project «Γεωγραφική Ανάλυση ΠΣΕ» του 

ArcGIS Pro 2.1. Με αυτή την επιλογή, εκτός των άλλων, υπάρχει η δυνατότητα να 

υπολογίζονται αυτόματα μήκη και εμβαδά των διανυσματικών επιπέδων πληροφοριών, κάτι 

που αποδείχτηκε ιδιαίτερα χρήσιμο κατά τη διάρκεια της υλοποίησης της εργασίας  (Εικ. 

1.3.2) .  

 

Εικόνα 1.3.1 
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Εικόνα 1.3.2: Το περιβάλλον του ArcGISPro 2.1 
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2.   ΨΗΦΙΑΚΑ ΜΟΝΤΕΛΑ ΕΔΑΦΟΥΣ 

2.1  Βασικές έννοιες 

Το ψηφιακό μοντέλο εδάφους ή αναγλύφου (Digital Terrain Models - DTM, ή και Digital 

Elevation Models - DEM) είναι μια ψηφιακή αναπαράσταση του γήινου αναγλύφου, η 

οποία περιγράφει τη γεωμετρία της γήινης επιφάνειας. Αποτελεί ένα χρήσιμο βοήθημα στη 

διαδικασία ανάλυσης, επεξεργασίας και παρουσίασης πληροφοριών που σχετίζονται με το 

φυσικό περιβάλλον (Εικόνα 2.1).  

 

Εικόνα 2.1:  Πηγή: https://asterweb.jpl.nasa.gov/gdem.asp 

Τα ψηφιακά μοντέλα εδάφους (DTM) άρχισαν να χρησιμοποιούνται από το 1950 (Miller & 

Laflamme, R., 1958). Στις μέρες μας η εξέλιξη της επιστήμης της πληροφορικής και των 

Γεωγραφικών Συστημάτων Πληροφοριών αναβάθμισε το ρόλο τους και τα κατέστησε 

ιδιαίτερα αξιόπιστα και χρήσιμα (Chang, 2003). Πολλοί ερευνητές τα θεωρούν απαραίτητα 

σε πολλές εφαρμογές γεωγραφικής ανάλυσης (Catlow, 1986), (Peckham & Jordan, G., 

2007).  

Σαν Ψηφιακό Μοντέλο Εδάφους ((DTM) μπορούμε να θεωρήσουμε κάθε ψηφιακή 

αναπαράσταση του εδάφους. Συνήθως με τον όρο DTM αναφερόμαστε σε χωρικά μοντέλα 

με συνεχή κατανομή στο χώρο (Χαλκιάς, 2006). Ο όρος Digital Elevation Model  / Matrix 

(DEM) είναι πιο ειδικός και αναφέρεται μόνο στην ψηφιακή αναπαράσταση υψομέτρων, 

ενώ ο όρος Digital Surface Model (DSM) χρησιμοποιείται επίσης σε ψηφιακές 

αναπαραστάσεις της γήινης επιφάνειας λαμβάνοντας υπόψη κι άλλα στοιχεία εκτός από το 

υψόμετρο, όπως είναι οι ανθρώπινες κατασκευές, η βλάστηση κ.λ.π. (Li, Zhu, Q., & Gold, 

C., 2004) (Εικόνα 2.2).  
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Εικόνα 2.2: Ψηφιακό Μοντέλο Εδάφους (Digital Terrain Model – γαλάζιο χρώμα) και          

Ψηφιακό Μοντέλο Επιφάνειας (Digital Surface Model- κόκκινο χρώμα). (Χαλκιάς Χ., 2015)  

2.2  Πηγές δεδομένων για τα ψηφιακά μοντέλα εδάφους (ΨΜΕ) 

Οι συνηθισμένες  πηγές δεδομένων που χρησιμοποιούνται για τη δημιουργία ψηφιακών 

μοντέλων εδάφους είναι: 

 Τα δεδομένα υπαίθρου, τα οποία εξάγονται με απευθείας εδαφικές μετρήσεις που 

επιτρέπουν την άμεση καταγραφή των δεδομένων και τη μεταφορά τους σ’ έναν 

Η/Υ. Μέχρι πρόσφατα οι μετρήσεις γίνονταν με τοπογραφικά όργανα, όμως πλέον 

πραγματοποιούνται με τη χρήση διαφορικών GPS. Από τα δεδομένα υπαίθρου, και 

μέσω χωρικής παρεμβολής, δημιουργούνται ΨΜΕ. 

 Η ψηφιοποίηση τοπογραφικών χαρτών και η κατασκευή  ΨΜΕ μέσω χωρικής 

παρεμβολής ήταν για όλες τις χώρες μέχρι πρόσφατα ο πιο διαδεδομένος τρόπος 

δημιουργίας ψηφιακών μοντέλων εδάφους ή αναγλύφου (ΨΜΕ). 

 Οι αερομεταφερόμενοι σαρωτές laser, που τροφοδοτούνται συνεχώς με δεδομένα 

διαφορικών GPS, μετρούν την απόσταση του αεροπλάνου ή του ελικοπτέρου από 

την επιφάνεια και καταγράφουν το ύψος των αντικειμένων παράγοντας ψηφιακά 

μοντέλα επιφανείας. Αποτελούν την καλύτερη μέθοδο αποτύπωσης της επιφανείας, 

έχουν όμως πολύ υψηλό κόστος και καλύπτουν μικρή επιφάνεια. 

 Οι αεροφωτογραφίες υπολογίζουν τα υψόμετρα αξιοποιώντας στερεοζεύγη 

αεροφωτογραφιών με πλευρική επικάλυψη, με βάση φωτογραμμετρικές τεχνικές που 

απορρέουν από το φαινόμενο της παράλλαξης. Το παραγόμενο Ψηφιακό Μοντέλο 

Εδάφους είναι υψηλής χωρικής διακριτικής ικανότητας και παρουσιάζει πολύ καλή 

ακρίβεια.  

 Τα οπτικά δορυφορικά δεδομένα αναπτύχθηκαν ιδιαίτερα τα τελευταία 25 χρόνια με 

τη δημιουργία ψηφιακών μοντέλων εδάφους από οπτικά δορυφορικά δεδομένα. Η 

αρχή έγινε με την εκτόξευση του δορυφόρου SPOT 1 (1986) ο οποίος παρείχε το 

πρώτο σύστημα αυτόματης δημιουργίας υψομετρικών δεδομένων για εκτεταμένες 

περιοχές της γης (και με ικανοποιητική ακρίβεια) με τη σύνθεση στερεοζεύγους 

εικόνων. Μέχρι σήμερα, έχουν αναπτυχθεί για αυτό το σκοπό αρκετά συστήματα τα 
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οποία βασίζονται σε παρόμοιες μεθόδους ή στην λογική των ενεργητικών 

συστημάτων (radar).  

 Oι εικόνες ραντάρ (SAR) καταγράφουν το χρόνο ενός παλμού επιστροφής και την 

έντασή του, καθώς και τη φάση των μικροκυμάτων. Αυτά τα σήματα φάσης 

δημιουργούν ένα συμβολογράφημα μεταξύ δύο λήψεων δεδομένων SAR. Η 

συμβολομετρία ραντάρ (InSAR) χρησιμοποιείται για μέτρηση του υψόμετρου του 

εδάφους, ενώ το διαφορικό InSAR (DInSAR) χρησιμοποιείται για μέτρηση της 

μετατόπισης του εδάφους, όπως είναι η ροή ενός παγετώνα. Υπάρχουν τέσσερις 

διαφορετικοί τρόποι για την εξαγωγή υψομετρικών δεδομένων από εικόνες ραντάρ 

(Toutin & Gray, L., 2000): κλισιμετρία, στερεοσκοπία, πολωσιμετρία και 

συμβολομετρία. 

 Οι φωτογραφίες από UAV (Unmanned Aerial Vehicle) ή Drone τα οποία μπορούν 

και πετούν σε μικρά ύψη συνήθως μικρότερα των 1.000m, χρησιμοποιούν απλές 

φωτογραφικές μηχανές και λαμβάνουν φωτογραφίες του γήινου αναγλύφου με 

στερεο-επικάλυψη. Η εξαγωγή της υψομετρικής πληροφορίας βασίζεται στη 

στερεοσκοπική παράλλαξη των εικόνων και είναι ίδια με τις αρχές που διέπουν την 

κλασική αέρια φωτογραμμετρία. Η έκταση που καλύπτεται είναι συνήθως μικρή, 

αλλά η υψομετρική ακρίβεια που επιτυγχάνεται είναι πάρα πολύ υψηλή. Η χωρική 

διακριτική ικανότητα εξαρτάται από το ύψος πτήσης και κυμαίνεται από 1 έως 

μερικές δεκάδες εκατοστά. 

2.3 Μορφές ψηφιακών μοντέλων εδάφους (ΨΜΕ) 

Από τις πρώτες δεκαετίες κατά τις οποίες προτάθηκαν από την επιστημονική κοινότητα τα 

ΨΜΕ (δεκαετίες ΄50 και ’60) μέχρι και σήμερα, έχουν χρησιμοποιηθεί αρκετά είδη 

ψηφιακών μοντέλων εδάφους. Οι διαφορές τους εντοπίζονται στη δομή αποθήκευσης και 

στον τρόπο διαχείρισης των δεδομένων.  

2.3.1 Ισοϋψείς 

Είναι καμπύλες γραμμές που ενώνουν σημεία με το ίδιο υψόμετρο. Η μεταβολή του 

υψομέτρου από τη μία ισοϋψή στην επόμενη ονομάζεται ισοδιάσταση. Η συνηθισμένη 

ισοδιάσταση των τοπογραφικών χαρτών 1:5.000 είναι 4 m, ενώ των τοπογραφικών χαρτών 

1:50.000 είναι 20 m. 

Οι ισοϋψείς καμπύλες σχεδιάζονται εύκολα και τις αντιλαμβάνεται με ευκολία ο άνθρωπος, 

λόγω της εξοικείωσής του με τους χάρτες. Όμως είναι ακατάλληλες για αυτοματοποιημένη 

επεξεργασία και η παρεμβολή για τα σημεία μεταξύ των ισοϋψών είναι απαραίτητη. Στις 
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Εικόνες 2.3α και 2.3β παρουσιάζονται ισοϋψείς, που προέκυψαν από την ψηφιοποίηση 

χάρτη της ΓΥΣ κλίμακας 1:50000, σε ένα Δημοτικό Διαμέρισμα της Περιφερειακής 

Ενότητας Φθιώτιδας με ισοδιάσταση 20 και 100 m, αντίστοιχα. 

 

                
                               α                                                                          β 
Εικόνα 2.3:  Ισοϋψείς καμπύλες από τη Φθιώτιδα με ισοδιάσταση α) 20 m και β)100 m, ιδία επεξεργασία. 

2.3.2  Δεδομένα καννάβου (grid) 

Ουσιαστικά πρόκειται για την ίδια δομή αρχείου με την ψηφιακή εικόνα, μόνο που αντί για 

τιμή φωτεινότητας, σε κάθε εικονοστοιχείο αντιστοιχεί μια τιμή υψομέτρου. 

Δημιουργούνται συνήθως από αεροφωτογραφίες, δορυφορικές εικόνες ή εικόνες ραντάρ. 

Είναι ο πιο απλός τρόπος αναπαράστασης υψομετρικών δεδομένων και για την επεξεργασία 

τους απαιτούν λιγότερη υπολογιστική ισχύ. Είναι εύκολο να χρησιμοποιηθούν για την 

παραγωγή θεματικών χαρτών (π.χ. χάρτες κλίσεων) και μπορούν να χρησιμοποιηθούν 

άμεσα για την ορθοαναγωγή εικόνων. 

Ωστόσο παρουσιάζουν προβλήματα στην απόδοση απότομων αλλαγών του υψομέτρου, 

λόγω της κανονικότητας του καννάβου και μπορεί να συμπεριλαμβάνουν πλεονάζοντα 

δεδομένα σε περιοχές ήπιου αναγλύφου. Η ακρίβεια τους εξαρτάται από την πυκνότητα της 

δειγματοληψίας. Στην Εικόνα 2.4 παρουσιάζεται ένα ΨΜΕ της ίδιας περιοχής σε δομή grid. 
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Εικόνα 2.4: ΨΜΕ σε δομή grid, από την ίδια περιοχή της Φθιώτιδας, ιδία επεξεργασία 

 

2.3.3  Δίκτυο ακανόνιστων τριγώνων 

Ένα δίκτυο ακανόνιστων τριγώνων (Triangular Irregular Network (TIN)), όπως 

χαρακτηριστικά περιγράφει και το όνομα του, αναπαριστά την επιφάνεια ως ένα σύνολο 

συνδεδεμένων γειτονικών τριγώνων με άνισες πλευρές. Οι τριάδες των σημείων βρίσκονται, 

γενικά, σε ακανόνιστη διάταξη. Όμως για την πιο εύκολη πρόσβαση των δεδομένων, τα 

τρίγωνα συνδέονται μεταξύ τους και αριθμούνται. Η δημιουργία των τριγώνων αυτών 

πρέπει να ικανοποιεί το κριτήριο Delaunay, σύμφωνα με το οποίο ο περιγεγραμμένος 

κύκλος στις κορυφές του τριγώνου, δε θα πρέπει να περιέχει άλλο σημείο. Μ’ αυτόν τον 

τρόπο όλοι οι κόμβοι συνδέονται με τους δύο πλησιέστερους. Επίσης, η ικανοποίηση του 

κριτηρίου αυτού εξασφαλίζει τη μονοσήμαντη δημιουργία των τριγώνων, η οποία επιπλέον, 

δεν εξαρτάται από τη σειρά επεξεργασίας των δεδομένων (Εικόνες 2.5 και 2.6). Το μέγεθος 

και το σχήμα κάθε τριγώνου μπορεί να μεταβληθεί ανάλογα με την απαιτούμενη 

μορφολογία του εδάφους. 
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Εικόνα 2.5: Ο τριγωνισμός Τ ενός συνόλου σημείων P είναι τριγωνισμός Delaunay αν o κύκλος που 

σχηματίζεται από κάθε τρίγωνο που ανήκει στο Τ δεν περιέχει κανένα από τα σημεία του P στο 

εσωτερικό του. (http://groups.csail.mit.edu/graphics/classes/6.838/.../Delaunay2D.ppt) 

 
Εικόνα 2.6: Έστω τα σημεία pi , pj, pm, pk και pl που ανήκουν σε ένα σύνολο σημείων P και οι κύκλοι 

C(pi pj, pm, ) και C(pi pj, pk, ). Το σημείο pl εμπίπτει μέσα στους δυο κύκλους άρα τα σχηματιζόμενα 

από τα σημεία pi , pj, pm, και pk τρίγωνα δεν υπακούουν στο κριτήριο Delaunay και πρέπει να 

αποκλειστούν. (http://groups.csail.mit.edu/graphics/classes/6.838/.../Delaunay2D.ppt) 

Τα στοιχεία ενός μοντέλου ΤΙΝ (Εικόνα 2.7) είναι τα παρακάτω: 

 Κόμβοι (Nodes): Είναι το βασικό στοιχείο του μοντέλου ΤΙΝ. Οι κόμβοι 

δημιουργούνται από τα δεδομένα εισαγωγής. Κάθε κόμβος είναι κορυφή τριγώνου 

και έχει μια τιμή Ζ της συνεχούς μεταβλητής, καθώς και συντεταγμένες Χ,Υ. 

 Πλευρές Τριγώνων (edges): Κάθε κόμβος συνδέεται με τους δύο πλησιέστερους  

σύμφωνα με το κριτήριο Delaunay. Κάθε πλευρά έχει δύο κόμβους, αλλά κάθε 

κόμβος μπορεί να ανήκει σε περισσότερες από δύο πλευρές. 

 Τρίγωνα (triangles): Κάθε τρίγωνο του μοντέλου περιγράφει ένα τμήμα της 

επιφάνειας. Είναι η στοιχειώδης δομική μονάδα και μπορεί να δώσει ποσοτικά 

στοιχεία σχετικά με την κλίση, τον προσανατολισμό, την επιφάνεια κ.λ.π. επίσης, ο 

συνδυασμός τριγώνων μπορεί να δώσει πληροφορίες σχετικές με τους όγκους, τις 

τομές επιφανειών, τις συνθήκες ορατότητας κ.λ.π. 
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Εικόνα 2.7: Τα βασικά στοιχεία του μοντέλου TIN 

Πηγή: https://en.wikipedia.org/wiki/Delaunay_triangulation 

Τα ΤΙΝ δέχονται κανονικά και μη κανονικά κατανεμημένα δεδομένα, χωρίς παρεμβολή, και 

έχουν το πλεονέκτημα της πλήρους προσαρμογής στο ανάγλυφο του εδάφους μέσω της 

διαφοροποίησης του μεγέθους των τριγώνων. Δέχονται επιπλέον σημειακά χαρακτηριστικά 

και γραμμές αλλαγής χαρακτηριστικών αναγλύφου αλλά δεν έχουν τη δυνατότητα για 

άμεση περαιτέρω επεξεργασία. Προκειμένου να χρησιμοποιηθούν για την παραγωγή 

χαρτών κλίσεων ή για ορθοαναγωγή δεδομένων, πρέπει να μετατραπούν σε grid. Στην 

Εικόνα 2.8 παρουσιάζεται το ΨΜΕ της ίδιας περιοχής της Φθιώτιδας  σε δομή TIN. 

 

Εικόνα 2.8:  ΨΜΕ σε δομή TIN, από την ίδια περιοχή της Φθιώτιδας, ιδία επεξεργασία. 

https://en.wikipedia.org/wiki/Delaunay_triangulation
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Σήμερα, από τις παραπάνω δομές, χρησιμοποιούνται κυρίως τα ακανόνιστα τριγωνικά 

δίκτυα (Triangular Irregular Network) και τα ψηφιακά υψομετρικά μοντέλα DEM (Digital 

Elevation Matrices) (Li, Zhu, Q., & Gold, C., 2004).  

2.4  Σφάλματα Ψηφιακών Μοντέλων Εδάφους (ΨΜΕ) 

Σε γενικές γραμμές για ένα συγκεκριμένο σημείο, σαν σφάλμα ορίζεται η διαφορά ανάμεσα 

στην πραγματική τιμή και την τιμή που μετράμε. Τα σφάλματα γενικά, αλλά και 

συγκεκριμένα για τα ΨΜΕ, είναι τριών ειδών: 

 Τα τυχαία σφάλματα που ακολουθούν στις περισσότερες περιπτώσεις κανονική 

κατανομή και παρουσιάζονται σε όλες τις μετρήσεις. 

 Τα συστηματικά σφάλματα, τα οποία μπορούν να μοντελοποιηθούν μαθηματικά και 

σχετίζονται με τη λανθασμένη ή ημιτελή βαθμονόμηση των οργάνων με τα οποία 

γίνονται οι μετρήσεις, τις ενδεχόμενες ατέλειές τους, τις καιρικές συνθήκες κ.α. Τα 

συστηματικά σφάλματα δεν μπορούν να εντοπιστούν αν οι μετρήσεις γίνονται με το 

ίδιο σύστημα «όργανο – παρατηρητής – συνθήκες». 

 Τα χονδροειδή σφάλματα, τα οποία δεν μπορούν να προβλεφθούν, όπως και τα 

τυχαία, και εμφανίζονται σε κάποιες παρατηρήσεις, ενώ γίνονται αντιληπτά από το 

πολύ μεγάλο μέγεθός τους. 

Τα χονδροειδή και συστηματικά σφάλματα συνήθως είναι τα πρώτα που εξαλείφονται από 

τον έλεγχο που πραγματοποιείται. Παρόλα αυτά παραμένει ένα μικρό ποσοστό 

συστηματικών σφαλμάτων μαζί με τα τυχαία. Τα εναπομείναντα αυτά σφάλματα 

αντιμετωπίζονται από κοινού με στατιστικά μοντέλα (Αγατζά – Μπαλοδήμου, 2009). 

Τα σφάλματα των ΨΜΕ σχετίζονται με την ακρίβεια και την πυκνότητα των δεδομένων που 

έχουν συλλεχθεί, τη μορφολογία του εδάφους και τη μέθοδο παρεμβολής που εφαρμόστηκε 

για την παραγωγή τους (Hu, Liu, X., & Hu, H., 2009). Αν και γενικά η θεωρία της 

μετάδοσης σφαλμάτων υποστηρίζει ότι τα σφάλματα των ΨΜΕ είναι τυχαία και ανεξάρτητα 

μεταξύ τους, στην πραγματικότητα κάτι τέτοιο δεν ισχύει καθώς αυτά σχετίζονται, όπως 

αναφέρθηκε, με τις παραπάνω συνιστώσες (Hu, Liu, X., & Hu, H., 2009). 

2.5  H χρήση των ψηφιακών μοντέλων εδάφους (ΨΜΕ) 

Μετά τη δημιουργία του ψηφιακού μοντέλου εδάφους μπορεί να εξαχθούν από αυτό πολλά 

παράγωγα θεματικά επίπεδα, τα οποία μπορούν να χρησιμοποιηθούν σε πολλές εφαρμογές, 

όπως: 
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 Η χωροθέτηση τηλεπικοινωνιακών δικτύων (τηλεόραση, ραδιόφωνο, κινητή 

τηλεφωνία). 

 Ο σχεδιασμός (κατασκευή και συντήρηση) μεγάλων τεχνικών έργων (αεροδρομίων, 

αυτοκινητοδρόμων, λιμανιών, διωρύγων, σταθμών παροχής ηλεκτρικής ενέργειας, 

πετρελαιαγωγών, κ.ά. 

 Η μελέτη διάβρωσης (με μελέτη κλίσεων, περιγραφή γεωμορφολογικών μονάδων, 

κ.λπ.). 

 Η μελέτη επιφανειακής απορροής υδάτων, ανάλυση στραγγίσεων, σχεδιασμός 

λιμνοδεξαμενών και φραγμάτων. 

 Η πολιτική προστασία, μέσω του εντοπισμού περιοχών που κινδυνεύουν από 

πλημμύρες, τσουνάμι κ.ά. 

 Ο σχεδιασμός δικτύων αποστράγγισης και άρδευσης γεωργικών εκτάσεων. 

 Η προσομοίωση πτήσεων και η καθοδήγηση πυραύλων. 

 Η ψηφιακή επεξεργασία εικόνας και ορθοαναγωγή δεδομένων τηλεπισκόπησης. 

2.6  Εφαρμογή στην Περιφέρεια Στερεάς Ελλάδας 

2.6.1  Το Ψηφιακό Μοντέλο Εδάφους της Περιφέρειας Στερεάς Ελλάδας 

Οι πηγές των ψηφιακών μοντέλων εδάφους για τον ελλαδικό χώρο είναι οι εξής:  

 Το ψηφιακό μοντέλο εδάφους της Κτηματολόγιο Α.Ε. με βήμα 5m 

 Το ψηφιακό μοντέλο εδάφους του ΟΚΧΕ με βήμα 10m 

 Το ψηφιακό μοντέλο εδάφους από δεδομένα SRTM (Shuttle Radar Topography 

Mission) με βήμα 90m 

 Το GDEM v.2 (δεύτερης έκδοσης) του δέκτη ASTER, με βήμα 30m 

Τα δεδομένα SRTM και ASTER GDEM διατίθενται εύκολα μέσω διαδικτύου και 

καλύπτουν το σύνολο της επικράτειας. Τα δεδομένα αυτά αποτελούν μία αξιόπιστη πηγή 

υψομετρικής πληροφορίας για τη χώρα μας. Τόσο η κατακόρυφη ακρίβεια τους, όσο κυρίως 

η πλήρης κάλυψη του χώρου και η ομοιογένεια των δεδομένων, τα καθιστούν ιδανικά για 

περιβαλλοντικές και όχι μόνο μελέτες. Η κατακόρυφη ακρίβεια παρουσιάζει διακυμάνσεις 

από περιοχή σε περιοχή, καθώς επηρεάζεται από το ανάγλυφο, και σίγουρα είναι χειρότερη 

των προδιαγραφών, κυρίως λόγω του έντονου αναγλύφου. Η κατακόρυφη ακρίβεια του 

ΨΜΕ από δεδομένα SRTM κυμαίνεται μεταξύ 30 m και 40 m (Nikolakopoulos & 

Chrysoulakis, N., 2006); (Νικολακόπουλος, Βαϊοπουλος, Δ., & Σκιανης, Γ., 2007). Η 

αντίστοιχη ακρίβεια του ASTER GDEM υπολογίστηκε ότι κυμαίνεται μεταξύ 16 και 32 m 

(Nikolakopoulos & Tsombos, 2010).   



 

30 
 

Για την εξαγωγή των παράγωγων θεματικών επιπέδων της Περιφέρειας Στερεάς Ελλάδας 

από το ΨΜΕ (π.χ.  ταξινόμηση αναγλύφου, εντοπισμό υδρογραφικού δικτύου, κατανομή 

κλίσεων εδάφους κ.α.) αποφάσισα να χρησιμοποιήσω το ASTER Global Digital Elevation 

Model, λόγω της ευκολίας στην πρόσβαση και της καλής ανάλυσης που διαθέτει, 

λαμβάνοντας υπόψη ότι η ανάλυση γίνεται σε μικρή κλίμακα, αφού αφορά όλη την έκταση 

της Περιφέρειας Στερεάς Ελλάδας.  

Το ASTER GDEM (Advanced Spaceborne Thermal Emdission & Reflection Radiometer 

Global Digital Elevation Model) κυκλοφόρησε στις 29 Ιουνίου 2009. Δημιουργήθηκε από 

κοινού από το Υπουργείο Οικονομίας, Εμπορείου και Βιομηχανίας της Ιαπωνίας (ΜΕΤΙ) 

και της Εθνικής Υπηρεσίας Αεροναυτικής και Διαστήματος των Ηνωμένων Πολιτειών 

(NASA) με τη στερεοσκοπική συσχέτιση 1,3 εκατομμυρίων εικόνων αρχείου ASTER 

VNIR.  

Κάθε αρχείο ASTER GDEM συνοδεύεται από ένα αρχείο αξιολόγησης της ποιότητας, το 

οποίο είτε αναφέρει τον αριθμό των εικόνων ASTER που χρησιμοποιήθηκαν για τον 

υπολογισμό των τιμών ενός εικονοστοιχείου, είτε αναφέρει την πηγή των εξωτερικών 

δεδομένων DEM που χρησιμοποιήθηκαν για να καλυφθούν τα κενά. Σύμφωνα με τα 

επίσημα έγγραφα αποδέσμευσης (ASTER GDEM Validation Team (2009)), το ASTER 

GDEM καλύπτει τις επιφάνειες του εδάφους μεταξύ 83°Β και 83°Ν και αποτελείται από 

22.702  εικόνες διαστάσεων 1οx1ο ( 60km × 60km). Συμπεριλαμβάνονται εικόνες που 

περιέχουν τουλάχιστον το 0,01% της έκτασης της γήινης σφαίρας. Τα δεδομένα είναι 

γεωαναφερμένα στο ελλειψοειδές WGS84, χρησιμοποιώντας την προβολή UTM και τα 

υψομετρικά δεδομένα είναι διορθωμένα ως προς το γεωειδές EGM96 (Earth Gravitational 

Model). Οι εκτιμώμενες ακρίβειες είναι της τάξης 20m με διάστημα εμπιστοσύνης 95% 

υψομετρικά και 30m με διάστημα εμπιστοσύνης 95% για τα οριζοντιογραφικά στοιχεία.  

Τα βασικά χαρακτηριστικά της συλλογής GDEM συνοψίζονται στην ακόλουθη εικόνα. 

 

Εικόνα 2.9:  Πηγή https://lpdaac.usgs.gov/dataset_discovery/aster/aster_products_table/astgtm 

https://lpdaac.usgs.gov/dataset_discovery/aster/aster_products_table/astgtm
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Υπάρχουν πέντε διαφορετικοί τρόποι για να προμηθευτεί κάποιος το  ASTER GDEM 

(https://asterweb.jpl.nasa.gov/data.asp), όπως φαίνεται στην εικόνα 2.10.  

 

Εικόνα 2.10   

Η διάθεσή του είναι δωρεάν μετά από  εγγραφή στην αντίστοιχη ιστοσελίδα που θα 

επιλέξουμε (εδώ  https://earthexplorer.usgs.gov/ ), όπως φαίνεται στην εικόνα 2.11 .  

 

Εικόνα 2.11   

https://asterweb.jpl.nasa.gov/data.asp
https://earthexplorer.usgs.gov/
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Κατά την παρουσίαση ή δημοσίευση των δεδομένων ASTER GDEM, οι χρήστες καλούνται 

να συμπεριλάβουν μια παραπομπή δηλώνοντας ότι: "ASTER GDEM is a product of METI 

and NASA", εικόνα 2.12. 

 

Εικόνα 2.12   

Από την ηλεκτρονική διεύθυνση που αναφέρθηκε (εικόνα 2.11)   κατεβάζουμε δώδεκα 

συμπιεσμένα αρχεία στα οποία περιέχεται όλη η επιφάνεια της Περιφέρειας Στερεάς 

Ελλάδας. Κάθε ένα από τα αρχεία περιέχει το Ψηφιακό Υψομετρικό Μοντέλο μιας περιοχής 

με διαστάσεις 60Km × 60Km σε GeoTIFF μορφή. Στη συνέχεια γίνεται εισαγωγή τους στο 

ArcGISPro 2.1 (Εικόνα 2.13).   

 

Εικόνα 2.13  
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Αρχικά θα ενώσουμε τις δώδεκα εικόνες και θα δημιουργήσουμε μια ενιαία 

μετασχηματίζοντας παράλληλα το σύστημα συντεταγμένων από WGS84 στο επίσημο 

ελληνικό, το ΕΓΣΑ 87. Αυτό γίνεται ως εξής: 

 Ανοίγουμε το παράθυρο του Geoprocessing από το μενού Analysis του ArcGISPro  

και αναζητούμε το εργαλείο Mosaic To New Raster.   

 Κάνουμε διπλό κλικ στο Mosaic To New Raster και εμφανίζεται η οθόνη διαλόγου 

του εργαλείου Mosaic To New Raster. Στο πρώτο παράθυρο της οθόνης 

τοποθετούνται οι δώδεκα εικόνες GeoTIFF που πρόκειται να δημιουργήσουν ένα 

ενιαίο Raster.  

 Στη συνέχεια ορίζουμε τη θέση εξαγωγής του νέου ενιαίου Raster και την ονομασία 

του. 

 Δηλώνουμε το σύστημα συντεταγμένων που θέλουμε να μετασχηματιστεί το νέο 

Raster που στην περίπτωση μας είναι το ΕΓΣΑ87 (Ελληνικό Γεωδαιτικό Σύστημα 

Αναφοράς 1987) και δηλώνεται με το Greek_Grid.  

 Διατηρούμε τις ιδιότητες των αρχικών Raster.   

 Τέλος πατάμε Run όπως φαίνεται  στην Εικόνα 2.14. 

 

Εικόνα 2.14  

Στην Εικόνα 2.15 φαίνεται η προσθήκη στον πίνακα περιεχομένων του ενιαίου Ψηφιακού 

Υψομετρικού Μοντέλου με την ονομασία Sterea_Mosaic. Στην περιοχή εκτύπωσης του 

χάρτη εμφανίζεται το νέο ενιαίο Raster μετασχηματισμένο σε ΕΓΣΑ 87.  
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Εικόνα 2.15  

Παρατηρούμε ότι καλύπτει και περιοχές εκτός των ορίων της Περιφέρειας Στερεάς 

Ελλάδας. Με την αναλυτική διαδικασία Extract by Mask  θα εξάγουμε το ΨΜΕ που 

βρίσκεται μόνο μέσα στα όρια της Περιφέρειας Στερεάς Ελλάδας. Αυτό γίνεται ως εξής: 

 Από την ιστοσελίδα Δημόσια Ανοιχτά Δεδομένα (http://geodata.gov.gr/) 

κατεβάζουμε τα όρια των Περιφερειών της Ελλάδας και τα εισάγουμε στο 

ArcGISPro σαν νέο επίπεδο πληροφορίας.  

 Κάνουμε αριστερό κλικ στο εργαλείο επιλογής και επιλέγουμε με αριστερό κλικ το 

πολύγωνο της Περιφέρειας  Στερεάς.  

 Με δεξί κλικ στο αναδυόμενο παράθυρο επιλέγουμε Export Data. 

 Στο αναδυόμενο παράθυρο Export Data αρχικά ορίζουμε το παραγόμενο αρχείο να 

έχει το ίδιο προβολικό σύστημα με το αρχείο προέλευσης, στη συνέχεια ορίζουμε τη 

θέση και το όνομα του παραγόμενου αρχείου και πατάμε Run.  

 

http://geodata.gov.gr/
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Το νέο αρχείο Oria_Perif_Stereas προστίθεται στον πίνακα περιεχομένων, εικόνα 2.16. 

 

Εικόνα 2.16  

Συνεχίζοντας τη διαδικασία: 

 Ανοίγουμε το παράθυρο του Geoprocessing από το μενού Analysis του ArcGISPro  

και αναζητούμε το εργαλείο Extract by Mask.  

 Κάνουμε διπλό κλικ στο Extract by Mask και εμφανίζεται η οθόνη διαλόγου του 

εργαλείου Extract by Mask.  

 Στο πεδίο Input raster τοποθετούμε το αρχείο Raster Sterea_Mosaic.  

 Στο πεδίο Input raster or feature mask data  τοποθετούμε το αρχείο 

Oria_Perif_Stereas.  

 Στο πεδίο Output raster ορίζουμε τη θέση και το όνομα του  ΨΜΕ της Περιφέρειας 

Στερεάς Ελλάδας. 

 Τέλος πατάμε Run όπως φαίνεται  στην Εικόνα 2.17. 

 

Εικόνα 2.17  



 

36 
 

Με δεξί κλικ στο παραγόμενο αρχείο, επιλέγουμε Symbology και μια έγχρωμη παλέτα 

χρωμάτων εικόνα 2.18α και παίρνουμε το αποτέλεσμα της εικόνας 2.18β. 

 

Εικόνα 2.18α  

 

 

Εικόνα 2.18β  

Με βάση το ψηφιακό μοντέλο εδάφους (ΨΜΕ) της Περιφέρειας Στερεάς Ελλάδας που είναι 

σε δομή grid, μπορούμε να δημιουργήσουμε τις άλλες δύο μορφές ΨΜΕ: τις ισοϋψείς και το 

TIN. Αυτό γίνεται ως εξής: 

 Ανοίγουμε το παράθυρο του Geoprocessing από το μενού Analysis του ArcGISPro  

και αναζητούμε το εργαλείο Contour.  

 Με διπλό κλικ στο Contour εμφανίζεται η οθόνη διαλόγου του εργαλείου Contour.  
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 Στο πεδίο Input raster τοποθετούμε το αρχείο Raster  Sterea_Dem. 

 Στο πεδίο Output polyline features  ορίζουμε τη θέση και το όνομα του  

παραγόμενου αρχείου.  

 Στο πεδίο contour interval ορίζω την ισοδιάσταση 100m. 

 Στο πεδίο Z factor θέτουμε τιμή 1. 

 Τέλος πατάμε Run όπως φαίνεται  στην Εικόνα 2.19. 

 

Εικόνα 2.19 

Το αποτέλεσμα είναι ο χάρτης ισοϋψών της Περιφέρειας Στερεάς με ισοδιάσταση 100m.  

 

Εικόνα 2.20 
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Χάρτης 1: Το ΨΜΕ της Περιφέρειας Στερεάς Ελλάδας σε δομή grid 

 

 



 

39 
 

 

Χάρτης 2: Το ΨΜΕ της Περιφέρειας Στερεάς Ελλάδας σε δομή ισοϋψών 
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Χάρτης 3:  Το ΨΜΕ της Περιφέρειας Στερεάς Ελλάδας σε δομή ισοϋψών με διαβάθμισή  

                       τους σε 9 κατηγορίες διαφορετικού χρώματος. 
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Για την δημιουργία του ΨΜΕ σε μορφή ΤΙΝ μπορούμε είτε να χρησιμοποιήσουμε το 

εργαλείο  Raster To TIN του 3D Analyst toolbox είτε να χρησιμοποιήσουμε το αρχείο με τις 

ισοϋψείς της Περιφέρειας Στερεάς Ελλάδας που δημιουργήσαμε προηγουμένως. 

Επιλέγοντας τον δεύτερο τρόπο η διαδικασία είναι η εξής: 

 Ανοίγουμε το παράθυρο του Geoprocessing από το μενού Analysis του ArcGISPro  

και αναζητούμε το εργαλείο Create TIN.  

 Με διπλό αριστερό κλικ εμφανίζεται η οθόνη διαλόγου του εργαλείου Create TIN 

και στο πεδίο Output TIN ορίζουμε τη θέση και το όνομα του  παραγόμενου αρχείου. 

 Στο πεδίο Coordinate System ορίζουμε το σύστημα συντεταγμένων του 

παραγόμενου αρχείου στην περίπτωση μας είναι το ΕΓΣΑ87 (Ελληνικό Γεωδαιτικό 

Σύστημα Αναφοράς 1987) και δηλώνεται με το Greek_Grid.  

 Στο πεδίο Input Feature Class εισάγουμε τα αρχεία:  των ισοϋψών και των ορίων της 

Περιφέρειας Στερεάς Ελλάδας. 

 Στο παράθυρο που ανοίγει κάνουμε τις εξής επιλογές: Για το επίπεδο των ισοϋψών 

ορίζουμε το πεδίο που έχει την πληροφορία υψομέτρου, Type: “Hard Line”, η οποία 

χρησιμοποιείται για όλες τις θέσεις απότομης αλλαγής κλίσης της επιφάνειας και 

Tag Field: “none”.  Για το επίπεδο των ορίων επιλέγουμε “none” για το υψόμετρο, 

στο Type: “Soft Clip”, η οποία χρησιμοποιείται για να εξασφαλίσει ότι οι τιμές του 

υψομέτρου (z) κατά μήκος ενός γραμμικού στοιχείου αποτελούν χαρακτηριστικά 

σημεία πάνω στα οποία μπορούν να κλείσουν τα δημιουργημένα τρίγωνα του ΤΙΝ 

μας και Tag Field: “none”.  Τέλος πατάμε Run  (Εικόνα 2.21) και δημιουργείται το 

ΤΙΝ (Χάρτης 4).   

 

Εικόνα 2.21 
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Χάρτης 4: Το ΨΜΕ της Περιφέρειας Στερεάς Ελλάδας σε δομή ΤΙΝ. 
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3.  ΑΝΑΛΥΣΗ ΑΝΑΓΛΥΦΟΥ   

Η γεωγραφική πληροφορία είναι σημαντικό χαρακτηριστικό για διάφορες δραστηριότητες, 

στρατηγικές ή μελλοντικά σχέδια. Το ανάγλυφο του εδάφους παίζει σημαντικό ρόλο σε 

αρκετές περιβαλλοντικές διεργασίες. Για παράδειγμα επηρεάζει την ροή και συσσώρευση 

του νερού και τη μεταφορά και συσσώρευση ιζημάτων, όπως άμμο, λάσπη, άργιλο, και 

άλλων ουσιών στην επιφάνεια της γης. Ακόμα επηρεάζει τα κλιματολογικά και 

μετεωρολογικά χαρακτηριστικά και τις ιδιότητες του εδάφους και έχει μια ισχυρή επίδραση 

στις χωρικές και χρονικές κατανομές του φωτός, του νερού, της θερμότητας και των 

θρεπτικών συστατικών που απαιτούνται από τα φυτά και τα ζώα (Wilson & Gallant J., 

2000). 

Η ανάλυση του αναγλύφου έχει χρησιμοποιηθεί για να αναλύσει τις σχέσεις του αναγλύφου 

με το τοπίο και να συμπεράνει τις ιδιότητες του εδάφους με βάση τις τοπογραφικές 

συνθήκες (Park, McSweetney, & Lowery, 2001), (MacMillan, 2008), για να αντλεί 

υδρολογικά, γεωμορφολογικά και βιολογικά χαρακτηριστικά του εδάφους και να τα 

μοντελοποιεί. (Moore, Guerra, L., & Kalma, J.D., 1991). Ακόμα έχει χρησιμοποιηθεί για να 

μελετήσει τις σχέσεις διαφόρων ειδών με το περιβάλλον και να προβλέψει τη διανομή των 

ειδών αυτών, (Franklin, 1998) και για να αξιολογήσει την πιθανότητα κατολίσθησης 

(Manzo, Tofani, V., Segoni, S., Battistini, A., & Catani, F., 2013). 

Επομένως η ανάλυση αναγλύφου περιλαμβάνει τις λειτουργίες χωρικής ανάλυσης που 

προσδιορίζουν τα χαρακτηριστικά του τοπογραφικού αναγλύφου και την επιρροή του 

εδάφους σε περιβαλλοντικές διαδικασίες. Για το λόγο αυτό με κατάλληλη επεξεργασία του 

διαθέσιμου ψηφιακού μοντέλου εδάφους (DEM) που δημιουργήσαμε καθώς και  άλλων 

δεδομένων θα εξάγουμε  χαρακτηριστικά του εδάφους όπως:  

 Την κατανομή Υψομέτρων (κατά Dikau, 1989) 

 Την κατανομή Κλίσεων (κατά Demek, 1972) 

 Την έκθεση ή προσανατολισμό του εδάφους 

 Την σκίαση αναγλύφου 

 Τον εντοπισμό του Υδρογραφικού Δικτύου και των λεκανών απορροής 
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3.1 Εφαρμογή στην Περιφέρεια Στερεάς Ελλάδας 

3.1.1 Ταξινόμηση αναγλύφου (κατά Dikau, 1989) 

Προκειμένου να χαρακτηριστεί το ανάγλυφο που παρατηρείται στην Περιφέρεια Στερεάς 

Ελλάδας χρησιμοποιήθηκε η μέθοδος ταξινόμησης των υψομέτρων που προτείνει ο Dikau. 

Με την ταξινόμηση αυτή μια περιοχή μπορεί να χαρακτηριστεί, ανάλογα με το απόλυτο 

υψόμετρο που παρουσιάζει πάνω από το επίπεδο της θάλασσας, σε πεδινή (0-150m), 

λοφώδη (150-600m), ημιορεινή (600-900m) και ορεινή (>900m) (Dikau, 1989).  

Η διαδικασία που θα ακολουθήσουμε στο περιβάλλον του ArcGISPro είναι η εξής: 

 Ανοίγουμε το παράθυρο του Geoprocessing από το μενού Analysis του ArcGISPro  

και αναζητούμε το εργαλείο Reclassify.  

 Με διπλό κλικ ανοίγει η οθόνη διαλόγου του εργαλείου Reclassify και στο πεδίο 

Input raster εισάγουμε το αρχείο Raster  Sterea_Dem. 

 Στο πεδίο Reclass field ορίζουμε το πεδίο που έχει την πληροφορία του υψομέτρου.  

 Πατώντας Classify ανοίγει η οθόνη διαλόγου του εργαλείου και επιλέγουμε τη 

δημιουργία 4 κλάσεων. Στο παράθυρο Classify βλέπουμε ότι τώρα έχουμε πλέον 4 

κατηγορίες υψομέτρου και μια κατηγορία No Data. Πληκτρολογούμε τις τιμές 150, 

600, 900, 2489  όπως φαίνεται στην εικόνα 3.1.  

 Στο πεδίο Output raster επιλέγουμε τη θέση και το όνομα του εξαγόμενου αρχείου. 

Τέλος πατάμε Run. 

 

 

Εικόνα 3.1 
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 Η διαδικασία ολοκληρώνεται με την προσθήκη του νέου αρχείου στον πίνακα 

περιεχομένων και στην περιοχή εκτύπωσης του χάρτη  (εικόνα 3.2). 

 

 

Εικόνα 3.2 

 

 Στη συνέχεια διαμορφώνουμε το χάρτη και το υπόμνημα (Χάρτης 5). 
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Χάρτης 5: Ταξινόμηση Αναγλύφου κατά Dikau της Περιφέρειας Στερεάς Ελλάδας σε δομή 

                    grid 
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Για να υπολογίσουμε την έκταση σε τετραγωνικά χιλιόμετρα (km²), και το ποσοστό που 

καταλαμβάνει κάθε περιοχή θα ακολουθήσουμε την εξής διαδικασία:  

 Ανοίγουμε το παράθυρο του Geoprocessing από το μενού Analysis του ArcGISPro  

αναζητούμε το εργαλείο Raster  to Polygon και κάνουμε διπλό κλικ πάνω του.  

 Στην οθόνη διαλόγου του εργαλείου Raster to Polygon και στο πεδίο Input raster 

εισάγουμε το αρχείο Ταξινόμηση αναγλύφου (Recl_Ster). 

 Στο πεδίο Field ορίζουμε το πεδίο που έχει την πληροφορία του υψομέτρου.  

 Στο πεδίο Output polygon features ορίζουμε τη θέση και το όνομα του  παραγόμενου 

αρχείου και πατάμε Run όπως φαίνεται στην εικόνα 3.3. 

 

Εικόνα 3.3 

 Το παραγόμενο αρχείο (εικ. 3.4)   

αποθηκεύεται στο project που 

δημιουργήσαμε, με αποτέλεσμα 

να υπολογιστεί αυτόματα η 

επιφάνεια των τεσσάρων 

περιοχών υψομέτρου, όπως 

φαίνεται στη διπλανή εικόνα 

(πεδίο Shape_Area). Το πεδίο 

gridcode περιλαμβάνει  τις τιμές 

1=πεδινές, 2=λοφώδεις, 3=ημιορεινές και 4= ορεινές. Με τη διαδικασία Dissolve θα 

απλοποιήσουμε τα πολύγωνα με βάση το πεδίο gridcode. 
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Εικόνα 3.4 

 Ανοίγουμε το παράθυρο του Geoprocessing από το μενού Analysis του ArcGISPro  

και αναζητούμε το εργαλείο Dissolve.  

 Με διπλό κλικ στο Dissolve εμφανίζεται η οθόνη διαλόγου του εργαλείου Dissolve.   

 Στο πεδίο Input features τοποθετούμε το αρχείο Raster_T_Polygon. 

 Στο πεδίο Output feature class  ορίζουμε τη θέση και το όνομα του  παραγόμενου 

αρχείου.  

 Στο πεδίο Dissolve field τσεκάρω το πεδίο gridcode που θα απλοποιηθεί. 

 Στο πεδίο Statistics field δεν επιλέγω τον υπολογισμό των εμβαδών γιατί αυτό  

γίνεται αυτόματα από το project. Τελειώνοντας πατάμε Run (Εικ. 3.5). 

 

Εικόνα 3.5 

 Στη συνέχεια διαμορφώνουμε το χάρτη και το υπόμνημα (Χάρτης 6). 
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Χάρτης 6: Ταξινόμηση Αναγλύφου κατά Dikau της Περιφέρειας Στερεάς Ελλάδας με τον  

                     υπολογισμό του ποσοστού που καταλαμβάνει η κάθε περιοχή (πολύγωνα) 
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Απόλυτο 

Υψόμετρο (m) 

Χαρακτηρισμός 

περιοχής 

Έκταση           

(km2) 

Ποσοστό             

(%) 

< 150 Πεδινή 3613,49 23,23 

150 - 600 Λοφώδης 6490,67 41,73 

600 - 900 Ημιορεινή 2299,80 14,79 

>900 Ορεινή 3148,87 20,25 

 Συνολική έκταση         15552,83 100,00 

Πίνακας 1: Έκταση και ποσοστά ανάγλυφου με βάση την ταξινόμηση Dikau (1989) όπως  

                       αυτά διαμορφώνονται στην Περιφέρεια Στερεάς Ελλάδας. 

Με βάση τους παραπάνω υπολογισμούς καταλήγουμε στο συμπέρασμα ότι το ανάγλυφο της 

Περιφέρειας Στερεάς Ελλάδας χαρακτηρίζεται κατά 23,23% ως πεδινό, κατά 41,73% ως 

λοφώδες, κατά 14,79% ως ημιορεινό και κατά 20,25% ως ορεινό.  

Εδώ θα πρέπει να τονιστεί ότι σύμφωνα με το site της Περιφέρειας Στερεάς Ελλάδας 

(https://pste.gov.gr/periferia-2/) η Περιφέρεια καταλαμβάνει έκταση 15.549 km2 ενώ με τις 

αναλυτικές διαδικασίες του ArcGIS υπολογίστηκε σε 15552,83 km2, δηλαδή κατά 3,83 km2 

περισσότερο. Παρόλο που η διαφορά είναι πάρα πολύ μικρή, αν λάβουμε υπόψη μας τη 

συνολική επιφάνεια της Περιφέρειας, αυτή αποδίδεται στο αρχείο που κατεβάσαμε από τα 

Δημόσια Ανοιχτά Δεδομένα,  από όπου προέκυψε το πολύγωνο με τα όρια της Περιφέρειας 

(Oria_Perif_Stereas, εικόνα 2.16). Από τον πίνακα περιγραφικών χαρακτηριστικών των 

Διοικητικών Περιφερειών προκύπτει ότι η Περιφέρεια  Στερεάς Ελλάδας καταλαμβάνει 

επιφάνεια 15553,11 km2 (εικ. 3.6).  

 

Εικόνα 3.6  

https://pste.gov.gr/periferia-2/
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3.1.2  Κατανομή κλίσεων αναγλύφου (κατά Demek, 1972) 

Ως κλίση (slope) μιας επιφάνειας, ορίζεται ο μέγιστος ρυθμός μεταβολής του υψομέτρου 

και υπολογίζεται σε μοίρες ή σε ποσοστό επί τοις εκατό. Η κλίση αποτελεί μια σημαντική 

παράμετρο για την ανάλυση του αναγλύφου , αφού με βάση αυτή εξάγονται χρήσιμα 

συμπεράσματα για το βαθμό διάβρωσης που υπόκειται μια περιοχή μελέτης. Λαμβάνοντας 

υπόψη την ταξινόμηση των κλίσεων του αναγλύφου που πρότεινε ο Demek (1972), η οποία 

υιοθετήθηκε στη συνέχεια από την Επιτροπή Γεωμορφολογικής Έρευνας και 

Χαρτογράφησης (Commission on Geomorphological Survey and Mapping) της Διεθνούς 

Γεωγραφικής Ένωσης (IGU – International Geographical Union), έγινε η ταξινόμηση των 

κλίσεων σε 6 κύριες κατηγορίες (Demek, 1972): 

 Κλίση 0° – 2° (0% – 3,5%): Επίπεδο έως ελαφρώς κεκλιμένο ανάγλυφο 

(πλημμυρικά πεδία, επιφάνειες επιπέδωσης, αναβαθμίδες). Έναρξη διάβρωσης τύπου 

καλύμματος. Απουσία προβλημάτων στις ανθρώπινες δραστηριότητες (μεταφορές, 

οικοδόμηση, γεωργία, υλοτομία). 

 Κλίση 2° – 5° (3,5% - 8,7%): Ελαφρώς κεκλιμένο ανάγλυφο (πρόποδες κοιλάδων, 

περιοχές τελικών μοραίνων, κλιτύες θινών). Διάβρωση καλύμματος και έναρξη 

αυλακωτής διάβρωσης. Σε περιοχές φυτοκάλυψης παρατηρείται έναρξη ερπυσμού 

εδαφών. Μέτρα προστασίας του εδάφους λαμβάνονται στις καλλιεργούμενες 

περιοχές. Ελαφρά δυσκολία στη μετακίνηση των οχημάτων, δυνατότητα εποικισμού 

και λειτουργίας βιομηχανιών. Καλλιέργεια δυνατή με τη χρήση μηχανημάτων. 

Προτεινόμενη η καλλιέργεια κατά τις ισοϋψείς. 

 Κλίση 5° – 15° (8,7% – 26,8%): Ισχυρώς κεκλιμένο ανάγλυφο (κλιτύες κοιλάδων, 

τεκτονικές αναβαθμίδες). Κινήσεις μαζών, ισχυρή διάβρωση τύπου καλύμματος και 

αυλακωτή, έντονες διαβρωτικές διεργασίες σε περιοχές μειωμένης φυτοκάλυψης, 

αλλά έναρξη τους και σε περιοχές έντονης φυτοκάλυψης. Πιθανές ολισθήσεις 

εδάφους και ερπυσμός. Στις 150 (26,8%) βρίσκεται η κρίσιμη γωνία για το 

σχηματισμό πλήρους εδαφικού ορίζοντα. Σημαντικές δυσκολίες στην κατασκευή 

δρόμων και στη μετακίνηση οχημάτων. Αδύνατη η καλλιέργεια δίχως τη χρήση 

αναβαθμίδων. Δυσκολίες στη χρήση γεωργικών μηχανημάτων. 

 Κλίση 15° – 35° (26,8% - 70%): Απότομο (150 - 250) έως εξαιρετικά απότομο (250 

– 350) ανάγλυφο (κλιτύες κοιλάδων μεσαίων ορέων). Έντονες διεργασίες 

απογύμνωσης πάσης φύσεως, ερπυσμοί εδαφών, λασπορροές, πολύ έντονη 

αυλακωτή και γραμμική διάβρωση, τόσο σε γυμνές όσο και σε καλυμμένες περιοχές 



 

52 
 

(δάση). Δυνατή η μετακίνηση μόνο με ερπυστριοφόρα μηχανήματα. Αδύνατη η 

καλλιέργεια, δυσχερής η υλοτομία. Περιοχή δασών και βοσκοτόπων. 

 Κλίση 35° - 55° (70% – 135%): Απόκρημνο ανάγλυφο (απότομες κλιτύες κοιλάδων 

υψηλών ορέων, κλιτύες σχηματισμών hogbacks, κλιτύες ασβεστολιθικών 

φαραγγιών). Πολύ λεπτό, ασυνεχές στρώμα εδάφους, έντονη απογύμνωση του 

μητρικού πετρώματος, ισχυρότατη έκθεση στους παράγοντες της διάβρωσης και της 

βαρύτητας. Αδύνατη η προσπέλαση. Περιοχή δασών, όριο εκμετάλλευσης της 

υλοτομίας. 

 Κλίση >55° (>135%): Κάθετο ανάγλυφο (κάθετες κλιτύες σε περιοχές ψαμμιτικών 

και ασβεστολιθικών ορέων). Απουσία εδάφους. Απογύμνωση των εκτεθειμένων 

πετρωμάτων, κατάρρευση βράχων. Αδύνατη η οικονομική εκμετάλλευση. 

Αναρρίχηση. Κίνδυνος πτώσης βράχων στα κατάντη. 

Για τη δημιουργία του χάρτη κλίσεων της Περιφέρειας Στερεάς Ελλάδας, με βάση την 

κατηγοριοποίηση του Demek (1972), θα ακολουθήσουμε την εξής διαδικασία: 

 Ανοίγουμε το παράθυρο του Geoprocessing από το μενού Analysis του ArcGISPro, 

αναζητούμε το εργαλείο Slope και κάνουμε διπλό κλικ πάνω του.  

 Στην οθόνη διαλόγου του εργαλείου Slope και στο πεδίο Input raster εισάγουμε το 

αρχείο Ψηφιακό Μοντέλο εδάφους (Raster  Sterea_Dem). 

 Στο πεδίο Output raster  ορίζουμε τη θέση και το όνομα του  παραγόμενου αρχείου.  

 Στο πεδίο Output measurement πατάμε Degree, στο Z  factor  πληκτρολογούμε την 

τιμή 1 και πατάμε Run όπως φαίνεται στην εικόνα 3.7. 

 

Εικόνα 3.7  

 Το αποτέλεσμα είναι ο χάρτης ταξινόμησης κλίσεων αναγλύφου της Περιφέρειας 

Στερεάς με βάση την κατηγοριοποίηση του Demek (1972). 
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Χάρτης 7: Ταξινόμηση κλίσεων κατά Demek της Περιφέρειας Στερεάς Ελλάδας (grid) 
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Για να υπολογίσουμε την έκταση και το αντίστοιχο ποσοστό που καταλαμβάνει η κάθε 

κατηγορία κλίσεων θα ακολουθήσουμε την ίδια διαδικασία που ακολουθήσαμε και στην 

ταξινόμηση αναγλύφου κατά Dikau: 

 Αρχικά θα επανακατηγοριοποιήσουμε το αρχείο κλίση αναγλύφου (Slope_Sterea1)  

που δημιουργήσαμε σε 6 κατηγορίες κλίσεων: Geoprocessing => Toolboxes => 

Spatial Analyst Tools => Reclass => Reclassify   

 Στη συνέχεια θα μετατρέψουμε σε διανυσματικό (πολύγωνα) το αρχείο Raster 

Reclass_Slope που δημιουργήσαμε και θα το αποθηκεύσουμε στο project για να 

υπολογιστεί η έκταση της κάθε κατηγορίας κλίσης: Geoprocessing => Toolboxes 

=> Conversion Tools => From Raster => Raster to Polygon. (Εικ. 3.8) 

 

Εικόνα 3.8 

 

 Με τη διαδικασία Dissolve θα απλοποιήσουμε τα πολύγωνα με βάση το πεδίο 

gridcode: Geoprocessing => Toolboxes => Data Management Tools => 

Generalization  => Dissolve.   

 

 Στη συνέχεια θα υπολογίσουμε την έκταση και το ποσοστό της κάθε κατηγορίας 

(πιν.2). Τελειώνοντας θα διαμορφώσουμε το χάρτη και το υπόμνημα (Χάρτης 8). 
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Χάρτης 8: Ταξινόμηση κλίσεων κατά Demek της Περιφέρειας Στερεάς Ελλάδας σε 

          διανυσματική μορφή (πολύγωνα) για τον υπολογισμό των εκτάσεων 

                     

 



 

56 
 

Κλίση σε μοίρες Έκταση  (km2) Ποσοστό  (%) 

0 - 2 968,24 6,22 

2 - 5 1834,37  11,80 

5 - 15 5615,24 36,10 

15 - 35 6216,20 39,97 

35 - 55 901,51  5,80 

     >55 16,47 0,11  

Σύνολο  15552,02 100,00 

Πίνακας 2: Έκταση και ποσοστά κλίσεων αναγλύφου με βάση την ταξινόμηση Demek   

               (1972) όπως  αυτά διαμορφώνονται στην Περιφέρεια Στερεάς Ελλάδας. 

Παρατηρώντας τον Πίνακα 2 αντιλαμβανόμαστε ότι το μεγαλύτερο ποσοστό της επιφάνειας 

χαρακτηρίζεται από κλίσεις 5 - 35ο. Αναλυτικότερα, το 36,10% της επιφάνειας της 

Περιφέρειας Στερεάς Ελλάδας καλύπτεται από κλίσεις 5-15ο, ενώ το 39,97%  από κλίσεις 

15-35ο.  Έτσι, μπορούμε να πούμε ότι το ανάγλυφο κατά κύριο λόγο χαρακτηρίζεται από 

ισχυρό έως απότομο και εξαιρετικά απότομο, αποτελούμενο από κλιτύες κοιλάδων οι οποίες 

υπόκεινται σε κινήσεις μαζών και διαβρωτικές διεργασίες. 

3.1.3 Έκθεση ή προσανατολισμός εδάφους 

Έκθεση ή προσανατολισμός εδάφους ή και διεύθυνση μέγιστης κλίσης είναι το μέγεθος το 

οποίο καταγράφει το αζιμούθιο (γωνία διεύθυνσης ως προς το βορρά του συστήματος 

αναφοράς) της μέγιστης κλίσης του εδάφους σε κάθε σημείο του αναγλύφου. Η έκθεση 

μετριέται σε μοίρες (0°−360°), δεξιόστροφα από την διεύθυνση του βορρά (Τσουχλαράκη 

& Αχιλλέως, 2010). 

Η έκθεση μπορεί να έχει σημαντική επίδραση στην θερμοκρασία και κατ’ επέκταση στο 

κλίμα μιας περιοχής. Η επίδραση της έκθεσης είναι πιο σημαντική στα μεσαία γεωγραφικά 

πλάτη, από περίπου 300 έως περίπου 550. Στο επίπεδο του ισημερινού  ο ήλιος πέφτει 

κάθετα και φωτίζει εξίσου σε όλες τις πλαγιές. Στην πολική ζώνη οι ακτίνες του ήλιου 

πέφτουν πλάγια και η επίδραση είναι μικρή. Ως εκ τούτου, η σημασία της έκθεσης είναι 

σημαντική κυρίως στα μέσα γεωγραφικά πλάτη. Στο βόρειο ημισφαίριο η βόρεια πλευρά 

ενός βουνού είναι συχνά σκιασμένη, ενώ η νότια λαμβάνει περισσότερη ηλιακή 

ακτινοβολία. Όσο πιο βόρεια ή νότια βρίσκεται κάποιος και κοντά στο χειμερινό 

ηλιοστάσιο τα φαινόμενα είναι πιο έντονα.  



 

57 
 

 

Εικόνα 3.9 :  Επίδραση της ηλιοφάνειας στο Βόρειο Ημισφαίριο  

                          (https://avalanche.org/avalanche-education/#avy-encyclopedia,  2018) 

 

Εικόνα 3.10 :  Ηλιοφάνεια στη Βόρεια και Νότια Πλευρά μιας Πλαγιάς στο Βόρειο Ημισφαίριο  

                          (https://avalanche.org/avalanche-education/#avy-encyclopedia,  2018) 

 

Εικόνα 3.11 : Ηλιοφάνεια στην Ανατολική και Δυτική Πλευρά μιας Πλαγιάς στο Βόρειο Ημισφαίριο 

(https://avalanche.org/avalanche-education/#avy-encyclopedia,  2018) 

Οι τιμές της έκθεσης μπορεί να είναι από 0°, όπου αντιστοιχεί στο βορρά, έως 360°, το 

οποίο αντιστοιχεί και αυτό στο βορρά αφού έχει κάνει ένα πλήρη κύκλο. Το επίπεδο των 

εκθέσεων εμφανίζεται σε 9 κατηγορίες, μια για τα εντελώς επίπεδα τμήματα της περιοχής 

μελέτης και 8 κατηγορίες σύμφωνα με τις οκτώ κύριες διευθύνσεις του ορίζοντα. Επίπεδες 

περιοχές παίρνουν την τιμή −1. (http://desktop.arcgis.com,  2018) 

https://avalanche.org/avalanche-education/#avy-encyclopedia
https://avalanche.org/avalanche-education/#avy-encyclopedia
https://avalanche.org/avalanche-education/#avy-encyclopedia
http://desktop.arcgis.com/
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Εικόνα 3.12 : Τιμές Έκθεσης σε μια Περιοχή (http://desktop.arcgis.com, 2018) 

Για τη δημιουργία του χάρτη έκθεσης της Περιφέρειας Στερεάς Ελλάδας θα 

ακολουθήσουμε την εξής διαδικασία:  

 Ανοίγουμε το Geoprocessing => Toolboxes => 3D Analyst Tools => Raster 

Surface και με διπλό κλικ Aspect.   

 Στην οθόνη διαλόγου του εργαλείου Aspect και στο πεδίο Input raster εισάγουμε το 

αρχείο Ψηφιακό Μοντέλο εδάφους (Raster  Sterea_Dem).  

 Στο πεδίο Output raster  ορίζουμε τη θέση και το όνομα του  παραγόμενου αρχείου.  

 Πατάμε Run όπως φαίνεται στην εικόνα 3.13. 

 

Εικόνα 3.13 

 Τελειώνοντας θα διαμορφώσουμε το χάρτη και το υπόμνημα (Χάρτης 9). 

 

 

http://desktop.arcgis.com/
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Χάρτης 9: Εκθέσεις  της Περιφέρειας Στερεάς Ελλάδας  
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3.1.4  Σκίαση αναγλύφου 

Ο χάρτης ή μοντέλο σκιασμένου αναγλύφου (Hillshade ή Shaded Relief Map/Model) δίνει 

μία ρεαλιστική και κατανοητή από όλους τους χρήστες του χάρτη εικόνα του 

προσανατολισμού του γήινου ανάγλυφου, θεωρώντας ότι αυτή φωτίζεται από μία υποθετική 

πηγή φωτός, η οποία βρίσκεται στο άπειρο και υπολογίζοντας ποιες περιοχές στο φυσικό 

γήινο ανάγλυφο σκιάζονται και πόσο, και ποιες δεν σκιάζονται. Εξ ορισμού η σκίαση και ο 

φωτισμός είναι αποχρώσεις του γκρι που συνοδεύονται από ακέραιες τιμές 0 – 254 , 

αυξανόμενες από το μαύρο στο άσπρο. 

Ο χάρτης σκιασμένου αναγλύφου δεν απεικονίζει την εδαφική κάλυψη παρά μόνο την 

ψηφιοποιημένη γήινη επιφάνεια και είναι πολύ χρήσιμος σε περιπτώσεις οπτικής 

παρατήρησης της περιοχής μελέτης, καθώς μας παρέχει την ευχέρεια να έχουμε σε κάτοψη 

μια τρισδιάστατη άποψη του χώρου μας και σε συνδυασμό με άλλα δεδομένα (π.χ. 

δορυφορικές εικόνες)  βελτιώνουμε το οπτικό αποτέλεσμα.  

Ο τρόπος με τον οποίο τα στοιχεία της επιφάνειας θα ανακλούν το φως εξαρτάται από τα 

χαρακτηριστικά τους (κλίση, προσανατολισμός) και από τη θέση της φωτεινής πηγής, η 

οποία καθορίζεται από τον αναλυτή, με τη βοήθεια δύο παραμέτρων: (1) του ηλιακού 

αζιμούθιου (Solar Azimuth) και (2) του ύψους ηλίου (Solar Elevation). Το αζιμούθιο είναι η 

γωνιακή διεύθυνση (0°-360°) του ηλίου, μετρούμενη από το Βορρά κατά τη φορά των 

δεικτών του ρολογιού. Το ύψος ηλίου ταυτίζεται με τη γωνία που σχηματίζει η φωτεινή 

πηγή με τον ορίζοντα. Οι εικόνες σκίασης αναγλύφου για χαρτογραφική χρήση 

δημιουργούνται κατά κανόνα με φως που έχει βορειοδυτική διεύθυνση, καθώς έχει 

αποδειχθεί ότι αυτό βοηθά όλους τους χρήστες χαρτών, έμπειρους και μη, να αντιληφθούν 

τους σχηματισμούς του ανάγλυφου της γήινης επιφάνειας άμεσα και με ακρίβεια. 

(Τζελέπης, Λοΐσιος, & Νάκος, 2008). Οι προεπιλεγμένες τιμές στο ArcGISPro είναι 315° 

(«φωτισμός» από ΒΔ), ενώ ως ύψος ηλίου γωνία 45°. (Εικόνα 3.15) 

 

Εικόνα 3.14: Πηγή  http://desktop.arcgis.com,  2018 

http://desktop.arcgis.com/
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Για τη δημιουργία του χάρτη σκίασης αναγλύφου της Περιφέρειας Στερεάς Ελλάδας θα 

ακολουθήσουμε την εξής διαδικασία:  

 Ανοίγουμε το Geoprocessing => Toolboxes => 3D Analyst Tools => Raster 

Surface  και με διπλό κλικ Hillshade.  

 Στην οθόνη διαλόγου του εργαλείου Hillshade και στο πεδίο Input raster εισάγουμε 

το αρχείο Ψηφιακό Μοντέλο εδάφους (Raster  Sterea_Dem).   

 Στο πεδίο Output raster  ορίζουμε τη θέση και το όνομα του  παραγόμενου αρχείου.  

 Θέτουμε ως γωνία αζιμούθιου του ήλιου 315°  

 Θέτουμε ως γωνία ύψους του ήλιου 45°    

 Πατάμε Run, όπως φαίνεται στην εικόνα 3.15. 

 

Εικόνα 3.15 

Το νέο επίπεδο πληροφορίας «σκίαση αναγλύφου» προστίθεται στον πίνακα περιεχομένων και 

εκτυπώνεται στην περιοχή εκτύπωσης του χάρτη. Τελειώνοντας θα διαμορφώσουμε το χάρτη και το 

υπόμνημα (Χάρτης 10).  

Στη συνέχεια θα τοποθετήσουμε το ΨΜΕ και τις κλίσεις αναγλύφου της Περιφέρειας 

Στερεάς Ελλάδας, τα οποία θα κάνουμε διάφανα κατά 40%, πάνω από το ψηφιδωτό σκίασης 

αναγλύφου και μπορούμε να δημιουργήσουμε μια ρεαλιστική εικόνα της Περιφέρειας, όπως 

φαίνεται στους χάρτες 11 και 12.  
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Χάρτης 10: Σκίαση αναγλύφου της Περιφέρειας Στερεάς Ελλάδας 

 

 



 

63 
 

 

Χάρτης 11: ΨΜΕ με υπέρθεση στη σκίαση αναγλύφου της Περιφέρειας Στερεάς Ελλάδας 
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Χάρτης 12: Κλίσεις  με υπέρθεση στη σκίαση αναγλύφου της Περιφέρειας Στερεάς Ελλάδας 
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3.1.5   Εντοπισμός υδρογραφικού δικτύου 

Μία ακόμα εφαρμογή του Ψηφιακού Μοντέλου  Εδάφους της Περιφέρειας Στερεάς είναι η 

αξιοποίησή του στον εντοπισμό του υδρογραφικού δικτύου και τον ορισμό των λεκανών 

απορροής της Περιφέρειας Στερεάς. Υδρογραφικό δίκτυο ονομάζεται ένα σύνολο 

επιφανειακών ρευμάτων νερού (ποταμών, χειμάρρων κλπ.), που συνδέονται μεταξύ τους με 

καθορισμένο τρόπο και δημιουργούν συγκεκριμένους τύπους απορροής. Οι αρχικοί κλάδοι 

του υδρογραφικού δικτύου είναι συνήθως μικρά, εφήμερα ρεύματα, τα οποία βρίσκονται 

στα τμήματα του εδάφους με μεγαλύτερο υψόμετρο και οδηγούν το νερό σε μεγαλύτερα 

κανάλια και ποτάμια κι από εκεί καταλήγει στη θάλασσα. Οι κλάδοι συνδέονται μεταξύ 

τους και εκείνοι που βρίσκονται σε χαμηλότερα υψόμετρα (κατάντη) δέχονται τα ύδατα από 

εκείνους που βρίσκονται σε ψηλότερα (ανάντη). Οι κλάδοι του υδρογραφικού δικτύου 

διακρίνονται ιεραρχικά σε τάξεις, σύμφωνα με διάφορες μεθόδους ταξινόμησης (π.χ. 

Horton, Strahler, Shreve and Scheidegger) (Τσακίρης, 1995).  

Το ανάγλυφο επηρεάζει την επιφανειακή απορροή των υδάτων που προκύπτουν από τα 

ατμοσφαιρικά κατακρημνίσματα κι επομένως, επιδρά στη διαμόρφωση των λεκανών 

απορροής και του υδρογραφικού δικτύου. Η επιφανειακή απορροή αποτελεί μέρος του 

υδρολογικού κύκλου και δημιουργείται από το νερό των ατμοσφαιρικών κατακρημνίσεων 

που δεν απορροφάται από το έδαφος, εφόσον υπάρχει κατάλληλη κλίση και βάθος ροής 

(Μιμίκου, 2006).  

Η λεκάνη απορροής (ή υδρολογική λεκάνη) είναι η περιοχή του εδάφους που συγκεντρώνει 

τα όμβρια ύδατα και τα διοχετεύει σε ένα υδρολογικό σύστημα (υδατόρευμα, ποτάμι, λίμνη, 

θάλασσα). Η επιφανειακή απορροή η οποία προκύπτει από τα ατμοσφαιρικά 

κατακρημνίσματα είναι από τις σπουδαιότερες διεργασίες που παρατηρούνται σε μια 

υδρολογική λεκάνη, και περιλαμβάνει επίγειες και υπεδάφιες ροές (Κουτσογιάννης & 

Ξανθόπουλος, Θ., 1999). Επειδή επηρεάζεται από τα γεωμορφολογικά χαρακτηριστικά της 

λεκάνης, είναι αναγκαία η αριθμητική έκφραση των χαρακτηριστικών αυτών (Τσακίρης, 

1995). Τα μορφομετρικά χαρακτηριστικά της λεκάνης απορροής τα οποία επηρεάζουν τη 

μελέτη των υδρολογικών χαρακτηριστικών μιας περιοχής (Τσακίρης, 1995) είναι: το 

μέγεθος, το σχήμα, το υψόμετρο, το ανάγλυφο και οι κλίσεις. 

Για την αυτόματη εξαγωγή και αρίθμηση του υδρογραφικού δικτύου καθώς και τον ορισμό 

των υδρολογικών λεκανών της Περιφέρειας θα αξιοποιήσουμε την προσθήκη ModelBuilder 

του λογισμικού ArcGISPro 2.1 (Κουτσόπουλος & Ανδρουλακάκης, Ν., 2005). Με τη 

λειτουργία του ModelBuilder θα δημιουργήσουμε ένα μοντέλο με τη βοήθεια του οποίου θα 

αυτοματοποιήσουμε την χωρική αναλυτική διαδικασία και θα έχουμε τη δυνατότητα να 
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πειραματιστούμε με τις τιμές των διαφόρων παραμέτρων των εργαλείων έτσι ώστε να 

παίρνουμε εύκολα αποτελέσματα από τις εναλλακτικές λύσεις.  

Η οθόνη του  ModelBuilder συνίσταται από ένα παράθυρο εμφάνισης, εντός του οποίου 

απεικονίζεται γραφικά το μοντέλο που δημιουργούμε, από μια σειρά μενού επιλογών και 

μια εργαλειοθήκη με τα οποία γίνεται η διαχείριση των στοιχείων που απαρτίζουν το 

μοντέλο. Στην εικόνα 3.16 φαίνονται τα τρία βασικά μέρη της οθόνης του  ModelBuilder: 

 

Εικόνα 3.16 

Το μοντέλο παίρνει τη μορφή ενός διαγράμματος και αναπαριστά μια σειρά  από 

διαδικασίες που συνδέονται μεταξύ τους και εκτελούνται ταυτόχρονα όταν εφαρμόζεται το 

μοντέλο. Όλα τα συστατικά της διαδικασίας δημιουργίας ενός μοντέλου έχουν το δικό τους 

χαρακτηριστικό σχήμα και χρώμα για να είναι πιο εύκολη η ανάγνωση και δημιουργία του 

μοντέλου (εικόνα 3.17). 

 

Εικόνα 3.17 
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Για την υδρολογική ανάλυση της Περιφέρειας Στερεάς Ελλάδας θα χρησιμοποιήσουμε τα 

εργαλεία του λογισμικού ArcGISPro που βρίσκονται στο μενού Geoprocessing (Tools) και 

ως βασική πηγή δεδομένων το ΨΜΕ που δημιουργήσαμε.   

 Αρχικά δημιουργούμε το project ArcGISPro Sterea_Hydrology  και ορίζουμε τη 

θέση εξαγωγής των αρχείων του project που θα προκύψουν. (Εικ. 3.18) 

 

Εικόνα 3.18 

 Από το μενού Insert => Toolbox => New Toolbox => δημιουργούμε την 

εργαλειοθήκη Perifereia_Stereas.tbx. Από το μενού Analysis => ModelBuilder 

δημιουργούμε το νέο μοντέλο. Πατάμε Save As και αποθηκεύουμε το μοντέλο σαν 

Hydrology_Stereas  στην εργαλειοθήκη Perifereia_Stereas.tbx.  (Εικ. 3.19) 

 

Εικόνα 3.19 
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 Από το μενού View => Catalog Pane => στο αναδυόμενο παράθυρο του Catalog 

επιλέγουμε Project => Toolboxes => Perifereia_Stereas.tbx => δεξί κλικ στο 

μοντέλο Hydrology_Stereas => Edit και εμφανίζεται η οθόνη του ModelBuilder. 

(Εικ. 3.20) 

 

Εικόνα 3.20 

 Από τον πίνακα περιεχομένων επιλέγουμε και σέρνουμε στο παράθυρο δημιουργίας 

του μοντέλου το ΨΜΕ της Περιφέρειας Στερεάς Ελλάδας. Με την ίδια διαδικασία 

εισάγουμε  το εργαλείο (Geoprocessing => Toolboxes => Spatial Analyst Tools => 

Hydrology =>) Fill. Κατά τη δημιουργία ενός ΨΜΕ προκύπτουν στο ανάγλυφο 

βυθίσματα τα οποία μπορεί να είναι ψευδή ή φυσικά (όπως λίμνες, δολίνες, 

κατολισθήσεις, παγετώνες) ή βυθίσματα που οφείλονται σε ανθρώπινες 

δραστηριότητες (εξορύξεις, εκσκαφές κ.ά.). Τα βυθίσματα αυτά πρέπει να 

διορθωθούν, ώστε να μην υπάρχουν μικρά τμήματα της λεκάνης, όπου το νερό 

εγκλωβίζεται, παρακωλύοντας την υδρολογική ανάλυση. Στην  Εικόνα 3.21 

βλέπουμε αριστερά ανάγλυφο με βύθισμα και δεξιά την πλήρωσή του με το εργαλείο 

Fill. Στην  Εικόνα 3.22 το ΨΜΕ που προκύπτει  με το εργαλείο Fill. 

 

Εικόνα 3.21: Πηγή  http://pro.arcgis.com/en/ , 2018 

http://pro.arcgis.com/en/
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Εικόνα 3.22: Raster μετά την πλήρωση του ΨΜΕ 

 Στη συνέχεια εισάγουμε το εργαλείο (Geoprocessing => Toolboxes => Spatial 

Analyst Tools => Hydrology =>) Flow Direction. Η διεύθυνση ροής υπολογίζεται 

σε κάθε κεντρικό εικονοστοιχείο ενός πίνακα 3x3. Η τιμή του κεντρικού 

εικονοστοιχείου συγκρίνεται με τις τιμές των 8 εικονοστοιχείων που το περιβάλουν. 

Όταν εντοπιστεί το εικονοστοιχείο με τη μεγαλύτερη κλίση ή το χαμηλότερο 

υψόμετρο ορίζεται αυτόματα η διεύθυνση ροής του κεντρικού εικονοστοιχείου. Ο 

τελικός χάρτης (raster) περιέχει διευθύνσεις ροής (Βόρεια, Βορειανατολικά κ.λπ.). 

(Εικ. 3.23) 

 

Εικόνα 3.23: Δημιουργία του καννάβου διεύθυνσης ροής από το πληρωμένο ΨΜΕ. 
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 Στη συνέχεια εισάγουμε το εργαλείο (Geoprocessing => Toolboxes => Spatial 

Analyst Tools => Hydrology =>) Flow Accumulation και υπολογίζεται αθροιστικά 

ο αριθμός των εικονοστοιχείων που αποστραγγίζονται σε κάθε ένα εικονοστοιχείο. 

Ο τελικός πίνακας περιέχει τιμές που αντιστοιχούν στο συνολικό άθροισμα των 

εικονοστοιχείων που συγκεντρώνουν το νερό τους σε ένα και μοναδικό 

εικονοστοιχείο. Πρακτικά δηλαδή μία τιμή εικονοστοιχείου 8 σημαίνει ότι το νερό 

από 8 άλλα εικονοστοιχεία θα συγκεντρωθεί στο συγκεκριμένο εικονοστοιχείο. Όσο 

μεγαλύτερη είναι η τιμή του εικονοστοιχείου τόσο μεγαλύτερης τάξης κλάδος 

αναμένεται να περνάει από αυτό το εικονοστοιχείο. (Εικ. 3.24)  

           

Εικόνα 3.24: Δημιουργία του καννάβου συγκεντρωτικής ροής από τον κάνναβο διεύθυνσης  ροής. 

 Συνεχίζοντας, από τον κάνναβο συγκεντρωτικής ροής μπορούμε να εξάγουμε το 

βασικό υδρογραφικό δίκτυο. Μπορούμε να χρησιμοποιήσουμε το εργαλείο 

(Geoprocessing => Toolboxes => Spatial Analyst Tools => Reclass =>) Reclassify 

και να δημιουργήσουμε δυο κλάσεις. Η πρώτη να απεικονίζει τα εικονοστοιχεία που 

ανήκουν σε κάθε κλάδο υδρογραφικού δικτύου με την τιμή True, ενώ η δεύτερη να 

απεικονίζει όλα τα υπόλοιπα εικονοστοιχεία που παίρνουν την τιμή False. Να 

ορίσουμε στη συνέχεια μία κατώτατη τιμή (με βάση το χάρτη αθροιστικής ροής) που 

πρέπει να έχει ένα εικονοστοιχείο ώστε να θεωρηθεί ότι ανήκει στο υδρογραφικό 

δίκτυο, την τιμή κατωφλίου. Όσο υψηλότερη είναι η τιμή κατωφλίου που θα 

ορίσουμε τόσο λιγότεροι κλάδοι θα υπάρχουν στο υδρογραφικό δίκτυο. Εάν η τιμή 
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του εικονοστοιχείου υπερβαίνει την τιμή του κατωφλίου τότε το εικονοστοιχείο 

παίρνει τιμή True, ενώ στην αντίθετη περίπτωση παίρνει την τιμή False. Tα ρέματα 

(streams) μπορούν να ορίζονται με τη χρήση ενός κατωφλίου 5000 ψηφίδων (στον 

κάνναβο συγκέντρωσης ροής με διάσταση 30m), με επιφάνεια 4,5km2. Οι ψηφίδες 

που αποστραγγίζουν μικρότερες εκτάσεις θεωρούνται ως επιφάνειες, οι οποίες 

αποστραγγίζονται στα ρέματα. Επομένως εκτάσεις με αριθμό ψηφίδων κάτω από 

1000, που αντιστοιχούν σε εμβαδό 0.9 km2 δεν μπορούν να θεωρηθούν ρέματα. 

(Oliveira, Furnans,J., Maidment,D. R., Djokic, D., & Ye, Z., 2002)  

Το κατώφλι των 5000 ψηφίδων, που απαιτείται για να θεωρηθεί ότι ξεκινά ένα ρέμα, 

έχει καθιερωθεί στις ΗΠΑ σε διάφορες εφαρμογές σύμφωνα με τους παραπάνω 

μελετητές, μεταξύ αυτών και για την επιχειρησιακή πρόγνωση πλημμυρών από τη 

Μετεωρολογική Υπηρεσία των ΗΠΑ. 

Επομένως σύμφωνα με τη διεθνή πρακτική θα πρέπει να ορίσουμε τιμή κατωφλίου 

5000 ψηφίδων. Επειδή μισγάγγειες με τιμή κάτω από 1000 ψηφίδες δεν μπορούν να 

χαρακτηριστούν ρέματα, μπορούμε να πειραματιστούμε με διαφορετικές τιμές 

κατωφλίου  (1000, 2000, 3000, 4000 και 5000), οι οποίες  δίνουν και διαφορετικά 

αποτελέσματα (Εικόνες 3.32 – 3.35).  

Σε αυτό το βήμα, αντί για τη διαδικασία 

Reclassify, μπορούμε να εκμεταλλευτούμε 

μια άλλη σημαντική δυνατότητα του 

ModelBuilder και να εισάγουμε το εργαλείο 

Raster Calculator, να παραμετροποιήσουμε 

τις τιμές του, έτσι ώστε όταν τρέχουμε το 

μοντέλο να παρουσιάζεται μια αρχική οθόνη 

στη οποία θα δίνουμε τις παραπάνω 

διαφορετικές τιμές κατωφλίου  (Εικ. 3.25).              

 Εικόνα 3.25:Ορίζουμε τιμή κατωφλίου 5000 

ψηφίδες 

          

Στην Εικ. 3.26 το όριο είναι 5000, αυτό σημαίνει ότι τα φατνία του καννάβου με 

τιμές 0–5000 θα είναι εκτός υδρογραφικού δικτύου, ενώ τα φατνία με τιμές 

μεγαλύτερες του 5000 θα συγκροτούν το υδρογραφικό δίκτυο.  
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Εικόνα 3.26: Χάρτης  υδρογραφικού δικτύου με τιμή κατωφλίου 5000. Με μαύρο χρώμα οι τιμές  

                          True και με λευκό οι τιμές False  

 Στη συνέχεια εισάγουμε το εργαλείο (Geoprocessing => Toolboxes => Spatial 

Analyst Tools => Hydrology =>) Stream Order και κάνουμε ιεράρχηση του 

υδρογραφικού δικτύου. Η τάξη των ρευμάτων είναι ένα χαρακτηριστικό που 

αντανακλά το βαθμό διακλάδωσής τους μέσα στη λεκάνη. Στο ArcGIS οι δύο 

μέθοδοι με τις οποίες γίνεται η ιεράρχηση του υδρογραφικού δικτύου είναι η 

μέθοδος Strahler και η μέθοδος Shreve, όπως φαίνεται στην Εικ. 3.27. Στην μέθοδο 

Strahler η τάξη ενός κλάδου αυξάνει όταν διασταυρωθούν δύο κλάδοι με την ίδια 

τάξη, αλλιώς ο ενωμένος κλάδος παίρνει την μεγαλύτερη τάξη από τους δύο 

κλάδους. Αντίθετα στην 

ιεράρχηση κατά Shreve, κατά την 

ένωση δύο κλάδων η τάξη του 

ενωμένου κλάδου προκύπτει ως 

άθροισμα των τάξεων των δυο 

κλάδων που ενώνονται. Θα 

επιλέξουμε σαν διαδικασία 

ιεράρχησης εκείνη του Strahler.       Εικ. 3.27: Πηγή  http://desktop.arcgis.com, 2018 

http://desktop.arcgis.com/
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Εικόνα 3.28  Δημιουργία ιεραρχημένου υδρογραφικού δικτύου  

 Ο αλγόριθμος ολοκληρώνεται με την εξαγωγή (μετατροπή) του υδρογραφικού   

δικτύου σε διανυσματική δομή.  Για το λόγο αυτό εισάγουμε το εργαλείο (Toolboxes 

=> Spatial Analyst Tools => Hydrology =>) Stream to Feature. (Εικ. 3.29) 

 

Εικόνα 3.29  Δημιουργία υδρογραφικού δικτύου με τιμή κατωφλίου 5000  
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Στην εικόνα 3.30 παρουσιάζεται το μοντέλο που εφαρμόσαμε για την εξαγωγή του 

υδρογραφικού δικτύου. Δημιουργήσαμε δύο παραμέτρους, μια για να ορίζουμε την τιμή 

κατωφλίου και μια για το τελικό παραγόμενο αρχείο. Η θέση αποθήκευσης του 

διανυσματικού αρχείου είναι ο χώρος εργασίας του project που δημιουργήσαμε ώστε να 

υπολογίζεται αυτόματα το μήκος των ρευμάτων.  

 

Εικόνα 3.30  Δημιουργία μοντέλου εξαγωγής υδρογραφικού δικτύου 

Όταν τρέχουμε το μοντέλο στην αρχική του οθόνη μας ζητάει να καθορίσουμε τις τιμές των 

παραμέτρων που ορίσαμε. (Εικ.3.31) 

 

Εικόνα 3.31  Αρχική οθόνη  μοντέλου εξαγωγής υδρογραφικού δικτύου 

Τρέχοντας το μοντέλο με τιμές κατωφλίου  1000, 2000, 3000, 4000 και 5000 παίρνουμε τα 

παρακάτω αποτελέσματα : 



 

75 
 

 

Εικόνα 3.32  Δημιουργία υδρογραφικού δικτύου με τιμή κατωφλίου 1000  

 

Εικόνα 3.33  Δημιουργία υδρογραφικού δικτύου με τιμή κατωφλίου 2000  
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Εικόνα 3.34  Δημιουργία υδρογραφικού δικτύου με τιμή κατωφλίου 3000  

 

Εικόνα 3.35  Δημιουργία υδρογραφικού δικτύου με τιμή κατωφλίου 4000  
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Χάρτης 13: Υδρογραφικό δίκτυο (τιμή κατωφλίου 5000)  με υπέρθεση στο ΨΜΕ και στη 

                        σκίαση αναγλύφου της Περιφέρειας Στερεάς Ελλάδας 
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Χάρτης 14: Υδρογραφικό δίκτυο (τιμή κατωφλίου 5000)  με υπέρθεση στο ΤΙΝ 

                               της Περιφέρειας Στερεάς Ελλάδας 

 

 



 

79 
 

Έχοντας αποθηκεύσει το διανυσματικό αρχείο του υδρογραφικού δικτύου στο χώρο 

εργασίας του project που δημιουργήσαμε, όπως αναφέραμε και παραπάνω, ο υπολογισμός 

μήκους και επιφάνειας γίνεται αυτόματα. Έτσι μας δίνεται η 

δυνατότητα από το περιβάλλον του ArcGISPro να 

υπολογίσουμε το μήκος του Υδρογραφικού Δικτύου καθώς 

και άλλα στατιστικά στοιχεία. Με αριστερό κλικ στο όνομα 

του θεματικού επιπέδου του υδρογραφικού δικτύου (με τιμή 

κατωφλίου 5000) και στη συνέχεια με δεξί κλικ, επιλέγουμε 

Open Attribute Table. Ακολούθως, επιλέγουμε (με αριστερό 

κλικ) το πεδίο Shape Length και με δεξί κλικ Statistics, 

οπότε παράγεται ένα γράφημα στατιστικών στο οποίο 

αναγράφονται τα στατιστικά στοιχεία για το επιλεγμένο 

πεδίο (Shape_Length), μεταξύ των οποίων είναι και το 

συνολικό μήκος, ως το άθροισμα (Sum = 

5366126,5205031009m) του μήκους του συνόλου των 

οντοτήτων που περιέχει το θεματικό επίπεδο σε (m) όπως 

βλέπουμε στην Εικ. 

3.36.   

 

                                

Εικόνα 3.36  Στατιστικά στοιχεία του μήκους του υδρογραφικού δικτύου με τιμή κατωφλίου 5000  

Για να υπολογίσουμε το μήκος ανά κατηγορία ιεράρχησης (τάξης) του υδρογραφικού 

δικτύου θα ακολουθήσουμε την εξής διαδικασία: Με αριστερό κλικ στο όνομά του 

επιλέγουμε το θεματικό επίπεδο του υδρογραφικού δικτύου (με τιμή κατωφλίου 5000) και 

στη συνέχεια με δεξί κλικ, επιλέγεται Open Attribute Table. Ακολούθως, με αριστερό κλικ 

επιλέγουμε το πεδίο gridcode και με δεξί κλικ Summarize. Στο παράθυρο του εργαλείου 

αυτού (Summary Statistics), συμπληρώνονται: 

 Στο πεδίο Input Table: Hydr_Diktyo_5000. 

 Στο πεδίο Output table: το όνομα και τη θέση του πίνακα όπου θα αποθηκευτούν τα 

στατιστικά στοιχεία. 

 Στα πεδία Statistics field(s): grid_code,  Statistic Type: Sum, Case field : 

grid_code. 

 Πατάμε Run και ο πίνακας προστίθεται στον πίνακα περιεχομένων. 

Το αποτέλεσμα της διαδικασίας φαίνεται στον πίνακα 3.  
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Υπολογισμός μήκους ανά κατηγορία ιεράρχησης 
(τάξης) του υδρογραφικού δικτύου της Περιφέρειας 

Τάξη Πλήθος κλάδων Συνολικό μήκος (km) 

1η 1105 3150,04 

2η 500 1414,67 

3η 257 623,57 

4η 44 118,40 

5η 34  59,45 

ΣΥΝΟΛΟ  1940 5366,13 

Πίνακας 3  

Για να υπολογίσουμε τις λεκάνες απορροής θα εισάγουμε στο μοντέλο μας το εργαλείο 

(Geoprocessing => Toolboxes => Spatial Analyst Tools => Hydrology =>) Basin.  

Εισαγόμενο αρχείο του εργαλείου είναι η διεύθυνση ροής. Εισάγοντας το εργαλείο 

(Geoprocessing => Toolboxes => Spatial Analyst Tools => Hydrology =>)  Raster To 

Polygon  θα μετατρέψουμε το αρχείο καννάβου (grid)  των λεκανών απορροής σε 

διανυσματικό. Η τελική μορφή του μοντέλου φαίνεται στην εικ.3.37 

 

Εικόνα 3.37: Μοντέλο Υδρολογικής Ανάλυσης    

 

Τρέχοντας το μοντέλο και ορίζοντας τις παραμέτρους (τιμή κατωφλίου 5000) εξάγονται στο 

project ArcGISPro Sterea_Hydrology  το υδρογραφικό δίκτυο και οι λεκάνες απορροής της 

Περιφέρειας Στερεάς Ελλάδας  (Χάρτης 15). 
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Χάρτης 15: Υδρογραφικό δίκτυο (τιμή κατωφλίου 5000) και Λεκάνες Απορροής με   

              υπέρθεση στη Σκίαση Αναγλύφου της Περιφέρειας Στερεάς Ελλάδας 
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4.  ΤΟ ΑΙΟΛΙΚΟ ΔΥΝΑΜΙΚΟ ΤΗΣ ΠΕΡΙΦΕΡΕΙΑΣ ΣΤΕΡΕΑΣ ΕΛΛΑΔΑΣ 

 Η αιολική ενέργεια στηρίζεται στην κινητική ενέργεια του ανέμου και την κατάλληλη 

αξιοποίησή της για την παραγωγή ηλεκτρικής ενέργειας. Ο άνεμος προέρχεται από τις 

διαφοροποιήσεις στην ατμοσφαιρική πίεση, οι οποίες οφείλονται στη διαφορετική 

θέρμανση της επιφάνειας της γης και της θάλασσας από τον ήλιο. 

Η αιολική ενέργεια είναι έμμεση μορφή της ηλιακής ενέργειας και περίπου 1-2% της 

ηλιακής ακτινοβολίας που προσπίπτει στην επιφάνεια της γης μετατρέπεται σε άνεμο. 

Καθώς ο αέρας θερμαίνεται στις τροπικές ζώνες αρχικά ανυψώνεται στην ατμόσφαιρα και 

κατόπιν οδεύει εν γένει προς τους πόλους. Η κίνηση αυτή της ατμόσφαιρας επηρεάζεται 

σημαντικά από την περιστροφή της γης, η επίδραση της οποίας είναι μεγαλύτερη στον 

ισημερινό και μηδενική στους πόλους, από την αναλογία της επιφάνειας της ξηράς προς την 

αντίστοιχη της θάλασσας, τα μορφολογικά χαρακτηριστικά της ξηράς (βουνά, πεδιάδες) και 

από εποχές του χρόνου. 

Άνεμοι δημιουργούνται και σε τοπική κλίμακα με διάφορους μηχανισμούς, όπως η 

δημιουργία θαλάσσιας ή απόγειας αύρας και τα καθοδικά ρεύματα προς τις κοιλάδες από τα 

βουνά. Οι ταχύτητες του ανέμου διαφέρουν με το ανάγλυφο μιας περιοχής και ποικίλλουν 

σημαντικά με την εποχή και την ημέρα. 

Ο άνεμος αποτελεί ένα ιδιαίτερα μεταβλητό μέγεθος, τόσο κυρίως με το χρόνο, όσο και το 

ύψος από το έδαφος. Επομένως, για την εκτίμηση του αιολικού δυναμικού μιας περιοχής 

χρειάζονται αναλυτικές μετρήσεις της ταχύτητας και της διεύθυνσης του ανέμου.  

Το ΚΑΠΕ (Κέντρο Ανανεώσιμων Πηγών και Εξοικονόμησης Ενέργειας) υπολόγισε με 

βάση ένα ευρύ πρόγραμμα επί τόπου μετρήσεων και εφαρμογή μαθηματικών μοντέλων το 

αιολικό δυναμικό του Ελληνικού χώρου (πλην Κρήτης και μέρους των νομών Καβάλας και 

Ξάνθης) σε κάνναβο 150 x 150 m. Το αιολικό δυναμικό εκφράζεται με βάση την μέση 

ετήσια ταχύτητα του αέρα σε μέτρα το δευτερόλεπτο, σε υπολογισμένο ύψος 40 μέτρων. Τις 

μετρήσεις του αιολικού δυναμικού (τελευταία ενημέρωση: Αύγουστος 17, 2015) θα τις 

κατεβάσουμε από το site http://geodata.gov.gr/ και θα τις αποθηκεύσουμε στον κατάλογο 

εργασίας που έχουμε δημιουργήσει.  

Με τις μετρήσεις του αιολικού δυναμικού θα δημιουργήσουμε ένα ψηφιδωτό (επιφάνεια) 

που θα αναπαριστά το φαινόμενο αυτό σε όλη την επιφάνεια της Περιφέρειας Στερεάς 

Ελλάδας. Το ψηφιδωτό θα  δημιουργηθεί από την μέση ετήσια ταχύτητα του αέρα σε μέτρα 

το δευτερόλεπτο, σε υπολογισμένο ύψος 40 μέτρων, με την μέθοδο της χωρικής 

παρεμβολής. Με την χωρική παρεμβολή το ΓΣΠ προσπαθεί να κάνει ένα λογικό 

υπολογισμό της μέσης ετήσιας ταχύτητας του αέρα σε μέρη όπου δεν έχει μετρηθεί. Η 

http://geodata.gov.gr/
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βασική αρχή που διέπει την χωρική Παρεμβολή είναι ο νόμος του Tobler ότι “όλες οι 

τοποθεσίες συσχετίζονται, αλλά εκείνες που είναι πιο κοντά συσχετίζονται περισσότερο από 

τις μακρινότερες”. (Tobler, 1970) 

Οι μέθοδοι που χρησιμοποιούνται συνήθως για να δημιουργηθούν ψηφιδωτά από σημειακά 

δεδομένα είναι : IDW , Kriging και Spline. Στην εργασία θα χρησιμοποιήσουμε τη μέθοδο 

Kriging, μία από τις πλέον ευέλικτες μεθόδους χωρικής παρεμβολής, που χρησιμοποιείται 

για όλα τα είδη δεδομένων. Η βασική ιδέα της μεθόδου είναι να ανακαλύψει πρώτα τις 

γενικές ιδιότητες της επιφάνειας και μετά να εφαρμόσει αυτές τις ιδιότητες στον 

υπολογισμό των υπολοίπων τιμών της επιφάνειας. Δηλαδή το Kriging χρησιμοποιεί τα 

δεδομένα δύο φορές: Την πρώτη φορά για να υπολογίσει την χωρική αυτοσυσχέτιση των 

δεδομένων και την δεύτερη φορά για να κάνει τις προβλέψεις.  

Ο υπολογισμός της χωρικής αυτοσυσχέτισης γίνεται με το εμπειρικό ημιβαριόγραμμα:  

Ημιβαριόγραμμα (απόσταση h) = 0.5 * μέσο όρο [(τιμή στην τοποθεσία i – τιμή στην 

τοποθεσία j )2]        

για όλα τα ζεύγη των τοποθεσιών που χωρίζονται από απόσταση h.  

Το εμπειρικό ημιβαριόγραμμα είναι ένα γράφημα των μέσων όρων των τιμών 

ημιβαριογράμματος στον άξονα των Υ και της απόστασης ή lag στον άξονα των Χ, όπως 

βλέπουμε στο παρακάτω διάγραμμα: 

                     Υ 

  Χ 

Σύμφωνα με τον νόμο του Tobler τα ζευγάρια τα οποία είναι κοντύτερα (αριστερά στον Χ 

άξονα) θα πρέπει να έχουν παρόμοιες τιμές (χαμηλά στον άξονα των Υ). Καθώς τα ζευγάρια 

των τοποθεσιών απομακρύνονται (μετακινούνται δεξιά στον άξονα των Χ), γίνονται και 

περισσότερο ανόμοια, έχοντας μεγαλύτερη τετραγωνική διαφορά (μετακινούνται 

υψηλότερα στον άξονα των Υ). Δεν παρέχει όμως πληροφορίες για όλες τις πιθανές 

διευθύνσεις και αποστάσεις. Για αυτό τον λόγο θα πρέπει να προσαρμόσουμε  ένα μοντέλο 

(μία καμπύλη) στο εμπειρικό ημιβαριόγραμμα. Τα μοντέλα ημιβαριογράμματος που 

χρησιμοποιούνται είναι:  Κυκλικό, σφαιρικό, Εκθετικό, Gaussian και γραμμικό. Στην 

εργασία θα χρησιμοποιήσουμε το σφαιρικό μοντέλο, το οποίο δείχνει μία προοδευτική 
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μείωση της αυτοσυσχέτισης (ισοδύναμα μία αύξηση στο ημιβαριόγραμμα), μέχρι κάποια 

απόσταση, μετά από την οποία η αυτοσυσχέτιση είναι μηδέν.  

     

 

                  

                      Partial Sill 

                     

 

                           Nugget 

                                            0                   Distance 

Range καλείται η απόσταση στην οποία το μοντέλο εξομαλύνεται σε μία ευθεία γραμμή. Τα 

σημεία δειγματοληψίας που έχουν αποστάσεις μικρότερες από το range, είναι χωρικά 

αυτοσυσχετισμένες, ενώ περιοχές που είναι μακρύτερα από το range δεν είναι. Η τιμή του 

ημιβαριογράμματος που αντιστοιχεί στην τιμή των Υ, για Χ= range καλείται Sill.  

Θεωρητικά σε μηδενική τιμή διαχωρισμού (lag = 0 ) το ημιβαριόγραμμα είναι μηδέν. 

Εντούτοις σε μία απειροελάχιστη απόσταση διαχωρισμού, το ημιβαριόγραμμα συχνά έχει 

μία τιμή μεγαλύτερη το μηδενός. Για παράδειγμα εάν το ημιβαριόγραμμα τέμνει τον άξονα 

των Υ στο 2 τότε το nugget  είναι 2. Η διαφορά Sill μείον nugget είναι το Partial Sill. Η 

επίδραση του nugget μπορεί να αποδοθεί στα λάθη των μετρήσεων.  

Για την δημιουργία της πρόβλεψης κάθε τοποθεσίας οι συντελεστές βάρους 

υπολογίζονται βάσει του ημιβαριογράμματος το οποίο δημιουργήθηκε από την εξερεύνηση 

των πρωτογενών δεδομένων. Εάν θέλουμε να περιορίσουμε τις πρωτογενείς τιμές που θα 

λάβουν μέρος στον υπολογισμό της προβλέψιμης τιμής θα πρέπει να ορίσουμε μία ακτίνα 

ψαξίματος. Επίσης μπορούμε να ορίσουμε και τον μέγιστο ή ελάχιστο αριθμό πρωτογενών 

μετρήσεων που θα λάβουν μέρος στον υπολογισμό. Έτσι οι συντελεστές βάρους και οι τιμές 

τους υπολογίζονται αφενός μεν από το ημιβαριόγραμμα και αφετέρου από τα έγκυρα 

σημεία των πρωτογενών μετρήσεων που περιβάλουν την προβλέψιμη τοποθεσία.  

Υπάρχουν δυο μέθοδοι Kriging: Ordinary και Universal Kriging. Θα χρησιμοποιήσουμε το 

Ordinary Kriging που είναι πιο γενικό και διαδεδομένο. Υποθέτει ότι ο σταθερός μέσος 

είναι άγνωστος. Είναι μία λογική υπόθεση εκτός και αν για κάποιο επιστημονικό λόγο η 

υπόθεση αυτή απορρίπτεται.  

 

Για τη δημιουργία του χάρτη Αιολικού Δυναμικού της Περιφέρειας Στερεάς Ελλάδας, με 

βάση την παραπάνω ανάλυση, θα ακολουθήσουμε την εξής διαδικασία: 
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 Αρχικά δημιουργούμε το project ArcGISPro Aioliko_Dynamiko  και ορίζουμε τη 

θέση εξαγωγής των αρχείων του project που θα προκύψουν. (Εικ. 4.1). Με την 

αναλυτική διαδικασία Clip θα αποκόψουμε τις μετρήσεις που βρίσκονται μέσα στο 

πολύγωνο της Περιφέρειας στερεάς Ελλάδας, δημιουργώντας ένα νέο επίπεδο 

πληροφορίας (Εικ. 4.2).    

 

Εικόνα 4.1 

 

Εικόνα 4.2 

Επειδή η κλίμακα του χάρτη είναι πολύ μικρή (1:1300000) και η δειγματοληψία 

τόση πυκνή, θα νόμιζε κάποιος ότι το νέο επίπεδο πληροφορίας είναι μια ενιαία 

επιφάνεια. Αν όμως, με την μεγάλη αύξηση της κλίμακας, εστιάσουμε σε μια μικρή 
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περιοχή θα διαπιστώσουμε ότι οι μετρήσεις απέχουν μεταξύ τους αποστάσεις 150 m. 

(Εικ. 4.3) 

 

Εικόνα 4.3 

 Για να υπολογίσουμε τις στατιστικές παραμέτρους του ημιβαριογράμματος (range, 

partial sill, nugget, lag size, number of lags) θα τρέξουμε το Geostatistical Wizard. 

(Εικ. 4.4) 

 

Εικόνα 4.4 

Πριν όμως τρέξουμε τον Wizard πρέπει να βρούμε το «Lag Size», δηλαδή στην 

ουσία την απόσταση που θα ορίσουμε μεταξύ των δειγματοληψιών. Για να το 

πετύχουμε αυτό θα ακολουθήσουμε τη διαδικασία Geoprocessing => Toolboxes => 

Spatial Statistics Tools => Analyzing Patterns => Average Nearest Neighbor.  
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Στο πεδίο Input feature class επιλέγουμε τις μετρήσεις της Περιφέρειας, σαν 

Distance Method επιλέγουμε Euclidean, τσεκάρουμε Generate Report και πατάμε 

Run. (Εικ. 4.5)    

 

Εικόνα 4.5 

 Εκτυπώνεται η αναφορά όπου φαίνεται ότι Observed Mean Distance= 150,024688. 

Επομένως η τιμή του  Lag Size που θα θέσω στο Wizard πρέπει να είναι μεγαλύτερη 

από αυτή που υπολογίστηκε ( > 150,024688 ). (Εικ. 4.6) 

   

Εικόνα 4.6 

 Αφού συμπληρώσουμε την πρώτη καρτέλα του Wizard (Εικ. 4.4) συμπληρώνουμε 

την δεύτερη καρτέλα του Wizard και πατάμε Next. (Εικ. 4.7) 
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       Εικόνα 4.7 

 Στην τρίτη καρτέλα του Wizard βλέπουμε πάνω αριστερά το μοντέλο του 

ημιβαριογράμματος των μετρήσεων της Περιφέρειας και στον πίνακα δεξιά τις 

στατιστικές παραμέτρους  για τιμή  Lag Size = 600:  

Range = 2409,14049 , partial sill = 1,139793 , nugget = 0, number of lags = 12   

(Εικ. 4.8). Ολοκληρώνουμε τη διαδικασία πατώντας Finish.  

    

 Εικόνα 4.8 

 Για την δημιουργία του ψηφιδωτού με τη μέθοδο Kriging θα εισάγουμε το εργαλείο 

(Geoprocessing => Toolboxes => Spatial Analyst Tools => Interpolation =>) 

Kriging. Συμπληρώνουμε την οθόνη του παραθύρου Kriging με τις στατιστικές 

παραμέτρους του ημιβαριογράμματος που υπολογίσαμε (Εικ. 4.9).   
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                                                             Εικόνα 4.9 

 

 Πατώντας Run εξάγεται το ψηφιδωτό αρχείο του αιολικού δυναμικού  (Εικ. 4.10).  

Παρατηρούμε ότι η μέθοδος Kriging έκανε πρόβλεψη και για σημεία 

δειγματοληψίας εκτός των ορίων της Περιφέρειας. Αυτό συνέβη γιατί στην καρτέλα 

της Εικ. 4.9 επιλέξαμε μία μεταβλητή ακτίνα ψαξίματος και ορίσαμε να 

συμμετέχουν τα 12 κοντινότερα σημεία για την πρόβλεψη τιμής. Αν δεν βρεθούν 12 

σημεία σαν μέγιστη απόσταση ψαξίματος ορίστηκαν τα 600 m στην οποία θα 

σταματήσει το ψάξιμο και ο υπολογισμός θα γίνει με όσα σημεία έχουν βρεθεί μέχρι 

εκείνη την στιγμή. Έτσι τα σημεία που βρίσκονται στα όρια της Περιφέρειας 

Στερεάς Ελλάδας μη συμπληρώνοντας τον απαιτούμενο αριθμό μετρήσεων 

επέκτειναν την πρόβλεψη και για σημεία πέρα από τα όρια μέχρι τα 600 m. Αν για 

παράδειγμα επιλέξουμε  σαν μέγιστη απόσταση ψαξίματος τα 5000 m τότε η 

πρόβλεψη θα επεκταθεί πέρα από τα όρια της Περιφέρειας κατά 5000 m.     
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Εικόνα 4.10 

 Με την αναλυτική διαδικασία Extract by Mask θα αποκόψουμε το ψηφιδωτό στα 

όρια της Περιφέρειας (Εικ. 4.11). 

 

Εικόνα 4.11 

 Τελειώνοντας με δεξί κλικ στο παραγόμενο αρχείο επιλέγουμε Symbology, θα 

δημιουργήσουμε οκτώ κατηγορίες ταχύτητας ανέμου και στη συνέχεια θα 

διαμορφώσουμε το χάρτη και το υπόμνημα (Χάρτης 16). 
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Χάρτης 16: Αιολικό Δυναμικό της Περιφέρειας Στερεάς Ελλάδας 
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5.  ΧΡΗΣΕΙΣ ΓΗΣ ΤΗΣ ΠΕΡΙΦΕΡΕΙΑΣ ΣΤΕΡΕΑΣ ΕΛΛΑΔΑΣ 

Ο Ευρωπαϊκός Οργανισμός Περιβάλλοντος είναι ο κύριος δημόσιος φορέας στην Ευρώπη, ο 

οποίος είναι αρμόδιος για την παροχή τεκμηριωμένων και αντικειμενικών πληροφοριών 

περιβάλλοντος στους αρμόδιους για τη χάραξη πολιτικής και στο κοινό. Ο ΕΟΠ, ο οποίος 

λειτουργεί από το 1994 με έδρα την Κοπεγχάγη, είναι ο κεντρικός κόμβος του Ευρωπαϊκού 

Δικτύου Πληροφοριών και Παρατηρήσεων για το Περιβάλλον (ΕΙΟΝΕΤ), ενός δικτύου που 

συνδέει 300 περίπου φορείς σε ολόκληρη την Ευρώπη, συλλέγοντας και διαδίδοντας 

πληροφορίες και στοιχεία για το περιβάλλον. Ο Οργανισμός είναι ένα όργανο της Ε.Ε. 

ανοικτό σε όλες τις χώρες που έχουν τους ίδιους στόχους. Σήμερα συμμετέχουν στον 

οργανισμό 35 Ευρωπαϊκές χώρες και άλλες 6 χώρες είναι υποψήφιες για ένταξη        

(Σερβία, Αλβανία, Κόσοβο, ΠΓΔΜ, Βοσνία-Ερζεγοβίνη, Μαυροβούνιο) 

(https://www.eea.europa.eu/countries-and-regions , 2018). 

Ο ΕΟΠ εκπόνησε το πρόγραμμα CLC2000 και παρουσίασε στις 17 Νοεμβρίου 2004 τον 

πρώτο ψηφιακό χάρτη των μεταβαλλόμενων τοπίων στην Ευρώπη με βάση το πρόγραμμα 

IMAGE2000, ένα δορυφορικό πρόγραμμα απεικόνισης, το οποίο ανέλαβε σε συνεργασία με 

το Κοινό Κέντρο Ερευνών της Ευρωπαϊκής Επιτροπής. Χρησιμοποιήθηκαν επίσης 

αεροφωτογραφίες και επίγειες εικόνες. Από το IMAGE2000, εμπειρογνώμονες από όλη την 

Ευρώπη κατάρτισαν λεπτομερείς χάρτες που εμφανίζουν 44 διαφορετικούς τύπους κάλυψης 

γης όπως ο “συνεχής αστικός ιστός”, οι “βοσκότοποι” και η “μη αρδευόμενη καλλιεργήσιμη 

γη”. 

Tο πρόγραμμα CLC2000 χρησιμοποιείται, μεταξύ άλλων, για την υποστήριξη της 

προστασίας των οικοσυστημάτων, της αναστολής της υποβάθμισης της βιοποικιλότητας, 

της καταγραφής των συνεπειών της μεταβολής του κλίματος, της εκτίμησης των εξελίξεων 

στον κλάδο της γεωργίας και της εφαρμογής της Οδηγίας-Πλαίσιο της ΕΕ για τα Ύδατα. 

Κατ' αυτόν τον τρόπο το πρόγραμμα συμβάλλει στην υλοποίηση των βασικών τομέων 

προτεραιότητας του έκτου κοινοτικού προγράμματος δράσης για το περιβάλλον. Το 

CLC2000 μπορεί να δείξει, παραδείγματος χάριν, πότε επιδεινώνεται το πρόβλημα της 

κατάτμησης της γης από δρόμους ή άλλες υποδομές, αυξάνοντας κατ' αυτόν τον τρόπο τον 

κίνδυνο να μην μπορούν πλέον τα οικοσυστήματα να επικοινωνούν μεταξύ τους και 

θέτοντας σε κίνδυνο την επιβίωση της χλωρίδας και της πανίδας τους. 

(https://www.eea.europa.eu/ , 2018) 

Στον τομέα της γεωργίας, το πρόγραμμα μπορεί να τονίσει τις περιπτώσεις όπου οι μείζονες 

διαρθρωτικές αλλαγές συνεχίζονται ή εντείνονται, όπως η μετατροπή των βοσκότοπων σε 

καλλιεργήσιμη γη (και το αντίστροφο), η επέκταση ή μείωση των εκτάσεων σε 

https://www.eea.europa.eu/countries-and-regions
https://www.eea.europa.eu/
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αγρανάπαυση και των εκτάσεων υπό καθεστώς παύσης καλλιέργειας ή η πλήρης 

εγκατάλειψη της γεωργικής απασχόλησης. 

Η Εθνικό Κτηματολόγιο και Χαρτογράφηση Α.Ε. (ΕΚΧΑ Α.Ε.) ανακοίνωσε την δωρεάν 

παροχή, σε  κάθε ενδιαφερόμενο, των δεδομένων Corine Land Cover για τα έτη 2006 & 

2012 που προέκυψαν μετά την ολοκλήρωση του προγράμματος «GMS/Copernicus  Initial  

Operations (GIO) Land Monitoring 2011-2013» ή GIO LAND, στοχεύοντας στην παροχή 

ολοκληρωμένης και έγκαιρης πληροφόρησης όσον αφορά τις μορφές κάλυψης και χρήσεων 

γης και τις μεταβολές τους, σε εθνικό επίπεδο. Το πρόγραμμα αφορά την διόρθωση του 

χάρτη, για το έτος 2000, των μορφών κάλυψης/χρήσεων γης σε εθνική κλίμακα, την 

καταγραφή των μορφών κάλυψης/χρήσεων γης κατά τα έτη 2006 και 2012 και των 

μεταβολών τους καθώς και τον έλεγχο και την επιβεβαίωση, ως προς την ορθότητά τους, 

των εξής πέντε επιπέδων πληροφορίας: δάση, λιβάδια, υγρότοποι, δόμηση και ύδατα. 

(http://www.ktimatologio.gr/forestmaps/Pages/xrisis-gis.aspx, 2018)    

 Για τη δημιουργία του χάρτη Χρήσεων Γης της Περιφέρειας Στερεάς Ελλάδας θα 

ακολουθήσουμε την εξής διαδικασία: 

 Αρχικά δημιουργούμε το project ArcGISPro  Land_Use και θα προσθέσουμε στον 

πίνακα περιεχομένων το νέο επίπεδο πληροφορίας Χρήσεων Γης (CLC12_GR.shp) 

που κατεβάσαμε από την ΕΚΧΑ Α.Ε. (Εικ. 5.1).  

 

Εικόνα 5.1 

 Με την αναλυτική διαδικασία Clip θα αποκόψουμε τις Χρήσεις Γης που βρίσκονται 

μέσα στο πολύγωνο της Περιφέρειας στερεάς Ελλάδας, δημιουργώντας ένα νέο 

επίπεδο πληροφορίας (Εικ. 5.2).    

http://www.ktimatologio.gr/forestmaps/Pages/xrisis-gis.aspx
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Εικόνα 5.2 

 Τελειώνοντας θα διαμορφώσουμε το χάρτη και το υπόμνημα σύμφωνα με τους 

τύπους κάλυψης γης και τους χρωματισμούς του προγράμματος Corine Land Cover  

(Χάρτης 17).  
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Χάρτης 17: Χρήσεις Γης  της Περιφέρειας Στερεάς Ελλάδας 

 

 

 



 

96 
 

Τα δεδομένα του Προγράμματος Corine Land  Cover μπορούν να αξιοποιηθούν στην 

αναζήτηση πληροφοριών για τη σχέση που υπάρχει μεταξύ της ανάπτυξης της Περιφέρειας 

Στερεάς Ελλάδας και του φυσικού χώρου. Στην Παγκόσμια Διάσκεψη του Οργανισμού 

Ηνωμένων Εθνών για το Περιβάλλον και την Ανάπτυξη, που έλαβε χώρα στο Ρίο της 

Βραζιλίας το 1992, διατυπώθηκε η θέση ότι η ανάπτυξη δεν συμβαίνει στο κενό αλλά 

βρίσκεται σε αλληλεπίδραση με το φυσικό και κοινωνικό «χώρο». (Porter & J.W. Brown, 

1996) 

Επομένως με τις πρωτοβουλίες της η Ευρωπαϊκή Ένωση συμβάλει στη δημιουργία και στην 

αξιοποίηση δεικτών που σχετίζονται με το φυσικό περιβάλλον και την κοινωνία. Ως προς το 

φυσικό περιβάλλον, η προσπάθεια που καταβάλλεται αφορά στη δημιουργία δεικτών 

μέτρησης περιβαλλοντικών πιέσεων που ασκούνται εντός της Ευρωπαϊκής Ένωσης από την 

ανθρώπινη δράση, καθώς και στον υπολογισμό του οικολογικού αποτυπώματος που 

δημιουργείται στον πλανήτη ως αποτέλεσμα της παραγωγής και κατανάλωσης εντός της 

Ευρωπαϊκής Ένωσης.  

Για την παροχή πληροφόρησης ως προς το φυσικό περιβάλλον και τις πιέσεις που δέχεται 

από την αναπτυξιακή διαδικασία, μέσω του Προγράμματος Corine Land  Cover  οι Χρήσεις 

Γης ταξινομήθηκαν σε 44 τύπους κάλυψης (Εικ. 5.3). Στην Περιφέρεια Στερεάς Ελλάδας 

απαντούν οι 37 τύποι κάλυψης (Εικ. 5.4 και 5.5) που μπορούν να ενταχθούν σε 5 ευρύτερες 

κατηγορίες:  

α) Τεχνητές επιφάνειες, β) Γεωργικές περιοχές, γ) Δάση και ημι-φυσικές περιοχές, δ) 

Υγρότοποι και ε) Υδάτινες επιφάνειες. 

Οι Τεχνητές επιφάνειες μπορούν να χρησιμοποιηθούν π.χ. στον υπολογισμό του Δείκτη 

Χωροθέτησης Τεχνητού Χώρου (Location Quotient - L.Q. artificial). Σκοπός του δείκτη 

είναι να αναδείξει τις περιοχές όπου τοπικά το χαρακτηριστικό υπερτερεί ή υπολείπεται σε 

σχέση με το σύνολο της χώρας. (Καλογήρου Στ., 2015) Οι Γεωργικές περιοχές μπορούν να 

χρησιμοποιηθούν στον υπολογισμό της Φυσιολογικής Πυκνότητας Πληθυσμού κ.α.  

Στο χάρτη 18 γίνεται υπολογισμός της έκτασης και του αντίστοιχου ποσοστού που 

καταλαμβάνουν οι 5 ευρύτερες κατηγορίες των Χρήσεων Γης της Περιφέρειας Στερεάς.  

Ως προς την κοινωνία, επιχειρείται η δημιουργία δεικτών που αφορούν στην κοινωνική 

συνοχή και στην ανθρώπινη ανάπτυξη, στην ποιότητα ζωής και στις καταναλωτικές 

συνήθειες. Υπολογισμό τέτοιων δεικτών θα δούμε στην ενότητα 6 (Δημογραφικά 

χαρακτηριστικά της Περιφέρειας). 
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Εικόνα 5.3 

 

 

 

 

 

 



 

98 
 

  

Εικόνα 5.4: Από τον πίνακα περιγραφικών χαρακτηριστικών του επιπέδου «Κατηγορίες χρήσεων  

                        Γης»  βλέπουμε τους  37  τύπους κάλυψης γης (τρίτο επίπεδο)  που συναντάμε στην  

                        Περιφέρεια Στερεάς, την επιφάνεια  και  το αντίστοιχο ποσοστό που  καταλαμβάνουν.  

                       Ο χάρτης 17 είναι η οπτικοποίηση του πίνακα. Η εξαγωγή του πίνακα σε φύλο Excel 

                       δίνει καλύτερο οπτικό αποτέλεσμα (Εικ. 5.5)  
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Εικόνα 5.5: Οι  37  τύποι κάλυψης γης  (τρίτο επίπεδο)  που συναντάμε στην Περιφέρεια 

                 Στερεάς με την επιφάνεια  και  το αντίστοιχο ποσοστό που  καταλαμβάνουν.  

                           Πηγή: ΕΚΧΑ Α.Ε, ιδία επεξεργασία 

 

 

 

ΤΥΠΟΙ  ΚΑΛΥΨΗΣ  ΓΗΣ  ΠΟΥ  ΣΥΝΑΝΤΑΜΕ  ΣΤΗΝ  

ΠΕΡΙΦΕΡΕΙΑ  ΣΤΕΡΕΑΣ  ΕΛΛΑΔΑΣ   (Τρίτο επίπεδο)

Κωδικός Επιφάνεια 

(τ.χλμ)

Ποσοστό 

(%)

Συνεχής αστικός ιστός 111 12,49 0,080

Ασυνεχής αστικός ιστός 112 176,96 1,138

Βιομηχανικές και εμπορικές ζώνες 121 38,81 0,250

Οδικά και σιδηροδρομικά δίκτυα 122 24,27 0,156

Ζώνες λιμένων 123 0,19 0,001

Αεροδρόμια 124 8,41 0,054

Χώροι εξορύξεως ορυκτών 131 50,10 0,322

Χώροι απορρίψεως απορριμμάτων 132 0,77 0,005

Χώροι οικοδόμησης 133 31,86 0,205

Εγκαταστάσεις αθλητισμού και αναψυχής 142 10,28 0,066

Μη αρδευόμενη αρόσιμη γη 211 866,07 5,568

Μόνιμα αρδευόμενη γη 212 1.134,89 7,297

Ορυζώνες 213 36,17 0,233

Αμπελώνες 221 14,18 0,091

Οπωροφόρα δένδρα και φυτείες με σαρκώδεις καρπούς 222 22,28 0,143

Ελαιώνες 223 735,19 4,727

Λιβάδια 231 54,29 0,349

Ετήσιες καλλιέργειες που σχετίζονται με μόνιμες καλλιέργειες 241 16,37 0,105

Σύνθετες καλλιέργειες 242 905,16 5,820

Γη που χρησιμοποιείται κυρίως για γεωργία μαζί με σημαντικά 

τμήματα φυσικής βλάστησης 243 1.260,32 8,103

Δάσος πλατύφυλλων 311 603,58 3,881

Δάσος κωνοφόρων 312 1.768,07 11,368

Μικτό δάσος 313 1.037,55 6,671

Φυσικοί βοσκότοποι 321 724,08 4,656

Θάμνοι και χερσότοποι 322 220,49 1,418

Σκληροφυλλική βλάστηση 323 3.548,34 22,814

Μεταβατικές δασώδεις και θαμνώδεις εκτάσεις 324 1.798,14 11,561

Παραλίες, αμμόλοφοι, Αμμουδιές 331 26,71 0,172

Απογυμνωμένοι βράχοι 332 28,23 0,182

Εκτάσεις με αραιή βλάστηση 333 223,12 1,435

Αποτεφρωμένες εκτάσεις 334 16,65 0,107

Βάλτοι στην ενδοχώρα 411 7,62 0,049

Παραθαλάσσιοι βάλτοι 421 9,49 0,061

Υδατορρεύματα 511 12,36 0,079

Επιφάνειες στάσιμου ύδατος 512 95,26 0,612

Εκβολές ποταμών 522 0,31 0,002

Θάλασσες και ωκεανοί 523 34,03 0,219

Συνολική επιφάνεια 15.553,11 100,000
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Χάρτης 18: Κατηγορίες Χρήσεων Γης της Περιφέρειας Στερεάς Ελλάδας 
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6.   ΔΗΜΟΓΡΑΦΙΚΑ ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ ΤΩΝ ΔΗΜΩΝ ΚΑΛΛΙΚΡΑΤΗ  ΤΗΣ   

      ΠΕΡΙΦΕΡΕΙΑΣ ΣΤΕΡΕΑΣ ΕΛΛΑΔΑΣ 

Σύμφωνα με το δημογραφικό λεξικό του Οργανισμού Ηνωμένων Εθνών (Ο.Η.Ε.) η 

Δημογραφία ορίζεται ως: “Η επιστήμη που μελετά του ανθρώπινους πληθυσμούς, 

πρωταρχικά όσον αφορά το μέγεθος, τη σύνθεση και την εξέλιξη τους”. 

Ένας πλήρης ορισμός της δημογραφίας διατυπώθηκε από τους Hauser και Duncan το 1959, 

όπου σύμφωνα με αυτούς δημογραφία είναι «η μελέτη του μεγέθους, της χωρικής κατανομής, 

της σύνθεσης και της δομής ενός πληθυσμού, των μεταβολών του και των συντελεστών αυτών 

των μεταβολών, δηλαδή της γεννητικότητας, της θνησιμότητας, των γεωγραφικών αλλά και 

κοινωνικών μετακινήσεων» (Hauser & O. D. Duncan, 1959) 

Η Δημογραφία λοιπόν είναι η επιστήμη που ασχολείται με την πληθυσμιακή μελέτη, τη 

μελέτη δηλαδή του μεγέθους και των χαρακτηριστικών των ανθρώπινων πληθυσμών και 

διερευνά το πώς αυτοί οι πληθυσμοί εξελίσσονται και πώς διαμορφώνονται διαχρονικά. 

Σύμφωνα με την Εθνική Στατιστική Υπηρεσία ο πληθυσμός διακρίνεται στον πραγματικό, 

στον μόνιμο και στον νόμιμο.    

Πραγματικός πληθυσμός: ο συνολικός πληθυσμός ενός τόπου που βρίσκεται και 

απογράφεται κατά την απογραφή στον συγκεκριμένο τόπο ανεξάρτητα από το εάν διαμένει 

μόνιμα στον τόπο αυτό ή αν είναι προσωρινός ή περαστικός. 

Μόνιμος πληθυσμός: ο συνολικός πληθυσμός που δηλώνει ως μόνιμη κατοικία του κατά 

την απογραφή του τον συγκεκριμένο τόπο ανεξάρτητα από το που βρέθηκε και απογράφηκε 

στην επικράτεια της χώρας. 

Νόμιμος πληθυσμός: αποτελείται από τον αριθμό των δημοτών, δηλαδή από το σύνολο 

των ατόμων κάθε ηλικίας και φύλου, που είναι καταχωρημένα στα αντίστοιχα δημοτολόγια 

και εφόσον κατά τη ημέρα της απογραφής βρίσκονταν στη Χώρα και απογράφηκαν ως 

παρόντες ή απουσίαζαν προσωρινά στο εξωτερικό..  

Το πρώτο βήμα για την μελέτη της δομής και της εξέλιξης του πληθυσμιακού συνόλου της 

Περιφέρειας Στερεάς Ελλάδας είναι η συλλογή στατιστικών δεδομένων από την ΕΛΣΤΑΤ 

που αφορούν τον μόνιμο πληθυσμό της. Στη συνέχεια τα δεδομένα αυτά αφενός μεν θα 

ταξινομηθούν και θα παρουσιαστούν με την εφαρμογή τεχνικών της Περιγραφικής 

Στατιστικής (κατασκευή πινάκων και διαγραμμάτων, υπολογισμός δεικτών) ώστε να 

αποκτήσουμε μια εικόνα της μορφής αυτών των δεδομένων, αφετέρου θα οπτικοποιηθούν 

με το ArcGISPro. Ο όρος “οπτικοποίηση” έχει μία διεισδυτικότερη, εννοιολογικά 

διάσταση, δεδομένου ότι ο χάρτης λειτουργεί όχι μόνο ως μέσο μετάδοσης πληροφορίας 

αλλά και ως μέσο δημιουργίας νοητικών αναπαραστάσεων του γεωγραφικού χώρου. 

(MacEachren, 1994)   
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Ο πληθυσμός της Περιφέρειας Στερεάς Ελλάδας, σύμφωνα με τα οριστικά αποτελέσματα 

της απογραφής πληθυσμού 2011, ανέρχεται σε 547.390 μόνιμους κατοίκους (5,06% του 

συνολικού πληθυσμού της χώρας), παρουσιάζοντας  μείωση κατά 2,02%, η οποία είναι λίγο 

μεγαλύτερη από τη γενική τάση μείωσης (1,34%) σε επίπεδο χώρας. Εδώ θα πρέπει να 

τονίσουμε ότι χρησιμοποιήθηκε ο «μόνιμος» πληθυσμός (558.144) της απογραφής 2001 

(πηγή: e-Demography, Πανεπιστήμιο Θεσσαλίας), ώστε να συγκρίνονται ίδια μεγέθη, και 

όχι ο «πραγματικός» που χρησιμοποιήθηκε κατά κόρον τη δεκαετία του 2000. Το 

μεγαλύτερο μέρος του πληθυσμού κατοικεί στο ανατολικό μέρος της περιφέρειας και στις 

Π.Ε. Εύβοιας (38,5%), Φθιώτιδας (28,9%) και Βοιωτίας (21,5%) έναντι των δύο δυτικών 

Π.Ε. Φωκίδας και Ευρυτανίας, όπου κατοικεί μόλις το 7,4% και το 3,7% αντίστοιχα. Στις 

πεδινές εκτάσεις της περιφέρειας εκτιμάται ότι κατοικεί περίπου το 57% του μόνιμου 

πληθυσμού, στις ημιορεινές το 26% και στις ορεινές μόλις το 17%.  Επίσης, πάνω από τα 

2/3 του πληθυσμού της Περιφέρειας είναι εγκατεστημένα στην παράκτια ζώνη (ως και 10 

χλμ. μακριά από την ακτογραμμή). Το ποσοστό των ανδρών (50,69%) είναι μεγαλύτερο από 

αυτό των γυναικών (49,31%). Στον πίνακα 4 παρουσιάζεται η κατανομή του πληθυσμού της 

Περιφέρειας Στερεάς Ελλάδας κατά φύλο και ηλικία ( σε πενταετείς ηλικιακές ομάδες) και 

στον πίνακα 5 το αντίστοιχο ποσοστό.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                        

  Πίνακας 4: Πηγή ΕΛΣΤΑΤ                                                       Πίνακας 5: Πηγή ΕΛΣΤΑΤ 

Ηλικιακή 
κατηγορία 

Άνδρες Γυναίκες 

0 -4 12 950 12 241 

5-9 12 758 12 142 

10-14 13 218 12 499 

15-19 14 298 12 361 

20-24 16 451 12 646 

25-29 19 304 15 670 

30-34 20 954 18 272 

35-39 20 479 18 585 

40-44 21 491 19 721 

45-49 19 006 18 193 

50-54 18 543 17 907 

55-59 16 748 16 493 

60-64 15 480 16 319 

65-69 13 911 14 702 

70-74 14 391 16 951 

75-79 12 829 15 189 

80-84 8 877 11 395 

85++ 5 787 8 629 

ΣΥΝΟΛΟ 277 475 269 915 

Ηλικιακή 
κατηγορία 

Άνδρες 
% 

Γυναίκες 
% 

0 -4 2.37 2.24 

5-9 2.33 2.22 

10-14 2.41 2.28 

15-19 2.61 2.26 

20-24 3.01 2.31 

25-29 3.53 2.86 

30-34 3.83 3.34 

35-39 3.74 3.40 

40-44 3.93 3.60 

45-49 3.47 3.32 

50-54 3.39 3.27 

55-59 3.06 3.01 

60-64 2.83 2.98 

65-69 2.54 2.69 

70-74 2.63 3.10 

75-79 2.34 2.77 

80-84 1.62 2.08 

85++ 1.06 1.58 

ΣΥΝΟΛΟ 50.69 49.31 
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Για την διαγραμματική αποτύπωση της κατανομής του πληθυσμού της Περιφέρειας Στερεάς 

Ελλάδας των παραπάνω πινάκων θα κατασκευάσουμε την ηλικιακή πυραμίδα:  

 

Εικόνα 6.1: Πηγή ΕΛΣΤΑΤ, απογραφή 2011, επεξεργασία στοιχείων 

 

Σχηματικά, μπορούμε, να διακρίνουμε τρεις τύπους πυραμίδων που αντιστοιχούν σε 

συγκεκριμένους τύπους πληθυσμού (νεανικό, ώριμο, γεροντικό). (Εικ. 6.2)  

 

Εικόνα 6.2 :  (Κοτζαμάνης, 2009) 

Η ηλικιακή πυραμίδα της Περιφέρειας Στερεάς Ελλάδας αντιστοιχεί στον τύπο (γ), 

επομένως ο πληθυσμός της χαρακτηρίζεται γεροντικός. 

Πιο συγκεκριμένα η πυραμίδα της Περιφέρειας Στερεάς Ελλάδας παρουσιάζει:  

 συρρικνωμένη βάση ως αποτέλεσμα της καθοδικής τάσης της γεννητικότητας, 

 διευρυμένη κορυφή εξαιτίας της δημογραφικής γήρανσης,  
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 ενισχυμένα τα μεσαία στρώματα λόγω και της πρόσφατης (για το 2011) μαζικής 

εγκατάστασης οικονομικών μεταναστών, 

 μεγαλύτερο ποσοστό των ανδρών  στις ηλικίες από 0-59 ετών, 

 μεγαλύτερο ποσοστό γυναικών στις ηλικίες πάνω από 60 ετών. 

Στη συνέχεια θα γίνει ανάλυση σε επίπεδο Δήμων Καλλικράτη της αριθμητικής πυκνότητας 

πληθυσμού και των επιμέρους δημογραφικών δεικτών. 

6.1   Αριθμητική πυκνότητα πληθυσμού των Δήμων Καλλικράτη της Περιφέρειας  

        Στερεάς Ελλάδας 

Σαν αριθμητική πυκνότητα πληθυσμού ορίζεται ο λόγος του πληθυσμού προς την έκταση 

και εκφράζεται σε αριθμό κατοίκων ανά τετραγωνικό χιλιόμετρο (κατ./τ.χλμ). Η αριθμητική 

πυκνότητα ενός δήμου δίνει μια εικόνα για την κατανομή των ανθρώπων σ’ αυτόν. Στην 

Εικόνα 6.3 βλέπουμε τα περιγραφικά χαρακτηριστικά του επιπέδου πληροφορίας 

«Αριθμητική Πυκνότητα πληθυσμού». Τα δεδομένα του μόνιμου πληθυσμού προέρχονται 

από την απογραφή του 2011, η έκταση των Δήμων (πεδίο _Area) υπολογίστηκε αυτόματα 

από το Project  που δημιουργήσαμε και η πυκνότητα των Δήμων  (πεδίο _Density_18) 

υπολογίστηκε με το εργαλείο Field Calculator του Geoprocessing.  Από το χάρτη 19 

φαίνεται ότι ο πιο πυκνοκατοικημένος Δήμος της Περιφέρειας Στερεάς Ελλάδας είναι ο 

Δήμος Χαλκιδέων και ο πιο αραιοκατοικημένος ο Δήμος Αγράφων.  

 

Εικόνα 6.3 
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Χάρτης 19: Αριθμητική  Πυκνότητα  Πληθυσμού των Δήμων Καλλικράτη 

                                   της Περιφέρειας Στερεάς Ελλάδας 
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6.2   Ανάλυση δομικών δημογραφικών δεικτών με βάση την απογραφή του 2011. 

6.2.1   Δείκτης αναλογίας φύλου (Sex Ratio) 

Είναι ο συνηθέστερος δημογραφικός δείκτης και υπολογίζεται σαν το κλάσμα του αριθμού 

ανδρών προς τον αριθμό γυναικών στον πληθυσμό. Πολλαπλασιαζόμενος με το 100 

εκφράζει τον αριθμό ανδρών ανά 100 γυναίκες στον πληθυσμό.  Ο συγκεκριμένος δείκτης 

καταγράφει έντονες γεωγραφικές διαφοροποιήσεις αφού είναι ιδιαίτερα ευαίσθητος στην 

ηλικιακή δομή του πληθυσμού ακολουθώντας σε γενικές γραμμές τον κανόνα ότι όσο 

νεότερος είναι ένας πληθυσμός τόσο υψηλότερη η αναλογία των ανδρών μέσα σε αυτόν. 

 

Πίνακας 6:  Δείκτης Αναλογίας  φύλου των Δήμων Καλλικράτη της Περιφέρειας Στερεάς  

                        Ελλάδας για το έτος 2011, Πηγή ΕΛΣΤΑΤ, επεξεργασία στοιχείων. 

Οι μεγαλύτερες τιμές του δείκτη αναλογίας φύλου αντιστοιχούν στον Δήμο Σκύρου (121). 

Τη μικρότερη τιμή του δείκτη έχουν οι δήμοι Μώλου-Αγίου Κωνσταντίνου και Ιστιαίας-

Αιδηψού (97). Ο δείκτης αναλογίας φύλου της Περιφέρειας Στερεάς Ελλάδας είναι 103. 

(Αυξήθηκε από την απογραφή του μόνιμου πληθυσμού του 2001 κατά 0,93: δείκτης 

αναλογίας φύλου 2001: 96,07. Τρόπος υπολογισμού του e-Demography: 

γυναίκες/άνδρες*100= 96,07. Για να είναι συγκρίσιμα τα μεγέθη πρέπει να γίνει ανάλογος 

υπολογισμός για το 2011: γυναίκες/άνδρες*100= 97. Πηγή: e-Demography, Πανεπιστήμιο 

Θεσσαλίας). Στο Διάγραμμα 1 βλέπουμε τη σύγκριση του δείκτη των Δήμων Καλλικράτη 

με τον δείκτη της Περιφέρειας.   

 



 

107 
 

 

Διάγραμμα 1: Πηγή ΕΛΣΤΑΤ, απογραφή 2011, επεξεργασία στοιχείων 

Για την οπτικοποίηση του παραπάνω αποτελέσματος με τη διαδικασία Join του ArcGISPro 

(Εικ. 6.4) θα συνδέσουμε τον πίνακα της ΕΛΣΤΑΤ που περιέχει τα δημογραφικά δεδομένα 

με βάση το κοινό πεδίο, που είναι ο γεωγραφικός κωδικός του Δήμου, με τον πίνακα 

περιγραφικών χαρακτηριστικών του επιπέδου πληροφορίας «Όρια Δήμων Καλλικράτη» που 

κατεβάσαμε από τα Δημόσια Ανοιχτά Δεδομένα και περιέχει τη γεωγραφική πληροφορία 

(Εικ. 6.5). Θα δημιουργήσουμε έτσι ένα νέο επίπεδο πληροφορίας «Αριθμός ανδρών ανά 

100 γυναίκες» που θα περιέχει τα δημογραφικά περιγραφικά χαρακτηριστικά και τη 

γεωγραφική πληροφορία.  

Με δεξί κλικ στο νέο επίπεδο πληροφορίας επιλέγουμε Symbology και στο αναδυόμενο 

παράθυρο μπορούμε να δημιουργήσουμε 6 κλάσεις για να διακρίνει κάποιος αμέσως τους 

Δήμους με την μεγαλύτερη και τη μικρότερη αναλογία ανδρών-γυναικών. Πράγματι από το 

Χάρτη 20 προκύπτει ότι οι δήμοι με τη μεγαλύτερη αναλογία ανδρών είναι οι Δήμοι 

Σκύρου και Τανάγρας ενώ αυτοί με τη μικρότερη αναλογία είναι οι Δήμοι Μώλου-Αγίου 

Κωνσταντίνου, Ιστιαίας-Αιδηψού και Δελφών.  
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Εικόνα 6.4: Λειτουργία του εργαλείου Join. Πηγή: Παράθυρο βοήθειας του ArcGISPro 2.1 

 

 

Εικόνα 6.5: Σύνδεση των δύο πινάκων με βάση το κοινό πεδίο που είναι ο κωδικός του Δήμου. 
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Χάρτης 20: Γεωγραφική Κατανομή του Δείκτη Αναλογίας Φύλου  

                                          της Περιφέρειας Στερεάς Ελλάδας 
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6.2.2   Δείκτης εξάρτησης (Dependency Ratio) 

Επειδή υπάρχουν ακριβείς πληροφορίες, από την απογραφή του 2011, ο δείκτης αυτός 

μπορεί να υπολογιστεί σαν το κλάσμα του αριθμού των οικονομικά μη ενεργών ατόμων 

προς τον αριθμό των οικονομικά ενεργών ατόμων στον πληθυσμό (Κωστάκη Α., 2003). 

Πολλαπλασιαζόμενος με 100 εκφράζει τον μέσο αριθμό εξαρτημένων ατόμων ανά 100 

οικονομικά ενεργά άτομα στον πληθυσμό. Από τον Πίνακα 7 βλέπουμε ότι η μεγαλύτερη 

τιμή του δείκτη αντιστοιχεί στον Δήμο Αγράφων (259) και η μικρότερη στον δήμο 

Τανάγρας (114).  Ο δείκτης εξάρτησης της Περιφέρειας Στερεάς Ελλάδας με αυτόν τον 

τρόπο υπολογισμού είναι 152. 

 

Πίνακας 7:  Δείκτης Εξάρτησης των Δήμων Καλλικράτη της Περιφέρειας Στερεάς  

                             Ελλάδας για το έτος 2011, Πηγή ΕΛΣΤΑΤ, επεξεργασία στοιχείων. 

Στο Διάγραμμα 2 βλέπουμε τη σύγκριση του Δείκτη Εξάρτησης  (Dependency Ratio)  των 

Δήμων Καλλικράτη με τον Δείκτη Εξάρτησης της Περιφέρειας Στερεάς Ελλάδας.   
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Διάγραμμα 2: Πηγή ΕΛΣΤΑΤ, απογραφή 2011, επεξεργασία στοιχείων 

Ακολουθώντας την παραπάνω διαδικασία Join θα οπτικοποιήσουμε το αποτέλεσμα 

δημιουργώντας 5 κλάσεις για να διακρίνεται αμέσως οι Δήμοι με το μεγαλύτερο και το 

μικρότερο δείκτη εξάρτησης. Πράγματι από το Χάρτη 21 προκύπτει ότι οι δήμοι με το 

μεγαλύτερο δείκτη εξάρτησης είναι οι Δήμοι Αγράφων και Δωρίδας ενώ αυτοί με το 

μικρότερο δείκτη είναι οι δήμοι Τανάγρας, Αλιάρτου, Θηβαίων και Χαλκιδέων.    

 



 

112 
 

 

Χάρτης 21: Γεωγραφική Κατανομή του Δείκτη Εξάρτησης (Dependency Ratio) 

                              της Περιφέρειας Στερεάς Ελλάδας 
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Όταν δεν υπάρχουν ακριβείς πληροφορίες ο παραπάνω δείκτης υπολογίζεται προσεγγιστικά 

σαν το κλάσμα του αριθμού ατόμων των ηλικιακών ομάδων 0-14 και 65 και άνω, προς τα 

άτομα ηλικιών 15-64 ετών. Με αυτόν τον τρόπο υπολογισμού του δείκτη εξάρτησης μας 

δίνεται η δυνατότητα να εξάγουμε σημαντικά συμπεράσματα για τα επίπεδα θνησιμότητας 

και γεννητικότητας του πληθυσμού, αφού αυτά επηρεάζονται από τον δείκτη εξάρτησης.  

Στον Πίνακα 8 εμφανίζονται οι Δείκτες Εξάρτησης (Age Dependency Ratio) των Δήμων 

Καλλικράτη της Περιφέρειας Στερεάς Ελλάδας το 2011 στο σύνολο του πληθυσμού, των 

Δήμων ξεχωριστά κατά φύλο και στην Περιφέρεια. Οι μεγαλύτερες τιμές του δείκτη τόσο 

στον πληθυσμό (87) όσο και στα δυο φύλα (άνδρες:69, γυναίκες:110) αντιστοιχούν στον 

Δήμο Αγράφων. Τη μικρότερη τιμή του δείκτη για το σύνολο του πληθυσμού έχουν οι 

δήμοι Θηβαίων, Τανάγρας και Χαλκιδέων (46). Για τον ανδρικό πληθυσμό τη μικρότερη 

τιμή έχουν οι δήμοι  Θηβαίων και Τανάγρας (40),  ενώ για τις γυναίκες ο δήμος Χαλκιδέων 

(49).  

Ο Δείκτης Εξάρτησης (Age Dependency Ratio) της Περιφέρειας Στερεάς Ελλάδας  για το 

σύνολο του πληθυσμού με αυτόν τον τρόπο υπολογισμού είναι 57 και αυξήθηκε από την 

απογραφή του μόνιμου πληθυσμού του 2001 κατά 4,35 (δείκτης εξάρτησης 2001: 52,65,  

πηγή: e-Demography, Πανεπιστήμιο Θεσσαλίας).  

Οι δείκτες εξάρτησης των γυναικών (62) παρουσιάζονται συστηματικά υψηλότεροι σε 

σχέση με εκείνους των ανδρών (52) γεγονός που μπορεί να αποδοθεί στην υψηλότερη 

θνησιμότητα των ανδρών. Αυτό έχει σαν αποτέλεσμα στην ηλικιακή ομάδα 65 και άνω οι 

γυναίκες να υπερτερούν αριθμητικά των ανδρών.  

Στο Διάγραμμα 3  βλέπουμε τη σύγκριση του Δείκτη Εξάρτησης  (Age Dependency Ratio)  

των Δήμων Καλλικράτη για το σύνολο του πληθυσμού, τις γυναίκες και τους άνδρες με τον 

Δείκτη Εξάρτησης (Age Dependency Ratio) της Περιφέρειας Στερεάς Ελλάδας.   
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Πίνακας 8:  Δείκτης Εξάρτησης (Age Dependency Ratio) των Δήμων Καλλικράτη  

                   της Περιφέρειας Στερεάς  Ελλάδας για το έτος 2011, Πηγή  ΕΛΣΤΑΤ,  

                             επεξεργασία στοιχείων. 
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Διάγραμμα 3: Πηγή ΕΛΣΤΑΤ, απογραφή 2011, επεξεργασία στοιχείων 

 

Ακολουθώντας την παραπάνω διαδικασία Join θα οπτικοποιήσουμε το αποτέλεσμα 

δημιουργώντας 5 κλάσεις για να διακρίνονται αμέσως οι Δήμοι με το μεγαλύτερο και το 

μικρότερο δείκτη συνολικής εξάρτησης. Ταυτόχρονα, για να αναδείξουμε τον υψηλότερο 

δείκτη εξάρτησης που παρουσιάζουν οι γυναίκες, θα εισάγουμε σε κάθε Δήμο γράφημα 

στηλών για τα δυο φύλα. Πράγματι από το Χάρτη 22 προκύπτει ότι οι Δήμοι με το 

μεγαλύτερο δείκτη εξάρτησης είναι οι Δήμοι Αγράφων, Δωρίδας, Μακρακώμης και 

Δομοκού ενώ αυτοί με το μικρότερο δείκτη είναι οι δήμοι Τανάγρας,  Θηβαίων και 

Χαλκιδέων. Από το γράφημα στηλών φαίνεται ότι ο δείκτης εξάρτησης γυναικών σε 

όλους τους Δήμους είναι υψηλότερος με μικρότερη διαφορά αυτή του Δήμου Ερέτριας.      
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Δείκτης εξάρτησης (Age Dependency Ratio) των Δήμων 
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Σύνολο Πληθυσμού Δήμου Άνδρες Γυναίκες Περιφέρεια
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Χάρτης 22: Γεωγραφική Κατανομή του Δείκτη Εξάρτησης (Age Dependency Ratio)  

                           της Περιφέρειας Στερεάς Ελλάδας 
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Ο συνολικός δείκτης εξάρτησης (Age Dependency Ratio) διασπάται σε δύο επιμέρους 

δείκτες : τον δείκτη εξάρτησης παιδικού πληθυσμού (Child Dependency Ratio) και τον δείκτη 

εξάρτησης ηλικιωμένων (Old Age Dependency Ratio). 

6.2.2.1   Δείκτης εξάρτησης παιδικού πληθυσμού (Child Dependency Ratio) 

Ο δείκτης αυτός υπολογίζεται σαν το κλάσμα του πληθυσμού ηλικιών 0 ως 14 προς τον 

πληθυσμό ηλικιών 15 έως 64. Πολλαπλασιασμένος με το 100 εκφράζει το μέσο αριθμό 

ατόμων ηλικιών κάτω των 15 ετών στα 100 άτομα ηλικιών 15 έως 64. 

Από τον Πίνακα 9 βλέπουμε ότι τη μεγαλύτερη τιμή του δείκτη παρουσιάζει ο δήμος 

Χαλκιδέων (24) και τη μικρότερη ο δήμος Αγράφων (15). Ο δείκτης εξάρτησης παιδικού 

πληθυσμού της Περιφέρειας Στερεάς Ελλάδας είναι 22.  

 

Πίνακας 9:  Δείκτης Εξάρτησης (Child Dependency Ratio) των Δήμων Καλλικράτη  

                   της  Περιφέρειας  Στερεάς  Ελλάδας για το έτος 2011, Πηγή  ΕΛΣΤΑΤ,  

                            επεξεργασία στοιχείων. 

 

Α/Α Δήμοι Καλλικράτη Σύνολο 

πληθυσμού 0-14 15-64 >65

Child 

Dependency 

Ratio

1 ΔΗΜΟΣ ΑΓΡΑΦΩΝ 6976 558 3733 2685 15

2 ΔΗΜΟΣ ΑΛΙΑΡΤΟΥ 10887 1526 7070 2291 22

3 ΔΗΜΟΣ ΑΜΦΙΚΛΕΙΑΣ - ΕΛΑΤΕΙΑΣ 10922 1242 6589 3091 19

4 ΔΗΜΟΣ ΔΕΛΦΩΝ 26716 3511 16700 6505 21

5 ΔΗΜΟΣ ΔΙΡΦΥΩΝ - ΜΕΣΣΑΠΙΩΝ 18800 2231 12222 4347 18

6 ΔΗΜΟΣ ΔΙΣΤΟΜΟΥ - ΑΡΑΧΟΒΑΣ - ΑΝΤΙΚΥΡΑΣ 8188 1215 5330 1643 23

7 ΔΗΜΟΣ ΔΟΜΟΚΟΥ 11495 1344 6519 3632 21

8 ΔΗΜΟΣ ΔΩΡΙΔΟΣ 13627 1310 7712 4605 17

9 ΔΗΜΟΣ ΕΡΕΤΡΙΑΣ 13053 1914 8290 2849 23

10 ΔΗΜΟΣ ΘΗΒΑΙΩΝ 36477 5140 24918 6419 21

11 ΔΗΜΟΣ ΙΣΤΙΑΙΑΣ - ΑΙΔΗΨΟΥ 21083 2703 12422 5958 22

12 ΔΗΜΟΣ ΚΑΡΠΕΝΗΣΙΟΥ 13105 1633 7783 3689 21

13 ΔΗΜΟΣ ΚΑΡΥΣΤΟΥ 12180 1614 7399 3167 22

14 ΔΗΜΟΣ ΚΥΜΗΣ - ΑΛΙΒΕΡΙΟΥ 28437 3630 16925 7882 21

15 ΔΗΜΟΣ ΛΑΜΙΕΩΝ 75315 11459 49411 14445 23

16 ΔΗΜΟΣ ΛΕΒΑΔΕΩΝ 31315 4603 20311 6401 23

17 ΔΗΜΟΣ ΛΟΚΡΩΝ 19623 2729 12191 4703 22

18 ΔΗΜΟΣ ΜΑΚΡΑΚΩΜΗΣ 16036 1597 8999 5440 18

19 ΔΗΜΟΣ ΜΑΝΤΟΥΔΙΟΥ - ΛΙΜΝΗΣ - ΑΓΙΑΣ ΑΝΝΑΣ 12045 1170 7304 3571 16

20 ΔΗΜΟΣ ΜΩΛΟΥ - ΑΓΙΟΥ ΚΩΝΣΤΑΝΤΙΝΟΥ 12090 1603 7198 3289 22

21 ΔΗΜΟΣ ΟΡΧΟΜΕΝΟΥ 11621 1629 6959 3033 23

22 ΔΗΜΟΣ ΣΚΥΡΟΥ 2994 453 1928 613 23

23 ΔΗΜΟΣ ΣΤΥΛΙΔΟΣ 12750 1542 7829 3379 20

24 ΔΗΜΟΣ ΤΑΝΑΓΡΑΣ 19432 2892 13348 3192 22

25 ΔΗΜΟΣ ΧΑΛΚΙΔΕΩΝ 102223 16560 69831 15832 24

ΠΕΡΙΦΕΡΕΙΑ ΣΤΕΡΕΑΣ ΕΛΛΑΔΑΣ 547390 75808 348921 122661 22
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Στο Διάγραμμα 4  βλέπουμε τη σύγκριση του Δείκτη Εξάρτησης  (Child Dependency Ratio)  

των Δήμων Καλλικράτη με τον Δείκτη Εξάρτησης (Child Dependency Ratio) της 

Περιφέρειας Στερεάς Ελλάδας.   

 

 

Διάγραμμα 4: Πηγή ΕΛΣΤΑΤ, απογραφή 2011, επεξεργασία στοιχείων 

 

6.2.2.2   Δείκτης εξάρτησης ηλικιωμένων (Old Age Dependency Ratio) 

Ο δείκτης αυτός υπολογίζεται σαν το κλάσμα του πληθυσμού ηλικιών από  65 ετών και 

πάνω προς τον πληθυσμό ηλικιών 15 έως 64 ετών. Πολλαπλασιασμένος με το 100 εκφράζει 

το μέσο αριθμό ατόμων ηλικιών από  65 ετών και πάνω στα 100 άτομα ηλικιών 15 έως 64 

ετών.  

Από τον Πίνακα 10 βλέπουμε ότι τη μεγαλύτερη τιμή του δείκτη παρουσιάζει ο δήμος 

Αγράφων (72) και τη μικρότερη ο δήμος Χαλκιδέων (23). Ο δείκτης εξάρτησης γεροντικού 

πληθυσμού της Περιφέρειας Στερεάς Ελλάδας είναι 35.  

Στο Διάγραμμα 5  βλέπουμε τη σύγκριση του Δείκτη Εξάρτησης  (Old Age Dependency 

Ratio)  των Δήμων Καλλικράτη με τον Δείκτη Εξάρτησης (Old Age Dependency Ratio) της 

Περιφέρειας Στερεάς Ελλάδας.   
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Πίνακας 10:  Δείκτης Εξάρτησης (Old Age Dependency Ratio) των Δήμων Καλλικράτη  

                      της  Περιφέρειας   Στερεάς   Ελλάδας  για το  έτος  2011,  Πηγή  ΕΛΣΤΑΤ,  

                           επεξεργασία στοιχείων. 

 

Διάγραμμα 5: Πηγή ΕΛΣΤΑΤ, απογραφή 2011, επεξεργασία στοιχείων 

Α/Α Δήμοι Καλλικράτη Σύνολο 

πληθυσμού 0-14 15-64 >65

Old Age 

Dependency 

Ratio

1 ΔΗΜΟΣ ΑΓΡΑΦΩΝ 6976 558 3733 2685 72

2 ΔΗΜΟΣ ΑΛΙΑΡΤΟΥ 10887 1526 7070 2291 32

3 ΔΗΜΟΣ ΑΜΦΙΚΛΕΙΑΣ - ΕΛΑΤΕΙΑΣ 10922 1242 6589 3091 47

4 ΔΗΜΟΣ ΔΕΛΦΩΝ 26716 3511 16700 6505 39

5 ΔΗΜΟΣ ΔΙΡΦΥΩΝ - ΜΕΣΣΑΠΙΩΝ 18800 2231 12222 4347 36

6 ΔΗΜΟΣ ΔΙΣΤΟΜΟΥ - ΑΡΑΧΟΒΑΣ - ΑΝΤΙΚΥΡΑΣ 8188 1215 5330 1643 31

7 ΔΗΜΟΣ ΔΟΜΟΚΟΥ 11495 1344 6519 3632 56

8 ΔΗΜΟΣ ΔΩΡΙΔΟΣ 13627 1310 7712 4605 60

9 ΔΗΜΟΣ ΕΡΕΤΡΙΑΣ 13053 1914 8290 2849 34

10 ΔΗΜΟΣ ΘΗΒΑΙΩΝ 36477 5140 24918 6419 26

11 ΔΗΜΟΣ ΙΣΤΙΑΙΑΣ - ΑΙΔΗΨΟΥ 21083 2703 12422 5958 48

12 ΔΗΜΟΣ ΚΑΡΠΕΝΗΣΙΟΥ 13105 1633 7783 3689 47

13 ΔΗΜΟΣ ΚΑΡΥΣΤΟΥ 12180 1614 7399 3167 43

14 ΔΗΜΟΣ ΚΥΜΗΣ - ΑΛΙΒΕΡΙΟΥ 28437 3630 16925 7882 47

15 ΔΗΜΟΣ ΛΑΜΙΕΩΝ 75315 11459 49411 14445 29

16 ΔΗΜΟΣ ΛΕΒΑΔΕΩΝ 31315 4603 20311 6401 32

17 ΔΗΜΟΣ ΛΟΚΡΩΝ 19623 2729 12191 4703 39

18 ΔΗΜΟΣ ΜΑΚΡΑΚΩΜΗΣ 16036 1597 8999 5440 60

19 ΔΗΜΟΣ ΜΑΝΤΟΥΔΙΟΥ - ΛΙΜΝΗΣ - ΑΓΙΑΣ ΑΝΝΑΣ 12045 1170 7304 3571 49

20 ΔΗΜΟΣ ΜΩΛΟΥ - ΑΓΙΟΥ ΚΩΝΣΤΑΝΤΙΝΟΥ 12090 1603 7198 3289 46

21 ΔΗΜΟΣ ΟΡΧΟΜΕΝΟΥ 11621 1629 6959 3033 44

22 ΔΗΜΟΣ ΣΚΥΡΟΥ 2994 453 1928 613 32

23 ΔΗΜΟΣ ΣΤΥΛΙΔΟΣ 12750 1542 7829 3379 43

24 ΔΗΜΟΣ ΤΑΝΑΓΡΑΣ 19432 2892 13348 3192 24

25 ΔΗΜΟΣ ΧΑΛΚΙΔΕΩΝ 102223 16560 69831 15832 23

ΠΕΡΙΦΕΡΕΙΑ ΣΤΕΡΕΑΣ ΕΛΛΑΔΑΣ 547390 75808 348921 122661 35
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6.2.3   Δείκτης εξαρτημένων (Dependant Ratio) 

Ο δείκτης υπολογίζεται σαν το κλάσμα του πληθυσμού ηλικιών 0 ως 14 προς τον πληθυσμό 

ηλικιών 65 και άνω. Πολλαπλασιασμένος με το 100 εκφράζει το μέσο αριθμό ατόμων 

ηλικιών κάτω των 15 ετών στα 100 άτομα ηλικιών 65 και άνω.  

Με το δείκτη εξαρτημένων (Dependant Ratio) αποτυπώνεται η σχέση μεταξύ αυτών που 

πρόκειται να ενταχτούν σε αυτόν τον πληθυσμό τα επόμενα 15 χρόνια προς αυτούς που 

αποχώρησαν από τον πληθυσμό εργάσιμης ηλικίας. Οι τιμές του δείκτη εξαρτημένων για 

την Περιφέρεια, για κάθε φύλο ξεχωριστά αλλά και για το συνολικό πληθυσμό των Δήμων 

της Περιφέρειας Στερεάς Ελλάδας το 2011 παρουσιάζονται στον Πίνακα 11.   

Οι μεγαλύτερες τιμές του δείκτη αντιστοιχούν στον Δήμο Χαλκιδέων (πληθυσμός:105, 

άνδρες:118, γυναίκες:93), δήμος ο οποίος χαρακτηρίζεται από υψηλή γεννητικότητα. Οι 

μικρότερες τιμές του δείκτη αντιστοιχούν στον Δήμο Αγράφων  (πληθυσμός:21, άνδρες:24, 

γυναίκες:18).  

Ο δείκτης εξαρτημένων στο σύνολο του πληθυσμού της Περιφέρειας Στερεάς Ελλάδας 

είναι 62. 

Συγκρίνοντας τώρα τις τιμές του Πίνακα 11 μπορούμε να παρατηρήσουμε ότι για όλους 

τους δήμους ο δείκτης εξαρτημένων παίρνει μεγαλύτερες τιμές στους άνδρες, και 

μικρότερες τιμές για τις γυναίκες. Αιτία και σ’ αυτή την περίπτωση είναι η υψηλότερη 

ανδρική θνησιμότητα.  

Στο Διάγραμμα 6  βλέπουμε τη σύγκριση του Δείκτη Εξαρτημένων (Dependant Ratio)  των 

Δήμων Καλλικράτη για το σύνολο του πληθυσμού, τις γυναίκες και τους άνδρες με τον 

Δείκτη Εξαρτημένων (Dependant Ratio) της Περιφέρειας Στερεάς Ελλάδας.   
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Πίνακας 11:  Δείκτης εξαρτημένων (Dependant Ratio) των Δήμων Καλλικράτη της 

                   Περιφέρειας  Στερεάς  Ελλάδας για  το  έτος 2011,  Πηγή   ΕΛΣΤΑΤ,  

                              επεξεργασία στοιχείων. 
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Διάγραμμα 6: Πηγή ΕΛΣΤΑΤ, απογραφή 2011, επεξεργασία στοιχείων 

Για να οπτικοποιήσουμε το αποτέλεσμα θα δημιουργήσουμε 6 κλάσεις έτσι ώστε να 

διακρίνεται αμέσως οι Δήμοι με το μεγαλύτερο και το μικρότερο δείκτη εξαρτημένων. 

Ταυτόχρονα, για να αναδείξουμε το γεγονός ότι οι άνδρες παρουσιάζουν υψηλότερο δείκτη 

εξαρτημένων, θα εισάγουμε σε κάθε Δήμο γράφημα στηλών για τα δυο φύλα. Πράγματι 

από το Χάρτη 23 προκύπτει ότι οι Δήμοι με το μεγαλύτερο δείκτη εξαρτημένων είναι οι 

Δήμοι Χαλκιδέων και Τανάγρας, ενώ ο Δήμος με το μικρότερο δείκτη είναι ο Δήμος  

Αγράφων. Από το γράφημα στηλών φαίνεται ότι ο δείκτης εξαρτημένων στους άνδρες 

είναι υψηλότερος σε όλους τους Δήμους με μικρότερη διαφορά αυτή του Δήμου Δωρίδας.      
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Εκφράζει το μέσο αριθμό ατόμων ηλικιών κάτω των 15 ετών                       

στα 100 άτομα ηλικιών 65 ετών και άνω

Σύνολο Πληθυσμού Δήμου Άνδρες Γυναίκες Περιφέρεια
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Χάρτης 23: Γεωγραφική Κατανομή του Δείκτη Εξαρτημένων (Dependant Ratio)  

                             της Περιφέρειας Στερεάς Ελλάδας 
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6.2.4   Δείκτης γήρανσης (Ageing Index) 

Ο Δείκτης Γήρανσης είναι το αντίστροφο του Δείκτη Εξαρτημένων και εκφράζει το μέσο 

αριθμό ηλικιωμένων (>64 ετών) που αντιστοιχούν σε 100 άτομα μικρότερα από 15 ετών. 

Όπως ήταν αναμενόμενο, ο Δήμος ο οποίος είχε το μεγαλύτερο Δείκτη Εξαρτημένων, ο 

Δήμος Χαλκιδέων, τώρα θα έχει το μικρότερο Δείκτη Γήρανσης (πληθυσμός:96, άνδρες:85, 

γυναίκες:107). Μάλιστα είναι ο μοναδικός Δήμος με Δείκτη μικρότερο της μονάδας. Οι 

μεγαλύτερες τιμές του Δείκτη αντιστοιχούν στον Δήμο Αγράφων  (πληθυσμός:481, 

άνδρες:416, γυναίκες:550).  

Ο Δείκτης Γήρανσης της Περιφέρειας Στερεάς Ελλάδας για το σύνολο του πληθυσμού 

είναι 162 και αυξήθηκε από την απογραφή του μόνιμου πληθυσμού του 2001 κατά 11,23 

(δείκτης γήρανσης 2001: 150,77,  πηγή: e-Demography, Πανεπιστήμιο Θεσσαλίας). 

Συγκρίνοντας τώρα τις τιμές του Πίνακα 12 μπορούμε να παρατηρήσουμε ότι οι τιμές των 

Δεικτών Γήρανσης για τις γυναίκες είναι υψηλότερες των αντιστοίχων των ανδρών, λόγω 

της χαμηλότερης θνησιμότητας των γυναικών.  

Στο Διάγραμμα 7  βλέπουμε τη σύγκριση του Δείκτη Γήρανσης (Ageing Index) των Δήμων 

Καλλικράτη για το σύνολο του πληθυσμού, τις γυναίκες και τους άνδρες με τον Δείκτη 

Γήρανσης (Ageing Index) της Περιφέρειας Στερεάς Ελλάδας.   
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Πίνακας 12:  Δείκτης  γήρανσης  (Ageing   Index)   των  Δήμων  Καλλικράτη  της 

                     Περιφέρειας  Στερεάς  Ελλάδας για  το έτος 2011,  Πηγή   ΕΛΣΤΑΤ,  

                               επεξεργασία στοιχείων. 
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Διάγραμμα 7: Πηγή ΕΛΣΤΑΤ, απογραφή 2011, επεξεργασία στοιχείων 

Για να οπτικοποιήσουμε το αποτέλεσμα θα δημιουργήσουμε 6 κλάσεις έτσι ώστε να 

διακρίνεται αμέσως ο Δήμος με το μεγαλύτερο και το μικρότερο δείκτη γήρανσης. 

Ταυτόχρονα, για να αναδείξουμε το γεγονός ότι οι γυναίκες παρουσιάζουν υψηλότερο 

δείκτη γήρανσης, θα εισάγουμε σε κάθε Δήμο γράφημα στηλών για τα δυο φύλα. 

Πράγματι από το Χάρτη 24 προκύπτει ότι ο δήμος με το μεγαλύτερο δείκτη γήρανσης 

είναι ο Δήμος Αγράφων, ενώ ο Δήμος με το μικρότερο δείκτη είναι ο δήμος Χαλκιδέων. 

Από το γράφημα στηλών φαίνεται ότι ο δείκτης γήρανσης στις γυναίκες είναι υψηλότερος 

σε όλους τους Δήμους με μικρότερη διαφορά αυτή του Δήμου Δωρίδας. 

0

100

200

300

400

500

600
Δ

Η
Μ

Ο
Σ 

Λ
Α

Μ
ΙΕ

Ω
Ν

Δ
Η

Μ
Ο

Σ 
Α

Μ
Φ

ΙΚ
Λ

ΕΙ
Α

Σ 
-…

Δ
Η

Μ
Ο

Σ 
Δ

Ο
Μ

Ο
Κ

Ο
Υ

Δ
Η

Μ
Ο

Σ 
Λ

Ο
Κ

Ρ
Ω

Ν

Δ
Η

Μ
Ο

Σ 
Μ

Α
Κ

Ρ
Α

Κ
Ω

Μ
Η

Σ

Δ
Η

Μ
Ο

Σ 
Μ

Ω
Λ

Ο
Υ 

-
Α

ΓΙ
Ο

Υ …

Δ
Η

Μ
Ο

Σ 
ΣΤ

ΥΛ
ΙΔ

Ο
Σ

Δ
Η

Μ
Ο

Σ 
Λ

ΕΒ
Α

Δ
ΕΩ

Ν

Δ
Η

Μ
Ο

Σ 
Α

Λ
ΙΑ

Ρ
ΤΟ

Υ

Δ
Η

Μ
Ο

Σ 
Δ

ΙΣ
ΤΟ

Μ
Ο

Υ 
-…

Δ
Η

Μ
Ο

Σ 
Θ

Η
Β

Α
ΙΩ

Ν

Δ
Η

Μ
Ο

Σ 
Ο

Ρ
Χ

Ο
Μ

ΕΝ
Ο

Υ

Δ
Η

Μ
Ο

Σ 
ΤΑ

Ν
Α

ΓΡ
Α

Σ

Δ
Η

Μ
Ο

Σ 
Χ

Α
Λ

Κ
ΙΔ

ΕΩ
Ν

Δ
Η

Μ
Ο

Σ 
Δ

ΙΡ
Φ

ΥΩ
Ν

 -
…

Δ
Η

Μ
Ο

Σ 
ΕΡ

ΕΤ
Ρ

ΙΑ
Σ

Δ
Η

Μ
Ο

Σ 
ΙΣ

ΤΙ
Α

ΙΑ
Σ 

-…

Δ
Η

Μ
Ο

Σ 
Κ

Α
Ρ

ΥΣ
ΤΟ

Υ

Δ
Η

Μ
Ο

Σ 
Κ

ΥΜ
Η

Σ 
-…

Δ
Η

Μ
Ο

Σ 
Μ

Α
Ν

ΤΟ
ΥΔ

ΙΟ
Υ 

-…

Δ
Η

Μ
Ο

Σ 
ΣΚ

ΥΡ
Ο

Υ

Δ
Η

Μ
Ο

Σ 
Κ

Α
Ρ

Π
ΕΝ

Η
ΣΙ

Ο
Υ

Δ
Η

Μ
Ο

Σ 
Α

ΓΡ
Α

Φ
Ω

Ν

Δ
Η

Μ
Ο

Σ 
Δ

ΕΛ
Φ

Ω
Ν

Δ
Η

Μ
Ο

Σ 
Δ

Ω
Ρ

ΙΔ
Ο

Σ

Δείκτης γήρανσης (Ageing Index) των Δήμων 

Καλλικράτη της Περιφέρειας Στερεάς Ελλάδας

Σύνολο Πληθυσμού Δήμων Άνδρες Γυναίκες Περιφέρεια



 

127 
 

 

Χάρτης 24: Γεωγραφική Κατανομή του Δείκτη Γήρανσης (Ageing Index)  

                                   της Περιφέρειας Στερεάς Ελλάδας 
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6.2.5   Δείκτης αντικατάστασης (Substitution Ratio) 

Ο δείκτης αυτός υπολογίζεται σαν το κλάσμα των ατόμων ηλικίας 10-14 ετών προς τον 

πληθυσμό ατόμων ηλικίας 60-64 ετών (ο λόγος αυτός συνήθως εκφράζεται επί τοις %). 

Εκφράζει τη σχέση ανάμεσα στα άτομα που θα έχουν τη νόμιμη ηλικία για να εργασθούν 

εισερχόμενα στην αγορά εργασίας και τα άτομα που θα έχουν την ηλικία συνταξιοδότησης 

εάν ήταν ήδη ενταγμένα στον οικονομικά ενεργό πληθυσμό.  

Από τον Πίνακα 13 παρατηρούμε ότι ο δείκτης αντικατάστασης της Περιφέρειας Στερεάς 

Ελλάδας για το σύνολο του πληθυσμού είναι 81 και ελαττώθηκε από την απογραφή του 

μόνιμου πληθυσμού του 2001 κατά 7,42 (δείκτης αντικατάστασης 2001: 88,42, πηγή: e-

Demography, Πανεπιστήμιο Θεσσαλίας).  Όσον αφορά το σύνολο του πληθυσμού ο Δήμος 

Χαλκιδέων παρουσιάζει την υψηλότερη τιμή (100) και είναι ο μοναδικός Δήμος που δεν 

παρουσιάζει δείκτη μικρότερο της μονάδας. Το γεγονός αυτό οφείλεται στην υψηλή 

γεννητικότητα του Δήμου Χαλκιδέων. Τη χαμηλότερη τιμή παρουσιάζει ο Δήμος Αγράφων 

(43).  

 

Πίνακας 13: Δείκτης αντικατάστασης (Substitution  Ratio) των  Δήμων  Καλλικράτη   

                     της Περιφέρειας  Στερεάς  Ελλάδας για  το έτος 2011,  Πηγή   ΕΛΣΤΑΤ,  

                            επεξεργασία στοιχείων. 

Αν τώρα κοιτάξουμε τους δείκτες κατά φύλο παρατηρούμε τα εξής: 

Όσον αφορά τους άνδρες οι Δήμοι Λαμιέων, Χαλκιδέων και Διστόμου-Αράχοβας-

Αντίκυρας  παρουσιάζουν την υψηλότερη τιμή (107) ενώ ο Δήμος Αγράφων έχει πάλι την 

μικρότερη τιμή (41). Σχετικά με τις γυναίκες τα πράγματα δεν διαφοροποιούνται, την 
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υψηλότερη τιμή (94) παρουσιάζει ο Δήμος Χαλκιδέων και την μικρότερη τιμή (46) ο Δήμος 

Αγράφων.  

Τα υψηλότερα επίπεδα τιμών του λόγου αντικατάστασης στους άνδρες είναι αναμενόμενα 

και συνδέονται με τα υψηλότερα επίπεδα θνησιμότητας που υπόκεινται σε σχέση με τα 

αντίστοιχα των γυναικών.  

Στο Διάγραμμα 8  βλέπουμε τη σύγκριση του Δείκτη αντικατάστασης (Substitution Ratio) 

των Δήμων Καλλικράτη για το σύνολο του πληθυσμού, τις γυναίκες και τους άνδρες με τον 

Δείκτη αντικατάστασης (Substitution Ratio) της Περιφέρειας Στερεάς Ελλάδας.   

 

Διάγραμμα 8: Πηγή ΕΛΣΤΑΤ, απογραφή 2011, επεξεργασία στοιχείων 

Για να οπτικοποιήσουμε το αποτέλεσμα θα δημιουργήσουμε 6 κλάσεις έτσι ώστε να 

διακρίνονται αμέσως οι Δήμοι με το μεγαλύτερο και το μικρότερο δείκτη αντικατάστασης. 

Ταυτόχρονα, για να αναδείξουμε το γεγονός ότι οι άνδρες παρουσιάζουν υψηλότερο δείκτη 

αντικατάστασης, θα εισάγουμε σε κάθε Δήμο γράφημα στηλών για τα δυο φύλα. Πράγματι 

από το Χάρτη 25 προκύπτει ότι οι Δήμοι με το μεγαλύτερο δείκτη αντικατάστασης είναι 

οι Δήμοι Χαλκιδέων και Λαμιέων, ενώ οι Δήμοι με το μικρότερο δείκτη είναι οι Δήμοι  

Αγράφων, Δωρίδας και Μαντουδίου-Λίμνης-Αγίας Άννας. Από το γράφημα στηλών 

φαίνεται ότι ο δείκτης αντικατάστασης στους άνδρες είναι υψηλότερος στους 

περισσότερους Δήμους με εξαίρεση τους Δήμους Καρπενησίου, Δελφών, Αγράφων και 

Δωρίδας όπου οι γυναίκες παρουσιάζουν υψηλότερο δείκτη.       
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Χάρτης 25: Γεωγραφική Κατανομή του Δείκτη Αντικατάστασης (Substitution Ratio)  

                          της Περιφέρειας Στερεάς Ελλάδας 
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7.   ΣΥΜΠΕΡΑΣΜΑΤΑ 

Συνοψίζοντας στη συγκεκριμένη διπλωματική εργασία, χρησιμοποιώντας τα Γεωγραφικά 

Συστήματα Πληροφοριών (ΓΣΠ), αξιοποιήσαμε πρωτογενή δεδομένα, πληροφορίες 

διαθέσιμες ελεύθερα στο διαδίκτυο από επίσημους φορείς και αναδείξαμε το ρόλο που 

μπορούν να παίξουν στην Γεωγραφική ανάλυση μιας περιοχής. Επιπλέον οι τεχνολογίες των 

ΓΣΠ θα μπορούσαν να αξιοποιηθούν στην εκπαιδευτική πρακτική συμβάλλοντας στην 

ενίσχυση του διδάσκοντα με ένα ακόμη   διδακτικό - εποπτικό μέσο που μπορεί να 

χρησιμοποιηθεί είτε σαν γνωστικό εργαλείο είτε σαν εργαλείο επικοινωνίας και έκφρασης. 

Η αξιοποίηση των ΓΣΠ θα μπορούσε να βοηθήσει αποτελεσματικά τους μαθητές σε 

δεξιότητες χαρτογράφησης, ανάλυσης δεδομένων και σε διαδικασίες εργασιών πεδίου.  

Από την επεξεργασία και ανάλυση των δεδομένων καταλήξαμε σε κάποια σημαντικά 

συμπεράσματα για την Περιφέρεια Στερεάς Ελλάδας:  

 Το ανάγλυφο της Περιφέρειας Στερεάς Ελλάδας χαρακτηρίζεται κατά 23,23% ως 

πεδινό, κατά 41,73% ως λοφώδες, κατά 14,79% ως ημιορεινό και κατά 20,25% ως 

ορεινό.  

 Το ανάγλυφο κατά κύριο λόγο (76,07% της επιφάνειας παρουσιάζει κλίσεις 5 - 35ο) 

χαρακτηρίζεται από ισχυρό έως απότομο και εξαιρετικά απότομο, αποτελούμενο 

από κλιτύες κοιλάδων οι οποίες υπόκεινται σε κινήσεις μαζών και διαβρωτικές 

διεργασίες. 

 Δημιουργήσαμε τους χάρτες Εκθέσεων και Σκίασης της Περιφέρειας. 

 Έγινε εντοπισμός του υδρογραφικού δικτύου με τη δημιουργία μοντέλου και 

υπολογίστηκε το μήκος ανά κατηγορία ιεράρχησης (τάξης) του υδρογραφικού 

δικτύου της Περιφέρειας (πλήθος κλάδων 1940, με συνολικό μήκος 5366,13 km). 

 Δημιουργήσαμε το χάρτη Αιολικού Δυναμικού της Περιφέρειας Στερεάς Ελλάδας. 

 Στην Περιφέρεια Στερεάς Ελλάδας απαντούν 37 τύποι κάλυψης γης. Το μεγαλύτερο 

ποσοστό καταλαμβάνουν: η σκληροφυλλική βλάστηση με 22,814%, οι μεταβατικές 

δασώδεις και θαμνώδεις εκτάσεις με 11,561%,  τα δάση κωνοφόρων με 11,368%, 

γη που  χρησιμοποιείται κυρίως για γεωργία μαζί με σημαντικά τμήματα φυσικής 

βλάστησης με 8,103%, μόνιμα αρδευόμενη γη με 7,297%, μικτό δάσος με 6,671%, 

μη αρδευόμενη αρόσιμη γη με 5,568%, ελαιώνες με 4,727%  και φυσικοί 

βοσκότοποι με 4,656%. Το μικρότερο ποσοστό καταλαμβάνουν: οι ζώνες λιμένων 

με 0,001%, οι εκβολές ποταμών με 0,002% και οι χώροι απορρίψεως 

απορριμμάτων με 0,005%. 
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Μπορούν να ενταχθούν σε 5 ευρύτερες κατηγορίες: τεχνητές επιφάνειες (2,28%), 

γεωργικές περιοχές (32,44%), δάση και ημιφυσικές περιοχές (64,26%), 

υγροτόπους  (0,11%) και υδάτινες επιφάνειες (0,91%).   

 Κατασκευάστηκε η ηλικιακή πυραμίδα Περιφέρειας Στερεάς Ελλάδας από την οποία 

προκύπτει ότι ο πληθυσμός της Περιφέρειας χαρακτηρίζεται γεροντικός. 

 Από τη γεωγραφική κατανομή της αριθμητικής πυκνότητας πληθυσμού προκύπτει 

ότι ο πιο πυκνοκατοικημένος Δήμος της Περιφέρειας Στερεάς Ελλάδας είναι ο 

Δήμος Χαλκιδέων και ο πιο αραιοκατοικημένος ο Δήμος Αγράφων. 

 Οι μεγαλύτερες τιμές του δείκτη αναλογίας φύλου αντιστοιχούν στον Δήμο Σκύρου 

(121). Τη μικρότερη τιμή του δείκτη έχουν οι δήμοι Μώλου-Αγίου Κωνσταντίνου 

και Ιστιαίας-Αιδηψού (97). Ο δείκτης αναλογίας φύλου της Περιφέρειας Στερεάς 

Ελλάδας είναι 103 και αυξήθηκε από την απογραφή του μόνιμου πληθυσμού του 

2001 κατά 0,93. 

 Η μεγαλύτερη τιμή του Δείκτης εξάρτησης (Dependency Ratio) αντιστοιχεί στον 

Δήμο Αγράφων (259) και η μικρότερη στον δήμο Τανάγρας (114). Ο δείκτης 

εξάρτησης της Περιφέρειας Στερεάς Ελλάδας με αυτόν τον τρόπο υπολογισμού 

(εκφράζοντας τον μέσο αριθμό των οικονομικά μη ενεργών ατόμων ανά 100 

οικονομικά ενεργά άτομα στον πληθυσμό) είναι 152. Δεν υπάρχουν στοιχεία από 

την απογραφή του 2001 για να γίνει σύγκριση. 

 Οι μεγαλύτερες τιμές του δείκτη εξάρτησης (Age Dependency Ratio) τόσο στον 

πληθυσμό (87) όσο και στα δυο φύλα (άνδρες:69, γυναίκες:110) αντιστοιχούν στον 

Δήμο Αγράφων. Τη μικρότερη τιμή του δείκτη για το σύνολο του πληθυσμού έχουν 

οι δήμοι Θηβαίων, Τανάγρας και Χαλκιδέων (46). Για τον ανδρικό πληθυσμό τη 

μικρότερη τιμή έχουν οι δήμοι Θηβαίων και Τανάγρας (40), ενώ για τις γυναίκες ο 

δήμος Χαλκιδέων (49). Ο δείκτης εξάρτησης της Περιφέρειας Στερεάς Ελλάδας 

με αυτόν τον τρόπο υπολογισμού (εκφράζοντας τον αριθμό των εξαρτημένων 

μελών (παιδιών και ηλικιωμένων) ανά 100 άτομα παραγωγικής ηλικίας) είναι 57 

και αυξήθηκε από την απογραφή του μόνιμου πληθυσμού του 2001 κατά 4,35.  

Οι δείκτες εξάρτησης των γυναικών παρουσιάζονται συστηματικά υψηλότεροι σε 

σχέση με εκείνους των ανδρών γεγονός που μπορεί να αποδοθεί στην υψηλότερη 

θνησιμότητα των ανδρών. 

Τη μεγαλύτερη τιμή του δείκτη εξάρτησης παιδικού πληθυσμού παρουσιάζει ο 

δήμος Χαλκιδέων (24) και τη μικρότερη ο δήμος Αγράφων (15). Ο δείκτης 

εξάρτησης παιδικού πληθυσμού της Περιφέρειας Στερεάς Ελλάδας είναι 22.  
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Τη μεγαλύτερη τιμή του δείκτη εξάρτησης γεροντικού πληθυσμού παρουσιάζει ο 

δήμος Αγράφων (72) και τη μικρότερη ο δήμος Χαλκιδέων (23). Ο δείκτης 

εξάρτησης γεροντικού πληθυσμού της Περιφέρειας Στερεάς Ελλάδας είναι 35. 

 Οι μεγαλύτερες τιμές του δείκτη εξαρτημένων (εκφράζει το μέσο αριθμό ατόμων 

ηλικιών κάτω των 15 ετών στα 100 άτομα ηλικιών 65 ετών και άνω) αντιστοιχούν 

στον Δήμο Χαλκιδέων (πληθυσμός:105, άνδρες:118, γυναίκες:93), δήμος ο οποίος 

χαρακτηρίζεται από υψηλή γεννητικότητα. Οι μικρότερες τιμές του δείκτη 

αντιστοιχούν στον Δήμο Αγράφων (πληθυσμός:21, άνδρες:24, γυναίκες:18). Ο 

δείκτης εξαρτημένων της Περιφέρειας Στερεάς Ελλάδας είναι 62. Ο δείκτης 

εξαρτημένων παίρνει μεγαλύτερες τιμές στους άνδρες, και μικρότερες τιμές για τις 

γυναίκες. Αιτία και σ’ αυτή την περίπτωση είναι η υψηλότερη ανδρική θνησιμότητα. 

 Το μικρότερο δείκτη γήρανσης (πληθυσμός:96, άνδρες:85, γυναίκες:107) 

παρουσιάζει ο Δήμος Χαλκιδέων. Μάλιστα είναι ο μοναδικός Δήμος με δείκτη 

μικρότερο της μονάδας. Οι μεγαλύτερες τιμές του δείκτη αντιστοιχούν στον Δήμο 

Αγράφων (πληθυσμός:481, άνδρες:416, γυναίκες:550). Ο δείκτης γήρανσης της 

Περιφέρειας Στερεάς Ελλάδας είναι 162 και αυξήθηκε από την απογραφή του 

μόνιμου πληθυσμού του 2001 κατά 11,23. Οι τιμές των δεικτών γήρανσης για τις 

γυναίκες είναι υψηλότερες των αντιστοίχων των ανδρών, λόγω της χαμηλότερης 

θνησιμότητας των γυναικών. 

 Ο δείκτης αντικατάστασης (υπολογίζεται σαν το κλάσμα των ατόμων ηλικίας 10-

14 ετών προς τον πληθυσμό ατόμων ηλικίας 60-64 ετών) της Περιφέρειας 

Στερεάς Ελλάδας είναι 81 και ελαττώθηκε από την απογραφή του μόνιμου 

πληθυσμού του 2001 κατά 7,42. Τα υψηλότερα επίπεδα τιμών του λόγου 

αντικατάστασης στους άνδρες είναι αναμενόμενα και συνδέονται με τα υψηλότερα 

επίπεδα θνησιμότητας που υπόκεινται σε σχέση με τα αντίστοιχα των γυναικών. 

Ένα θέμα που θα μπορούσε να αποτελέσει αντικείμενο μελλοντικών εργασιών θα ήταν η  

δημιουργία μιας πλήρους βάσης δεδομένων η οποία θα περιλάμβανε όλα τα ποσοτικά και 

ποιοτικά χαρακτηριστικά του φυσικού και ανθρωπογενούς περιβάλλοντος της Περιφέρειας 

Στερεάς Ελλάδας. Τα δεδομένα που χρησιμοποιήθηκαν στην Γεωγραφική Ανάλυση και οι 

παράγωγες πληροφορίες που προέκυψαν, εμπεριέχουν μεγάλο βαθμό ακρίβειας και 

λεπτομέρειας και θα μπορούσαν να αποτελέσουν τη βάση για χαρτογραφήσεις σε 

μεγαλύτερες κλίμακες, σε επίπεδο  Δήμου Καλλικράτη.  

Θα παραθέσουμε ορισμένα παραδείγματα διερεύνησης και αξιοποίησης των δεδομένων που 

προέκυψαν από τις αναλυτικές διαδικασίες σε μελλοντικές εργασίες:  
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 Μπορεί να εξεταστεί πως και πόσο επιδρά το ανάγλυφο μιας περιοχής στο 

κλίμα, στην χλωρίδα και στην πανίδα. Επίσης θα μπορούσε να αναλυθεί η 

προοπτική που έχει μια περιοχή για ανάπτυξη με βάση το φυσικό ανάγλυφο 

που διαθέτει. 

 Από τα δεδομένα των κλίσεων θα μπορούσε να προβλεφθεί η πιθανότητα 

εκδήλωσης  πλημμυρών σε κάποιες περιοχές.  

 Από τα δεδομένα των εκθέσεων μπορεί να μελετηθεί το κλίμα μιας περιοχής. 

 Ο συνδυασμός δεδομένων των κλίσεων και εκθέσεων με γεωλογικά 

δεδομένα μπορεί να οδηγήσει στην αξιολόγηση της πιθανότητας εκδήλωσης  

κατολισθητικών φαινομένων σε κάποιες περιοχές. 

 Από τα δεδομένα του σκιασμένου αναγλύφου, όπου έχουμε την μέγιστη 

ηλιοφάνεια για το μεγαλύτερο μέρος της μέρας, μπορεί να γίνει χωροθέτηση 

ενός φωτοβολταϊκού πάρκου. 

 Από τα δεδομένα του υδρογραφικού δικτύου μπορούν να μελετηθούν τα 

μορφομετρικά χαρακτηριστικά (μέγεθος, σχήμα, υψόμετρο, ανάγλυφο, 

κλίσεις) των λεκανών  απορροής της Περιφέρειας.  

 Τα δεδομένα των χρήσεων γης μπορούν να αξιοποιηθούν στην χωροθέτηση 

αιολικών πάρκων και στις μελέτες περιβαλλοντικών επιπτώσεων. 

 Ο συνδυασμός δεδομένων όπως το υψόμετρο, οι κλίσεις, οι εκθέσεις, η 

απόσταση από τους δρόμους και τα είδη βλάστησης μπορεί να οδηγήσει στη 

δημιουργία μοντέλων κινδύνου εκδήλωσης πυρκαγιών.  

 Στο πλαίσιο της αναζήτησης τρόπων αντιμετώπισης του σημαντικού 

δημογραφικού προβλήματος που αντιμετωπίζει η πατρίδα μας, θα μπορούσε 

η Δημογραφία αν εισαχθεί ως μάθημα στην Δευτεροβάθμια εκπαίδευση να 

συμβάλει στην ενημέρωση, από μικρή σχετικά ηλικία, και ευαισθητοποίηση 

πάνω στο ζήτημα;  

 Μπορεί να γίνει αξιοποίηση και των οικονομικών χαρακτηριστικών της 

απογραφής του μόνιμου πληθυσμού, για να εξαχθούν σημαντικοί δείκτες 

όπως ο δείκτης στέρησης Townsend, ο Δείκτης Ανθρώπινης Φτώχειας του 

Οργανισμού Ηνωμένων Εθνών (ΟΗΕ) και ο Δείκτης Ανθρώπινης Ανάπτυξης 

του ΟΗΕ.  

 Μπορεί να γίνει ανάλυση των παραγόντων που επηρεάζουν τη γεωγραφική 

κατανομή της ανεργίας στην Περιφέρεια Στερεάς Ελλάδας.  
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